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第一章 – 概述 

Foxit PhantomPDF軟體概述 

Foxit PhantomPDF，是一套專業、安全、實用的 PDF解決方案，功能強大且執行快速。Foxit 

PhantomPDF 分兩個版本： Foxit PhantomPDF Express 和 Foxit PhantomPDF Business。

ExpressFoxit PhantomPDF Express滿足個人或家庭辦公的各種需求，具有 PDF閱讀、建立、

注釋等功能；而 Foxit PhantomPDF Business能滿足大型企業用戶的迫切需求，如物件編輯、

加密、群組原則、建立互動式表單、支援 JavaScript等功能。 

功能對比表 
Foxit 

PhantomPDF 

Express 

Foxit 

PhantomPDF 

Business 

從微軟辦公軟體（如 Word、Excel 和 PowerPoint）、

掃描器、空白頁面和虛擬印表機中建立 PDF文件   

將 PDF文件轉換成微軟 Office文件、RTF、HTML、text

和影像檔 
  

閱讀和搜索 PDF文件歷程 
  

朗讀功能 
  

為桌面系統隨附 PDF IFilter，可通過 Windows搜索技

術搜索 PDF文件   

增加、編輯、刪除和管理 PDF文件超連結、書籤、圖

片和影音   

比較 PDF文件 
  

段落編輯，編輯時文字將自動重排 
  

增加、編輯、刪除和管理文字、圖片和路徑物件 
  

OCR文字識別，建立可搜索和可選擇的文件 
  

增加、管理、查看、導覽、導入/匯出注釋和小結注釋 
  

PDF優化 
  

填寫表單、導入/匯出表單數據和重置表單欄位 
  

表單欄位識別和表單設計小助手 
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支持 JavaScript 
  

製作和編輯表單（文字欄位、按鈕、下拉清單、核取

方塊、選項按鈕和數位簽章欄位） 
  

PDF 快速簽名- 支持增加、編輯、刪除和管理 PDF 簽

名圖像   

在 PDF文件中增加、編輯、刪除和管理數位簽章 
  

驗證數位簽章 
  

增加、編輯、刪除和管理密碼和證書，對 PDF檔進行

安全加密和許可權控制 
  

支援微軟 AD RMS（活動目錄許可權管理服務）對 PDF

文件的加解密 
  

標記“密文”：選擇文字標記為密文、使之不可見，避

免重要資訊外泄 
  

簽入/簽出 SharePoint伺服器上的 PDF文件 
  

 

Foxit PhantomPDF Express 

Foxit PhantomPDF Express是一款免費的 PDF專業軟體。它小巧、快速、準確，具有傲人的

顯示速度、便捷的注釋、填寫表單、數位簽章、多途徑建立 PDF文件、搜索、列印等功能，

是日常 PDF文件用戶的必備工具。 

 XFA表單填寫 

 一鍵建立 PDF文件 

 便捷注釋 

 進階搜索 

 驗證數位簽章 

Foxit PhantomPDF Business 

Foxit PhantomPDF Business是一款建立在 Express標準版本基礎上進階的 PDF專業產品，不

僅可迅速、簡單地建立和編輯符合業界標準的 PDF 文件，還提供保護重要文件和檔案的安

全保護與應用，它符合企業用戶對文件的各類需求，突出的性價比優勢，是企業級 PDF 文

件的綜合解決方案。 

 密文 

 文件認證 

 XFA表單填寫 

 增加貝茨數 
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 朗讀功能 

 許可權管理服務 

 高壓縮文件 

關於手冊 

本手冊為您介紹標準版和企業版所有功能的使用方法。 

快速安裝指南 

如何安裝、註冊、卸載和更新 Foxit PhantomPDF軟體，請參閱 Foxit PhantomPDF軟體 

快速安裝指南      。 

注意: 請選擇 [文件] > [偏好設定] > [信任管理器]，在 [信任管理器]中取消對安全閱讀模式

的勾選，然後滑鼠雙擊檔案附件圖示 開啟快速安裝指南。  
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Foxit® PhantomPDF™ for HP 


快速安裝指南 
 


 


本手冊提供 Foxit PhantomPDF Business的快速入門指南，包括如何安裝、啟動、卸載和升級


等。 


安裝、升級、啟動與卸載  


安裝 Foxit PhantomPDF 


安裝步驟 


Foxit PhantomPDF安裝套件格式為 EXE格式。請先下載到電腦，然後按以下步驟進行安裝： 


1. 按兩下安裝套件文件，彈出安裝精靈，按一下“下一步”按鈕。  


 


 
 


2. 從兩種安裝類型中選擇一種安裝，可預設安裝到 C:\Program Files\Foxit PhantomPDF\，


或者點擊“更改”自訂選擇安裝目錄。 


典型安裝 — 預設安裝所有功能。 


    自訂安裝 — 自訂選擇安裝相應功能。 
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3. 設定完成後，點擊“安裝”開始安裝。  


 


4. 完成安裝後，系統將彈出一個資訊框顯示 Foxit PhantomPDF已安裝，可勾選“執行 Foxit 


PhantomPDF”選項立刻啟動該程式。然後點擊“完成”，結束安裝。  


 


 
 


升級到 Foxit PhantomPDF Business 


Foxit PhantomPDF Express可以免費升級到 Foxit PhantomPDF Business試用 30天。點擊“主


頁/説明”功能表 > “升級至 Business”選項 > “試用 Business”進行升級。 
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試用結束後，您可以選擇購買 Business版或降級到免費的 Express版。 


 


您可以隨時點擊程式中的按鈕購買 Business版授權證書。購買時，根據您當前的程式視窗，


請選擇“主頁/説明”功能表 > “升級至Business”或“獲取Business”選項 > “升級”、


“現在購買”或“升級”按鈕，進入 Foxit官網線上購買。  


    


 


獲得授權證書後，請選擇“説明”功能表 > “升級至 Business”或“獲取 Business”選項 > 


“升級”或“現在購買” > “啟動”按鈕。 


 


關於啟動的詳細步驟，請參看啟動 Foxit PhantomPDF Business。 


啟動 Foxit PhantomPDF Business 


1. 點擊“啟動”按鈕後，啟動精靈將提示您安裝授權證書或輸入註冊代碼。然後點擊“下


一步”或“安裝授權文件”繼續。  


 


 


2. 在文字方塊中輸入授權持有人名稱，然後點擊“現在啟動”按鈕。啟動時，您必須網路


連線。 
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3. 若啟動成功，系統將彈出以下資訊框，然後點擊“確定”。  


 


 


 


4. 安裝完授權證書，您必須重啟程式。點擊“重啟”按鈕重啟程式。 


 


卸載 Foxit PhantomPDF 


Windows系統控制台卸載 


 


 點擊“開始” > “控制台”>“卸載程式”> 選擇“Foxit PhantomPDF”>“卸載”。 


使用命令列安裝和卸載 


程式的安裝命令列是： 


1) /help：顯示説明資訊。  


2) /extract <path>：將套件中內容提取到指定路徑。若無指定路徑，則提取到現有的目


前的目錄中。 
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3) /quiet：靜默安裝。 


4) /lang <en|de|es|fr|zh-hk|it|jp|ko|nl|pt|ru|zh-tw|zh>：選擇安裝套件語言。 


5) /force：強制覆蓋已安裝版本。  


6) /shortcut：增加桌面快捷方式（預設不增加）。 


7) /log <path>：建立文字日誌檔。  


8) /repair：安裝修復。 


 


程式的卸載命令列是： 


1) /uninstall：卸載。  


2) /log <path>：建立文字日誌檔。其預設路徑是%temp%，檔案名為 foxit_setup.log。 


3) /quiet：靜默卸載。  


4) /clean：和/uninstall命令一起使用，去除所有的註冊表和資料。 


Foxit PhantomPDF外掛程式 


Foxit PhantomPDF 提供單獨外掛程式以增強產品性能。大多數外掛程式已經整合到 Foxit 


PhantomPDF安裝套件中（如 JPEG2000/JBIG解碼器、拼寫檢查工具和火狐外掛程式），因此


安裝 Foxit PhantomPDF後無需再次安裝。 


如需更新這些外掛程式，請在程式視窗選擇“説明” > “檢查更新”下載安裝最新版本，


參看更新 Foxit PhantomPDF。 


如需獲取新的可用外掛程式，步驟同上。 


更新 Foxit PhantomPDF 


Foxit PhantomPDF 主程式及其外掛程式的更新都可以從“説明”功能表進入。另外，Foxit 


PhantomPDF擁有自動更新功能，如檢測到新版本，程式將會彈出資訊提示使用者更新。 


從“説明”功能表更新 


1. 選擇“幫助” > “檢查更新”； 


2. 從左欄的“可用更新 ”列表中（列表中僅為適合您所安裝產品的更新和元件）選擇更


新，點擊“增加”將其增加到右欄中； 


3. 點擊“下一步”，安裝所選項目的更新。 
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聯繫我們 


技術支援 


 郵箱： 


Foxit4HP@foxitsoftware.com 


 聯繫電話： 


+1-866-MYFOXIT or +1-866-693-6948 (24/7) 
+86-591-38509808（9:00-22:00 UTC+8，僅支持普通話） 


 





		安裝、升級、啟動與卸載

		安裝Foxit PhantomPDF

		升級到Foxit PhantomPDF Business

		啟動Foxit PhantomPDF Business

		卸載Foxit PhantomPDF

		使用命令列安裝和卸載



		Foxit PhantomPDF外掛程式

		更新Foxit PhantomPDF

		從“説明”功能表更新



		聯繫我們

		技術支援









Administrator
File Attachment
Foxit PhantomPDF for HP_快速安裝指南.pdf
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第二章 – 使用入門 

Foxit PhantomPDF軟體的工作區中有許多工具能幫助處理 PDF文件，且工作區被分為文件顯

示區、導覽列、工具列、功能表列和狀態列。快速使用 Foxit PhantomPDF軟體的最好途徑就

是先充分熟悉軟體的工作區。 

工作區 

Foxit PhantomPDF Business提供直觀的使用者介面：功能表列、工具列、導覽列、工作區和

狀態列。 

功能表列及文意功能選單 

Foxit PhantomPDF Business程式視窗功能表列中有“檔案”、“主頁”、“編輯”、“頁面

管理”、“注釋”等功能表。當您在工作區中右擊物件時，將根據您右擊的專案或區彈出對

應的右鍵功能表單。右鍵功能表包含許多常用的命令和工具。 

工具列 

工具列中在不同標籤下顯示不同的工具，如下圖： 

 

 [主頁] 標籤下工具列 

注: 將指標移動到工具按鈕上，將能查看到該工具的描述資訊。  

顯示/隱藏工具列 

顯示/隱藏工具列，請按下列步驟操作： 

 請點擊窗口右上角 和 按鈕分別收起和展開工具列。 

 右擊工具列並勾選“最小化功能區”隱藏工具列；反之亦然。 



Foxit PhantomPDF Business for HP 

用戶手冊 

9 

導覽列 

顯示或隱藏導覽列 

導覽列左邊的命令按鈕可顯示出不同的導覽面板，如書籤  和頁面縮圖  。 

 顯示或隱藏導覽列，使用快速鍵 F4。 

 開啟導覽面板，請選擇導覽列左邊的命令按鈕。 

 關閉導覽面板，使用快速鍵 F4，或在導覽列中再次點擊已經開啟的導覽面板的命令圖

示。 

技巧: 顯示或隱藏導覽面板，您也可以點擊導覽列右上角的 / 按鈕。 

調整導覽面板 

與工具列相同，導覽面板也可以浮動或鎖定。您可以選擇開啟、隱藏或關閉導覽面板，也可

以調整它的寬度。 

1. 在導覽面板中查看內容 

所有的面板都預設鎖定在工作區左邊部分的導覽列中。請按照下列步驟操作： 

 選擇導覽面板左邊部分的各個按鈕進行查看。 

2. 改變導覽面板顯示區域 

 改變導覽面板顯示區域，請拖動它的右側邊框以調整寬度。 

 最小化或最大化導覽面板，請點擊導覽列右上角的 / 。 

3. 鎖定或浮動導覽面板 

 浮動導覽面板，請拖動面板標籤至文件顯示區域。 

 拖動面板標籤可移動面板。 

 鎖定導覽面板，請滑鼠雙擊其標題列。 

圖層 

圖層或較正式的稱呼為選擇性內容群組(OCG, Optional Content Groups)就像是

含有文字或圖形等元素的膠片，一張張按順序疊放在一起，組合起來形成頁面的最終效果。

圖層可以將頁面上的元素精確定位。圖層中可以加入文字、圖片、表格、外掛程式，也可以

在裡面再嵌入圖層。在 Foxit PhantomPDF軟體中，您可以使用圖層面板控制 PDF圖層的顯



Foxit PhantomPDF Business for HP 

用戶手冊 

10 

示，例如：您可以利用圖層分辨出背景圖像、主要內容區和廣告區，並且隨意隱藏您不需要

顯示的圖像。 

顯示或隱藏 PDF圖層 

在 PDF 中，資訊可被儲存到不同的圖層中。顯示或隱藏不同的圖層，您可以參閱導覽列中

的圖層面板。請注意，在本軟體中，您不能建立或編輯圖層，但是，您可以查閱圖層並選擇

顯示或隱藏每個圖層中的內容。  

  

圖層面板 

A. 圖層顯示標誌    B. 圖層隱藏標誌 

1. 開啟圖層，請選擇下列操作之一： 

 隱藏圖層，請取消對其的勾選。 

 顯示隱藏的圖層，請勾選該圖層。 

2. 點擊圖層面板右上角的圖示 可進行圖層的設定： 

 列出所有頁面的圖層：顯示文件中每個跨頁的圖層。 

 列出可視頁面的圖層：僅顯示當前可見頁面圖層。 

 重設為初始可見性：重設圖層恢復其預設狀態。 

 全部展開：展開文件中所有的圖層。 

 全部收起：收起當前展開的所有圖層。 

狀態列 

狀態列在工作區的底端，顯示目前頁面的頁碼、總頁數、頁面轉場按鈕、縮放按鈕等，您可

以用這些來設定視圖方式。當您開啟一個 PDF文件時，狀態列預設是開啟的。在 [檢視] 功

能表 [視圖設定] 標籤中，您可以選擇顯示或隱藏狀態列。 

A 

B 
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顯示狀態列: 若勾選它，則狀態列將顯示在工作區底部。 

自動隱藏狀態列: 若勾選它，則狀態列被隱藏。但如果您將游標移到視窗底端，狀態列又會

出現。 

隱藏工具列: 若勾選它，狀態列將被隱藏。 

偏好設定 

在偏好設定對話方塊中，您可以對 OCR、表單、一般、訪問、歷史記錄、內容、簽名、全螢

幕、文件、檔案關聯、信任管理器及頁面顯示等選項的參數進行設定。您所做的設定將會自

動生效，並保留到下次改動之前。 

1. 選擇 [檔案] 功能表 > [偏好設定]； 

2. 在左邊的選項面板中選擇需要修改參數的專案。 
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第三章 – 閱讀 

對 Foxit PhantomPDF軟體的工作區及工具列熟悉之後，您可以開始體驗 PDF文件閱讀。您可

以開啟 PDF 文件、隨意進入任何指定頁面、調整文件視圖、通過文字閱讀器閱讀純文字、

閱讀文件的同時收聽文件內容等等。您還可以閱讀檔包。 

開啟/關閉/儲存 PDF文件 

開啟 PDF文件 

在Foxit PhantomPDF軟體中開啟PDF文件 

選擇下列方式之一進行操作： 

 選擇 [檔案] > [開啟]，或在程式視窗標題列上點擊開啟按鈕 ，在 [開啟] 對話方塊中

選擇需要開啟的文件，點擊 [確定]。PDF文件通常以.pdf為副檔名。 

 直接將PDF文件拖進程式視窗中。 

注意: 當您在程式中開啟多個PDF文件時，可以通過點擊文件顯示區上方的標籤來切換各個

文件。 

在桌面或其他程式中開啟 PDF文件 

如果您已將Foxit PhantomPDF軟體設定為預設PDF瀏覽器，您就可以在下列程式中開啟PDF文

件： 

 郵件程式：在大部分常用郵件應用程式中，滑鼠雙擊附件圖示可開啟文件。 

 網頁瀏覽器：在網頁中點擊PDF文件連結，可以查閱嵌入HTML中的PDF文件。 

 檔案系統：在檔案系統中，直接滑鼠雙擊PDF文件。 

開啟安全保護的 PDF文件 

如果您收到受到安全保護的PDF文件，則需要使用密碼才能開啟。部分受保護文件對列印、

編輯、複製等功能有限制。 

 當開啟受保護的PDF文件時，程式將提示您輸入密碼。 

 當您嘗試複製或編輯該文件時，程式將提示：必須取得文件所有者的授權。 

當您用其他PDF程式開啟受Foxit PhantomPDF軟體的AD RMS功能保護的某PDF文件，系統會彈

出一個包裹程式 (其實是PDF格式的一頁內容) 提示您下載Foxit PhantomPDF軟體來開啟該

PDF文件。如果您想編輯該包裹程式內容，請編輯後將其儲存名為“wrapper PDF”的PDF檔
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案並存放於Foxit PhantomPDF軟體的安裝目錄下。 

在 Foxit PhantomPDF軟體中獲取最近開啟過的 PDF文件 

在  [檔案] 功能表列的下拉式功能表中，您能快速獲取最近開啟過的PDF文件。Foxit 

PhantomPDF軟體能夠列出一些最近開啟過的PDF文件。選擇 [檔案] > [開啟] > [最近使用檔

案]。  

注意: 如需設定顯示最近使用過的檔數目，請選擇 [檔案] > [偏好設定] > [歷史記錄]。 

儲存 PDF文件 

儲存 PDF複件 

1. 選擇 [檔案] > [另存新檔]； 

2. 在另存新檔對話方塊中，輸入檔案名稱並指定儲存路徑，點擊儲存。 

將 PDF文件儲存為文字文件 

1. 選擇 [檔案] > [另存新檔]； 

2. 在另存新檔對話方塊中選擇副檔名； 

3. 輸入檔案名稱並指定儲存路徑並點擊儲存。 

注: 為了機密起見，此功能允許 PDF文件以不同檔案類型出現，就好像這些 PDF文件是在除

PDF之外的不同平臺中建立的。 

關閉 PDF文件 

請按以下方式操作： 

如果是多標籤瀏覽模式，關閉 PDF文件請點擊 Foxit PhantomPDF軟體程式視窗的標籤欄中點

擊該文件的關閉按鈕即可；若要關閉所有開啟的 PDF文件，則點擊程式視窗的關閉按鈕。 

如果是單文件介面模式，則點擊程式視窗的關閉按鈕即可。 

匯出 PDF文件 

匯出 PDF文件為Word、RTF、Excel、PPT或 HTML文件 

1. 選擇[檔案] > [匯出]； 

2. 選擇您要轉換的格式； 

3. 在 [另存新檔] 對話方塊中您還可以在 [設定] 中選擇 PDF 文件中所用的語言，以確保
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轉換後的檔案品質。 

匯出 PDF文件為影像檔 

1. 選擇[檔案] > [匯出] > [成 Image]； 

2. 指定頁面範圍 (所有頁面、目前頁面、某範圍內的頁面) 並點擊確定； 

3. 儲存前您可以在設定中選擇品質、顏色空間和解析度； 

4. 點擊 [儲存]。 

與 IFilter的綁定 

Foxit PhantomPDF軟體已經和 Foxit PDF IFilter桌上出版本綁定，使用者可在大批次的 PDF文

件中索引並快速在桌面系統中找到這些文件。您可以在 Foxit PhantomPDF軟體的安裝路徑下

啟動 Foxit PDF IFilter。更多詳細資訊，請參閱《Foxit PDF IFilter使用者手冊》    。 

PDF標準驗證及建立符合 PDF相應標準的文件 

 

Foxit PhantomPDF軟體的業界標準功能，在多種用途中可以建立或驗證是否符合 PDF標準。

本軟體支援 PDF/A、PDF/E和 PDF/X三種標準的驗證功能和建立符合這些標準的 PDF文件。

點擊 [主頁] 功能表 > [相容性] 標籤 > [業界標準] 按鈕 ，選擇一種標準，在彈出的對

話方塊中點擊 [分析] 或 [分析並修復] 選項。您也可以通過另存新檔符合 PDF/A、PDF/E或

PDF/X標準的文件來建立符合標準的 PDF文件。 (僅適用於企業版) 

閱讀 

Foxit PhantomPDF軟體提供多種 PDF閱讀模式，包括多標籤閱讀及單一文件閱讀。 

多標籤閱讀及單一文件閱讀 

多標籤瀏覽 

多標籤瀏覽允許您在一個程式視窗中開啟多個文件。PDF文件以標籤形式顯示。 

啟用/取消多標籤瀏覽，請選擇 [檔案] > [偏好設定] > [文件] > 取消勾選/勾選允許多實例。 
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Chapter 1 - Overview 


Welcome to Foxit PDF IFilter -- a professional tool that helps you to index PDF files. 


Foxit PDF IFilter is an application that extracts the contents, properties, bookmarks, forms, 


annotations and attachments from PDF documents, indexes them, and returns the 


indexed results to the search engine so that users can search PDF documents with 


keywords.  


Foxit PDF IFilter supports PDF 1.7 specification and can be used in many Microsoft 


search engines, such as Windows Indexing Service, MSN Desktop Search, and all other 


products based on Microsoft Search technology. With Foxit PDF IFilter, all these search 


engines can find PDF files with ease. 


Operation Systems 


 Windows 7 (32-bit & 64-bit). 


 Windows 8 (32-bit & 64-bit). 


Note： If you want to run Foxit PDF IFilter on both desktop and server environment, 


please try this version. 


Why PDF IFilter? 


PDF IFilter is necessary for several reasons: 


 Microsoft creates and maintains office file formats, such as .doc, .xls, .ppt, etc. 


However, many other file formats are created and maintained by other companies. 


For example, PDF was created by Adobe.  


 With the advantages of security, reliability and accessibility, PDF is now being used 


by more and more people all over the world. 


 PDF IFilter is a plug-in that allows Microsoft search engines to index PDF files so that 


they become searchable. Without an appropriate PDF IFilter, contents of a PDF file 


cannot be indexed. 


 


 


Why Foxit PDF IFilter? 



http://foxitsoftware.com/products/ifilter/register.php
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Foxit PDF IFilter is favored by a large number of governments and well-known companies 


because of the following reasons: 


 Foxit PDF IFilter helps to do index, which makes finding information much easier. 


 Foxit PDF IFilter supports native 64-bit code. 


 Smaller and faster than other PDF IFilters. 


 Supports twelve languages. Please go to Language Support part for details. 


How Foxit PDF IFilter works? 


Foxit PDF IFilter acts as a plug-in for full-text search engines. A search engine usually 


works in two steps: 


Step 1, the search engine goes through a designated place, e.g. a file folder or a 


database, and indexes all documents or newly modified documents, including PDF 


documents, in the background and creates internal data to store the indexed result. 


Step 2, a user specifies some keywords for search and the search engine looks up the 


indexing result and responds to the user with all the documents that contains the 


keywords. 


During Step 1, the search engine looks in the windows registry for appropriate IFilter 


implementations and uses those filters for indexing. It filters out embedded formatting and 


extracts text from the document and returns the result. Foxit PDF IFilter is one such 


implementation. Further information about the IFilter specification can be found on the 


Microsoft Web site. 


Key Benefits 


 Integrates with existing operating systems and tools within your company. 


 Provides an easy solution to search within PDF documents located on the local 


computer, local network, and/or internet. 


 Greatly increases your ability to accurately locate information. 


 Much smaller and faster than PDF IFilters offered by other vendors. 


 Supports Chinese/Japanese/Korean PDF documents. 


 Supports native 64-bit code. 



http://msdn2.microsoft.com/en-us/library/ms691105.aspx
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Chapter 2 - Getting Started 


Installing Foxit PDF IFilter  


On the Foxit PhantomPDF installation setup, click on Foxit PDF IFilter and choose the 


option “Will be installed on local hard drive” shown as below to complete the installation. 


 


 


 


Note:  


1. Foxit PDF IFilter has no user interface. 


2. Foxit PDF IFilter Desktop Version is packaged with Foxit PhantomPDF. Therefore, 


Foxit PDF IFilter will be chosen to be installed by default when Foxit PhantomPDF is 


installed. 


Configuring Foxit PDF IFilter 


Foxit PDF IFilter adds five configurable registry items under 


“HKEY_LOCAL_MACHINE\SOFTWARE\Foxit Software\Foxit PDF IFilter” directory: 


FilterBookmarks [REG_DWORD] – sets the value to decide whether to filter out 


bookmarks. 0 represents no and other values represent yes. 


FilterAttachFile [REG_DWORD] – sets the value to decide whether to filter out 


attachments. 0 represents no and other values represent yes. 







                              Foxit PDF IFilter for Desktop 


 7 


FilterAnnotation [REG_DWORD] – sets the value to decide whether to filter out 


annotations. 0 represents no and other values represent yes. 


LogLevel [REG_DWORD] – sets the log level. Value can be from 0 to 3. 


0 - no output  


1 - error log only. Includes error information when errors happen, and stack message 


when the application crashes. 


2 - simple log which only includes the main calling functions and returned values. 


3 - detailed log which includes specific information such as date, and chunk. 


LogFilePath [REG_SZ] – sets the output path of log file. 


Note: The default setting in Foxit PDF IFilter is to filter out bookmarks, attachments and 


annotations, but not to filter out any log information. The default output path of log file is 


the installation folder of Foxit PDF IFilter. Restart application if you made any changes to 


the registry. 


Uninstalling Foxit PDF IFilter 


Foxit PDF IFilter doesn’t have separate uninstalling application and needs to be 


uninstalled by running the package of Foxit PhantomPDF. 


1. Double-click the “FoxitPhantomPDF_Setup.exe” and a setup wizard will pop up. Click 


Next to continue. 
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2. Choose Change in the dialog box and click Next. 


 


3. Click on the “Foxit PDF IFilter” button  and then choose Entire feature will be 


unavailable in the context menu. Then choose Next to continue. 
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4. In the pop-up dialog box, select Change to uninstall the Foxit PDF IFilter. 
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5. Click Finish button to complete uninstalling. 
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Chapter 3 - Foxit PDF IFilter for 


WDS  


Foxit PDF IFilter is able to search text in PDF files, Email PDF attachments, and PDFs in 


Database Fields (BLOB), etc. After you install Foxit PDF IFilter, you should index all 


documents and re-build index data with Windows Desktop Search (WDS) before you start 


a search. 


Working in Windows 8 and Windows 7 


WDS functionality is already built into Windows 8 and Windows 7.  


Indexing PDFs 


With Foxit PDF IFilter, you can index PDF properties and file contents. After installing 


Foxit PDF IFilter, please note that “Index Properties and File Contents” will be selected 


automatically in File Types tab of Advanced Options dialog box.  


 


The Advanced Options dialog box with Foxit PDF IFilter 
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Note: Before installing the Foxit PDF IFilter, “Index Properties Only” is selected by default. 


Setting index locations 


You can have Microsoft Windows Desktop Search index any locations that contain PDF 


files. Once the index is complete, Windows Desktop Search is able to use this index to 


find text in PDF quickly. Please make sure all desired locations are included. 


To select the locations where PDF files exist and you want to search, do the following: 


 Select Start > Control Panel > Indexing Options to open the Indexing Options tool. 


 Click the Modify button to add or subtract specific files/folders from the search index. 


 In the Indexed Locations dialog box, select the locations that you want, and click OK. 
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Indexing selected items 


Once you select the locations and click OK, Windows Desktop Search will start the 


indexing task automatically. 


 


 


Indexing complete 


Notes: 


1. If you just installed Foxit PDF IFilter or the IFilter has just been upgraded, you’ll have 


to index all documents and rebuild index data. 


2. Windows Desktop Search updates the index every time that you add or change a file 


or an e-mail message. You don’t need to re-index PDF files unless the IFilter is 


reinstalled or updated. 
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Searching PDFs 


After you finish indexing PDF files, you can start a search for the contents and properties 


such as author, title, etc. of your files.  


To start a search, do the following: 


 Click to open a drive or a folder that contains the PDF file that you want to search. 


 Type your search words in the search box at the top right corner of the window. 


 


The search box 


 Windows Desktop Results appear immediately as you type the search words. 


 


 
Search results 


 Double-click one of the search results to open it with your default PDF Reader. You 


can select “How does indexing affect searches” in Indexing Options for more help. 


 


 


 


 


 


Window 7 
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Chapter 4 - Additional Information 


Microsoft Developer Support 


Foxit PDF IFilter is a Dynamic Link Library (DLL) file that provides a bridge between a 


Microsoft indexing client and a library of PDF files. It consists of code that understands the 


PDF Format as well as code that can interface with the indexing client. When an indexing 


client needs to index content from PDF files, it will look in its registry for an appropriate 


DLL and will find the Foxit PDF IFilter. Foxit PDF IFilter will return text to the indexing 


client. The indexing client will then index the results and return the appropriate results to 


the user. 


Language Support 


This section lists languages supported by Foxit PDF IFilter. 


 German 


 French 


 Italian 


 English 


 Spanish 


 Portuguese 


 Russian 


 Chinese (traditional and simplified) 


 Korean 


 Japanese 


 Arabic 


 Hebrew 
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標籤欄  

單一文件瀏覽 

單一文件瀏覽允許您每開啟一個文件都啟用新的程式視窗。 

 啟用/取消單一文件瀏覽，請選擇 [檔案] > [偏好設定] > [文件] > 勾選/取消勾選允許多

實例。 

閱讀內容 

進入指定頁面閱讀 

點擊 [檢視] 功能表下 [跳到] 選項中的 [首頁]、[末頁]、[前一頁]、[後一頁] 按鈕可閱讀指

定頁面，這些按鈕在狀態列中也能找到 。您也可以直接在框中輸入頁碼進入指定頁面。另

外，還有 [前一視圖] 和 [下一視圖] 兩個按鈕，分別指的是返回到目前視圖的上一次視圖

和目前視圖的下一次視圖。 

 

運用書籤閱讀 

通過書籤可以進入指定標題閱讀。點擊導覽面板上的書籤按鈕 ，點擊相應書籤或滑鼠右

擊相應書籤在下拉式功能表中選擇 [跳至書籤] 即可。點擊書籤前面的 [+] 號和 [-] 號 (如

下圖) 可以展開或收起書籤下一層內容。 
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運用頁面縮圖閱讀 

通過頁面縮圖可以進入到指定頁面。點擊左邊導覽面板中的頁面縮圖按鈕 。可以發現紅

色框的內容為當前視圖，故可通過移動紅色框來把視圖定位到目前頁面的其他位置，也可通

過滑鼠右擊某頁面縮圖在下拉式功能表中選擇 [放大頁面預覽] 或 [縮小頁面預覽] 來縮放

頁面縮圖。 

 

閱讀 PDF歷程文件 (portfolio) 

歷程文件是一種含多種檔案格式的檔案集合，如 Word 文件、文字文件和試算表等。Foxit 

PhantomPDF軟體支援查看和列印歷程文件功能，支援在歷程文件中搜尋關鍵字功能。  
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PDF 文件包樣例 

 下載一個歷程文件樣本 (最好含有多種不同格式的檔案)； 

 滑鼠右擊該歷程文件，選擇 [通過 Foxit PhantomPDF軟體開啟]； 

 開啟後，在歷程文件裡瀏覽各個檔案； 

 在搜尋框中或按下 CTRL+ Shift + F 鍵後輸入關鍵字搜尋文件。 

在 PDF文件中搜尋/索引 

查尋文字 

要進行簡單快速查尋，請執行以下操作： 

 按一下功能表列的搜尋框 ； 

A.全詞限制——搜尋僅限於全詞。例如，如果你搜尋單詞 Read，Reader 則不會被發現。 

B.大小寫不同——使搜尋會特別地區分大小寫。例如，如果你搜尋 text，Text 和 TEXT

將不會被發現。 

C.書籤檢索——可以搜尋到包含在整個文件中的某個詞彙，包括書籤。 

D.評論檢索——可以搜尋到包含在整個文件中的某個詞彙，包括評論 

 在查尋框內輸入想要查尋的文字，按 Enter 鍵，程式將跳至您搜尋文字的第一個實例並

以螢光標示。 

 按一下或按下快速鍵 Shift + F3 和 F3 查詢上一個或下一個結果，或按 Enter 以找到下一

個結果. 
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Foxit PhantomPDF軟體支持進階搜尋功能，即您不僅可以在一個檔案中搜尋文字，還可以在

指定資料夾下的多個檔案中進行搜尋。查尋結束時，所有的實例將以樹狀羅列，您可以點擊

其中任何一個實例跳到該位置。  

要進行進階搜尋，請執行以下操作： 

 按一下工具列上的進階搜尋工具 ，在搜尋對話方塊中鍵入您想要查尋的文字，指定

搜尋範圍，然後執行以下操作： 

A. 要搜尋您輸入的全字示例，請選擇 [全字拼寫須相符]。例如，您搜尋單字 Read，則

不會顯示單字 Reader。  

B. 要搜尋相符您輸入大小寫單字的示例，請選擇 [大小寫須相符]。例如，您搜尋單字

text，則不會顯示單字 Text和 TEXT。 

C. 搜尋範圍若須包括書籤在內的文字，請選擇 [包含書籤]。  

D. 搜尋範圍若須包括注釋在內的文字，請選擇 [包含注釋]。 

 按一下搜尋。程式將跳至您搜尋文字的第一個實例並以螢光標示。所有的實例將以樹狀

羅列，您可以點擊其中任何一個實例跳到該位置。 

 按一下 [新建搜尋] 進行新的查尋，或按一下搜尋框頂端的關閉按鈕結束搜尋。 

移動和調整搜尋框 

進階搜尋框可以浮動或停泊，也可以調整它的大小。 

 要使停泊搜尋框變為浮動框，滑鼠雙擊標題列。 

 要移動浮動搜尋框，拖動它的標題列到頁面的任意位置。 

 要調整搜尋框大小，按住滑鼠左鍵，將游標放在搜尋框的邊界上任意一點拖動。 

 要停泊浮動搜尋框，再次滑鼠雙擊標題列。 

OCR功能 

OCR (Optical Character Recognition，光學文字辨識) 是指電子設備 (例如掃描器或數碼相機)

檢查紙上列印的字元，通過檢測暗、亮的模式確定其形狀，然後用文字識別方法將形狀翻譯

成電腦文字的過程；即，對文字資料進行掃描，然後對影像檔進行分析處理，獲取文字及版

面資訊的過程。當需要將紙質文件掃描並建立成電子文件或對現有的電子文件 (如 PDF文件) 

進行操作時，OCR是最常用的一種方式。  

 在單個檔中識別文字 

在 PDF檔案中識別文字，請按以下步驟操作： 

點擊 [主頁] 功能表 > [OCR] 標籤 > [OCR] > [目前檔案]，在彈出的 [識別文字] 對話方塊中，

指定識別範圍並點擊 [確認] 繼續。在 [選擇 OCR引擎] 對話方塊中，  
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1. 從語言清單中選擇文件的語言，您也可以選擇多種語言； 

2. 在 [輸出類型] 中，勾選 [可搜尋文字的圖片]，這樣您在查尋文字時也可以搜尋到文件

中圖片上的文字。點擊 [確定] 開始識別文字； 

注: 如果您在 [輸出類型] 中選擇了 [可編輯文字]，原文件中的圖片物件將被移除，只剩下

從此圖片中識別出的文字。 

3. 文字識別進度狀態欄將會彈出顯示進度。  

 

4. 識別結束後，再執行搜尋功能，您會發現原來在圖片上或掃描文件中的文字也可以被搜

尋到。  

您也可以在開啟的圖片或掃描的文件中識別文字。  

在多個檔中識別文字： 

1. 點擊 [主頁] 功能表 > [OCR] > [多個檔案]； 

2. 在彈出的 [OCR多個檔案] 對話方塊中，點擊 [增加檔案] 增加文件或資料夾。點擊 [上

移]、[下移]、[移除] 可以調整檔的順序，然後點擊 [確定]； 

3. 選擇目的檔案夾和為檔命名； 

4. 點擊 [確定] 完成識別。 
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請參閱 “在單個檔案中識別文字” 

 查尋並更正 OCR可疑元素 

在 PDF 檔案中識別完圖片文字或掃描文字後，您還可以將模糊不確定的文字辨認出並進行

更正，操作步驟如下： 

1. 點擊 [主頁] 功能表> [OCR] > [疑似錯誤結果] > [所有疑似錯誤]，然後彈出 [查尋 OCR疑

似錯誤] 對話方塊，查尋完成後立即彈出 [查尋結束] 資訊框； 

  

“查尋 OCR 疑似錯誤”對話方塊 

注: 疑似錯誤結果預設是基於 [搜尋文件] 而得出的結果。您也可以選擇 [搜尋網頁面] 在目

前頁面查尋疑似錯誤，重複以上操作。 

2. 在“查找 OCR疑似錯誤”對話方塊顯示了文本中的疑似錯誤。如該疑似錯誤被錯誤地識

別成文本，請點擊“不是文本”。點擊“查找下一個”查找下一個疑似錯誤，或點擊“接

受並繼續查找”接受該疑似錯誤並繼續查找下一個疑似錯誤。 

3. 如果您點擊“主頁”功能表 >“OCR”>“疑似錯誤結果”>“所有疑似錯誤”，也將彈

出“查找 OCR 疑似錯誤”對話方塊，且所有 OCR 疑似錯誤將被用紅色框高亮出來，如

下圖： 
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OCR 前的文本 

 

OCR 文本后的疑似错误结果 

您可以檢查高亮文本，在錯誤的地方點擊並輸入正確的文本。若高亮部分原本就不是文本，

可在“查找 OCR疑似錯誤”對話方塊中點擊“不是文本”； 

4. 檢查完畢後，關閉“查找 OCR疑似錯誤”對話方塊。 

調整資料頁面檢視 

Foxit PhantomPDF軟體提供了許多工具方便您快速調整文件的視圖，包括一些基本工具，如

放大和縮小工具，以及一些進階工具，如設定頁面配置和方向等。 

調整頁面縮放率 

請按以下方式之一操作： 

1. 在 [主頁] 功能表 > [縮放] 標籤，選擇放大按鈕 或縮小按鈕 。 

2. 滑鼠右擊文件區，選擇放大或縮小。 

注：此工具結合滑鼠各種操作方便使用者操作。當您點擊頁面某點，此縮放工具將以此點為

顯示視窗中心進行縮放。如果您在頁面上拖畫某個矩形框，然後釋放滑鼠，那麼此工具將以

此框作為視窗中心進行縮放。如果您在滾動滑鼠滾輪時按住Ctrl鍵，那麼向前滾動則放大文

件，向後滾動則縮小文件。 

3. 在同一標籤的縮放值區選擇或輸入特定的縮放率。 

4. 使用選框工具 
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選擇“視圖”功能表上的“輔助”選項 > 選框工具。游標變成 。用游標在頁面上拖動成矩

形或者點擊頁面以將其放大至一個預先設定的狀態，聚焦於剛才所點擊的位置。 

5. 選擇選框工具，游標變成 並按Ctrl點擊頁面。在頁面上拖動成矩形方框或是點擊頁面來

減少放大率。放大鏡工具 

 選擇 [檢視] 功能表 > [助手] 標籤 > [放大鏡] 工具 ； 

 您可以隨著放大鏡在頁面上的移動，近距離地查看頁面的任意位置； 

 (可選) 選擇 [放大鏡工具] 對話方塊裡的 [鎖定] 選項，點擊您想近距離查看的文件區，

一個紅色矩形框出現在文件區，相應地矩形框裡內容被顯示在 [放大鏡工具] 對話方

塊裡，您可以拖動或改變矩形框大小來改變放大鏡工具裡的內容； 

 您可以在放大鏡工具縮放文字方塊裡輸入一個數值或拖動放大鏡的滑塊，改變放大鏡

的縮放率。 

 

6. 模擬放大鏡工具 

使用Foxit PhantomPDF軟體的模擬放大鏡工具可以輕鬆地放大頁面的任何區域。該工具

對視力不好的使用者特別有幫助。 

  

    平面放大                      球面放大 

 按一下 [檢視] 功能表 > [助手] 標籤 > [模擬放大鏡] 工具 ； 

 移動模擬放大鏡到您想查看的文件頁面的任意位置； 

 按下滑鼠左鍵，在平面放大和球面放大間切換； 

 按下滑鼠右鍵改變放大鏡視窗尺寸； 

 要關閉放大鏡，選擇其它任何工具。 
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調整頁面以符合視窗 

您有三種調整類型可以選擇： 

 要調整以符合整個文件窗格頁面，請選擇 [主頁] > [縮放] > [符合頁面] 按鈕，或滑鼠右

擊文件區然後選擇 [符合頁面] 按鈕。 

 要調整以符合視窗的寬度，請選擇 [主頁] > [縮放] > [符合寬度] 按鈕，或滑鼠右擊文件

區然後選擇 [符合寬度] 按鈕，頁面的一部分可能不可見。 

 要調整以實際大小顯示頁面，請選擇 [主頁] > [縮放] > [實際大小] 按鈕，或滑鼠右擊文

件區然後選擇 [實際大小] 按鈕。 

 調整頁面以符合視窗範圍，並移除頁邊距，請選擇 [主頁] > [縮放] > [符合視區] 按鈕。 

調整頁面顯示 

您可以通過旋轉工具改變頁面的方向，例如修改縱向頁面為橫向頁面。請按以下方式之一操

作： 

 選擇 [主頁] 功能表 > [工具] 標籤 > [旋轉視圖] 按鈕。 

 選擇 [檢視] 功能表 > [頁面顯示] 標籤 > [旋轉視圖] 按鈕，在下拉式功能表中選擇 

[向左] 按鈕 或 [向右] 按鈕 。 

 滑鼠右擊文字區，選擇 [順時針旋轉] 工具。 

注：您可以90度的增量更改資料頁面檢視，但其只更改頁面的視圖並非更改文件的實際方向。

您無法儲存本更改。 

當您需要調整文件大小預覽文件佈局時，可以對頁面的佈局進行更改。Foxit PhantomPDF軟

體提供了以下幾種頁面配置： 

 單頁檢視 - 一次顯示一頁，其它頁面的部分不可見。 

 啟用捲動 - 豎排連續的顯示單頁頁面。 

 雙頁檢視  - 一次並排同時顯示兩頁，其它部分的頁面不可見。 

 啟用雙頁捲動  - 豎排連續顯示雙聯頁面。 

 單獨顯示封面 - 雙聯顯示時第一頁為單獨的封面頁。  

 分割  - 您可以在兩個 (分割命令) 或四個 (表格式分割命令) 窗口中瀏覽文

件。 

注:恢復單個視圖，選擇 [檢視] 功能表 > 取消對 [分割視圖]/[表格式拆分] 的勾選。 



Foxit PhantomPDF Business for HP 

用戶手冊 

24 

使用 [分割視圖] 視窗閱讀，您可以在一個視窗中捲動頁面、改變縮放比例或跳轉到其他頁

面，而不會影響到其他視窗。  

使用 [表格式分割] 閱讀模式，可以在捲動瀏覽目前頁面中比較大的表格或表單時，保證橫

向或縱向的標題可視。在此模式中，如改變一個視窗的縮放比例，則其他所有視窗的比例也

會相應改變。 

閱讀模式 

在閱讀模式下閱讀 PDF文件 

在閱讀模式下，導覽列、工具列、狀態列等使用者介面設定均被隱藏，此時文件區變大，減

少了不必要的空間，但是功能表列仍然可以使用。 

設定閱讀模式，請選以下其中一種方式操作： 

 選擇 [檢視] 功能表 > [文件視圖] 標籤 > [閱讀模式] 按鈕。 

 按快速鍵 Ctrl + H。 

 滑鼠右擊文件區選擇 [閱讀模式]。 

在閱讀模式下，當游標移到視窗底端時，出現一個漂浮的常用工具列，有儲存、列印、縮放

等工具。  

閱讀模式下如果您已開啟多個文件，可以按 Ctrl + Tab 鍵切換文件。 

退出閱讀模式，請按下列一種方式操作： 

 按一下 [檢視] 功能表 > [文件視圖] 標籤 > [閱讀模式]。 

 按快速鍵 Ctrl + H 。 

 按一下視窗底部懸浮常用工具列上的 [閱讀模式] 按鈕 。 

在全螢幕閱讀模式下閱讀 PDF文件 

在全螢幕模式下，功能表列、工具列、狀態列以及導覽列都將自動隱藏，滑鼠指標則可繼續

使用，可以點選連結。  

1. 設定全螢幕參數，請選擇 [檔案] 功能表 > [偏好設定] > [全螢幕]。 

2. 進入全螢幕模式，請選擇下列操作之一： 

 滑鼠右擊文件區選擇 [全螢幕]。 

 按快速鍵F11。 

3. 調整全螢幕視圖，請使用右鍵功能表。 
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注意：此功能只在取消 [按一下左鍵前進一頁，按一下右鍵後退一頁] 選項後生效。使用者

可在全螢幕參數中設定此項。 

4. 退出全螢幕模式，按如下其中一種方式操作： 

 使用 Esc鍵。 

 按快速鍵 F11。 

5. 全螢幕轉場效果 

Foxit PhantomPDF軟體支援多種全螢幕模式下的翻頁效果，包括：拆分、遮簾、方框、劃出、

分解、閃爍、飛入、推出、覆蓋、揭開和漸隱。同時，您也可以對這些效果的方向、速度、

頁面範圍做出設定。  

設定全螢幕轉場效果，請選擇 [檢視] 功能表 > [頁面配置] 標籤 > [頁面轉場] 按鈕。 

 

注:  

 此設定只對目前文件有效。 

 下次開啟並在全螢幕模式下閱讀此文件時仍保留此設定。 

 如需對所有由 Foxit PhantomPDF軟體開啟的 PDF文件進行頁面轉場設定，請進入 [檔案] 

> [偏好設定] > [全螢幕] 進行設定。 
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在反序閱讀模式下閱讀 PDF文件 

倒序閱讀文件，請按以下其中一種方式操作： 

 選擇 [檢視] 功能表> [文件視圖] 標籤 > [反序閱讀] 按鈕。 

 滑鼠右擊文件區選擇 [反序閱讀]。 

使用 Foxit文字檢視器閱讀 PDF文件 

使用 Foxit文字檢視器，可以在純文字模式下閱讀 PDF文件。像記事本一樣，您可以撇開圖

表僅使用文字。同時，您也可以根據需要進行設定。 

進入文字閱讀模式，選擇下列操作之一： 

 選擇 [檢視] 功能表> [文件視圖] 標籤> [文字檢視器]。 

 按快速鍵 Ctrl + 6。 

 自訂文字檢視器  

啟用文字檢視器之後，您可以使用字型設定工具自訂您的工作區。滑鼠右擊文字區並選擇字

型設定。 

1. 使用文字檢視器閱讀文件時改變文字字型 

 滑鼠右擊並選擇 [字型設定] > [字型]。  

 選擇字型名稱、字形、字型大小、顏色及效果。螢幕顯示效果最好是“Courier”字型。 
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2. 將字型變為粗體，請選擇 [字型設定] > [粗體]。 

3. 將字型變為斜體，請選擇 [字型設定] > [斜體]。 

4. 改變文字檢視器顏色。 

 滑鼠右擊選擇 [字型設定] > [顏色]。 

 [文字檢視器顏色] 對話方塊彈出。 

 

   拖動滑動桿改變前景和背景色。在下方的預覽框中可以預覽效果。 

   點擊 [確定] 完成設定，或點擊 [取消] 取消設定。 

5. 改變文字檢視器設定 
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  滑鼠右擊文字區 > 選擇 [設定]。 

  [文字檢視器設定] 對話方塊彈出。 

 

   文字檢視器設定如下： 

A. 設定 [目前頁面寬度]、[目前文件寬度] 和 [系統預設寬度]。 

B. 最小寬度 – 此項值的範圍為0-1024，預設為78。 

C. 保持列 – 對於PDF表單和文字列，您可以勾選此項以便在文字查看模式中保留合

適的列，此項為預設勾選項。 

D. 自動寬度 - Auto Width –對於PDF表單和文字列，您可以勾選此項以便在文字查看

模式中保留合適寬度，此項為預設勾選項。 

E. 自動旋轉 – 勾選此項可保證文件與印表機角度一致。此項為預設項。 

 在文字檢視器中導覽 

1. 跳至前一頁或後一頁，請選擇下列操作之一： 

 選擇 [檢視] > [跳到] > [上一頁] /[下一頁] 。 

 點擊狀態列中的上一頁按鈕 或下一頁按鈕 。 

 將滑鼠指標移至文件顯示區後，使用鍵盤上的左右鍵。 

2. 跳至首頁或末頁，請選擇下列操作之一： 

 選擇 [檢視] > [跳到] > [首頁]  或 [末頁] 。 

 點擊狀態列中的首頁 和末頁 按鈕。 
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 使用鍵盤下的起始或結束按鍵。 

3. 跳到指定頁面，請選擇下列操作之一： 

 選擇 [檢視] > [跳到] > 輸入目標頁面 > 按Enter鍵。 

 在狀態列中的目前頁面面顯示框中 輸入或選擇目標頁碼並按下

Enter鍵。 

 改變文件的縮放比例 

請選擇下列操作之一： 

1. 在狀態列中點擊放大圖示 或縮小圖示 。  

2. 選擇 [主頁] > [縮放] > [放大] /[縮小] 。  

注: [縮放至] 按鈕  在文字檢視器中不可用。 

 在文字檢視器中查尋文字 

查尋文字，按如下步驟操作：  

 在功能表列的搜尋框 輸入所要查尋的文字。 

 要進行進階搜尋，請執行以下操作： 

1. 按一下工具列上的進階搜尋工具 ，在搜尋對話方塊中鍵入您想要查尋的文字，

指定搜尋範圍，然後執行以下操作： 

A. 要搜尋您輸入的全字示例，請選擇 [全字拼寫須相符]。例如，您搜尋單字 Read，

則不會顯示單字 Reader。   

B. 要搜尋相符您輸入大小寫單字的示例，請選擇 [大小寫須相符]。例如，您搜尋

單字 text，則不會顯示單字 Text和 TEXT。 

C. 搜尋範圍若須包括書籤在內的文字，請選擇 [包含書籤]。 

D. 搜尋範圍若須包括注釋在內的文字，請選擇 [包含注釋]。 

2. 按一下 [搜尋]。程式將跳至您搜尋文字的第一個實例並以螢光標示。所有的實例將

以樹狀羅列，您可以點擊其中任何一個實例跳轉到該位置。 

3. 按一下 [新建搜尋] 進行新的查尋，或按一下搜尋框頂端的關閉按鈕結束搜尋。 

 在文字檢視器中複製/貼上文字 
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1. 選擇文字 

 選擇一個字：滑鼠雙擊目標。 

 選擇一行：拖動滑鼠選擇文字。 

 選擇所有文字：使用 Ctrl+A或滑鼠右擊文字並選擇全選。 

2. 複製文字，請選擇一下操作之一： 

 滑鼠右擊選擇好的文字 > 選擇複製。 

 選擇好文字後，使用快速鍵 Ctrl + C。 

3. 貼上文字 

將文字貼上至其他程式中，請遵循特定程式的貼上命令。 

朗讀 PDF文件 

什麼是朗讀 PDF文件？ 

朗讀 PDF文件是一種“文字到語音”工具，能將 PDF中的文字 (包括注釋中的文字及圖像或

填寫欄位的文字描述等) 朗讀出來。此功能讓您無需用眼閱讀就能獲得文件資訊，可有效緩

解眼睛疲勞。您在聽的同時還可以閱讀其他材料。 

啟用朗讀功能，請執行以下操作： 

 選擇 [檢視] > [助手] > [朗讀] > [朗讀目前頁面] 或 [從目前頁面開始朗讀]。 

朗讀偏好設定 

進入 [檔案] > [偏好設定] > [朗讀]。 

在 [朗讀] 選項中，您可以控制朗讀音量、語速、語音和音調。您還可以選擇是否朗讀文件

中的注釋。 

朗讀動作 

在朗讀模式下，Foxit PhantomPDF軟體給使用者提供了一些簡單的動作，如 [朗讀目前頁面]、 

[從目前頁面開始朗讀]、[暫停]、[重新開始]、[加快速度]、[減緩速度]、[停止]等。 

1. 在 Ribbon工具列模式下，按一下 [檢視] > [助手]，選擇所需按鈕。 
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2. 在經典模式下，在您點擊 [檢視] > [工具列] > [朗讀] 按鈕後，介面上會彈出一個漂浮的

簡易的朗讀工具列。 

朗讀功能會啟用您系統中的可用語音。若您從“文字至語音”安裝了 SAPI 5語音或其他語言

應用程式，您就可以通過它們來朗讀 PDF文件。 

注：該朗讀功能不是螢幕閱讀器，而且在某些作業系統可能不可用。 

尺規、參閱線及測量 

使用尺規和輔助線 

Foxit PhantomPDF軟體提供了水平和垂直尺規輔助線來説明您調整頁面上的文字、圖像或其

它物件的位置使他們對齊，也可以檢查圖像的大小尺寸和頁邊距。 

 

尺規 & 輔助線 

A. 尺規  B. 輔助線 

顯示或隱藏尺規/輔助線，請選擇 [檢視] > 勾選或不勾選尺規/輔助線。 

建立尺規輔助線，請執行以下操作：  

 按一下水平尺規，按住滑鼠左鍵不放向下拖動，建立水平尺規線；按一下垂直尺規，

按住滑鼠左鍵不放，向尺規右方拖動，建立垂直尺規線。 

 滑鼠雙擊水平尺規上任一位置，建立垂直尺規線；滑鼠雙擊垂直尺規上的任一位置，

建立水平尺規線。 

移動尺規/輔助線，請選擇手形工具，將指針移至輔助線上並使用滑鼠左鍵拖動其到新的位
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置。 

改變度量單位，請用滑鼠滑鼠右擊水平或垂直尺規，在彈出的功能表裡選擇需要的度量單

位。 

刪除尺規/輔助線，請執行以下操作之一： 

 刪除一條尺規輔助線：首先按一下該尺規輔助線選中，然後按鍵盤上的 [Delete] 鍵。 

 刪除某頁面上所有尺規輔助線：定位到該頁面，滑鼠右擊尺規，選擇 [清除頁面輔助

線]。 

 刪除所有尺規輔助線：滑鼠右擊尺規，選擇 [清除所有輔助線]。 

使用測量工具 

您可以使用測量工具來測量文件中物件的距離和面積。當您要確定表單或輔助設計檔案中物

件的距離或面積，或者要在發送文件到專業印表機之前測量文件的某些區域時，測量工具特

別有用。     

當您在使用測量工具時，工具對話方塊會顯示拖畫線段的測量資訊。 

 測量物件 

請選擇 [注釋] > [測量] > 選擇測量工具，然後執行以下任一操作： 

 請選擇距離工具 來測量兩點之間的距離。請滑鼠點擊一下第一點，移動指標到第二

點，然後再點擊一下。測量資訊將顯示在工具對話方塊中。 

 請選擇周長工具 來測量多點之間的一組距離。請滑鼠點擊一下您要測量的每一點並

滑鼠雙擊最後一點。 

 請選擇面積工具 來測量拖畫線段內的區域面積。請滑鼠點擊一下您要測量的每一點，

在您至少已點擊一下了兩個點之後，請點擊一下第一點或滑鼠雙擊最後一點來完成面積

測量。 

注：您可以通過右鍵功能表選擇完成或取消測量。 

在測量物件時，請在彈出的工具對話方塊中執行以下任一操作： 

 要更改繪畫區的縮放比例 (例如 1:2)，請在工具對話方塊中輸入適當的數位。如果需要，

請更改比率旁邊的度量單位。 

 如果您想要拖畫的線條顯示為注釋，請在工具對話方塊中選擇“測量標記”。然後，您

可以使用手形工具來滑鼠雙擊注釋並查看拖畫線段的測量資訊。 

注：如果您未選中“測量標記”，則您所拖畫的物件將消失。 
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 例如： 

 

 

 

 編輯測量物件 

在完成測量操作後，您可以對測量物件進行其它的編輯操作，如移動位置、調整大小、翻轉

及其它類似注釋的操作等等。 

1. 移動測量物件 

 請選擇手形工具 或選擇標注工具 ，點擊您要移動的測量物件。 

 將游標放置於測量物件中，待游標變為 形狀時，按住滑鼠左鍵，將測量物件拖至其它

位置。 

A. 選擇距離工具並將縮放比例設

置為 2:1。 
1英寸 = 2 英寸 

 

B. 可以看到實際距離為 4.16 英

寸，由於縮放比例為 2:1，因此

圖內距離為 8.32 英寸 

。 

4.16 英寸 

1 英 寸

=2 英寸 
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2. 更改線段長度和方向 

 請選擇手形工具 或選擇標注工具 ，點擊測量物件，選擇其中一個縮放點 ，此時

游標將變為 。  

 左鍵拖動即可更改線段的長度和方向。 

3. 反轉測量物件和注釋 

您可以隨時翻轉您繪製的測量物件和注釋，如： 

 

翻轉前                        翻轉後 

要翻轉測量物件和注釋，請執行以下操作： 

 請選擇手形工具 或標注選擇工具 。 

 按右鍵您所繪製的測量物件 > 選擇翻動。 

 將測量對象作為注釋 

您可以將測量物件視為普通的文字注釋而進行操作。不僅可以對其設定狀態、開啟彈出式注

釋、刪除測量標注、回復標注，還可以修改其屬性，設定目前屬性為預設。具體的操作方法，

請參閱第七章 注釋。 

文件比對 

文件比對功能讓您可以查閱兩個不同版式的PDF文件之間的差別，進而更恰當地選擇更加符

合需要的版式。此功能不對PDF中的注釋做出比對。 

比對新舊文件 

 選擇 [注釋] 功能表 > [比對] 標籤 > [比對] 按鈕。 
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比對 PDF 文件對話方塊 

 通過 [選擇] 按鈕選擇需要比對的兩個文件並可以對它們進行預覽。 

 拖動下方的滑動桿選擇比對頁面。 

 在 [比對範圍] 中，選擇項目： 

所有 – 選擇新/舊文件的所有頁面進行比對 

頁面 - 從新/舊文件中選擇頁面進行比對 

 在 [比對類型] 中，選擇項目： 

按頁面標識不同 –比對視覺上的不同，如文字、圖像、注釋等。 

文字差異 – 僅比對兩個文件中的文字。 

包含字型資訊 – 比對文字的同時還比對文字格式。 

標注顏色 - 選擇比對結果顯示的顏色。 

 點擊 [確定]。比對結果將顯示在一個Foxit PhantomPDF軟體自動建立的名為“比對結果”

的PDF文件中。 

發送 PDF郵件 

當您需要把一份正在閱讀的PDF文件發送給客戶來促進日常工作或是想和朋友分享一個有

趣的故事，“發送郵件”就是一個非常有用的功能。 

電子郵件發送PDF文件，請按下列步驟操作： 
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 選擇 [分享] > [發送到] > [電子郵件]； 

 系統預設的郵件程式將自動執行； 

 PDF文件將會自動附件至郵件中； 

 輸入主題和位址，點擊發送。 

選擇&複製 

Foxit PhantomPDF軟體允許您複製文字及圖像至其他程式中。 

選擇和複製文字 

選擇文字工具允許您選擇 PDF文件中的橫向文字和縱向文字。Foxit PhantomPDF軟體中每個

Ribbon工具列下都有手形工具和選擇工具，隨手可及。 

選擇文字 

 選擇一行：沿所要選擇的一行按住左鍵拖動滑鼠。 

 選擇一列: 將游標停放在行間，按一下時滑鼠變成 ，沿一列拖動滑鼠在其上方畫出一

個矩形。 

 選擇一個字：滑鼠雙擊需要選擇的字。 

 選擇頁面中的多段：將滑鼠移至段落的開頭，按住滑鼠左鍵並拖動到末尾，釋放滑鼠。 

 選擇所有文字：按下 Ctrl + A或選擇部分文字並在右鍵功能表中選擇全選。 

 取消全選：按一下文字的任何區域取消全選。 

複製文字 

選中文字後，執行以下任一操作： 

 滑鼠右擊選中的文字 > 選擇複製。 

 使用快速鍵 Ctrl + C。 

貼上文字 

將剪貼簿中的文字貼上至其他程式中，請根據具體程式的貼上命令進行操作。 

複製圖像 

您可以將圖片複製並貼上至剪貼簿、其他程式或其他檔中。  

快照 
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複製圖片，可選擇快照工具： 

 選擇 [主頁] > [快照] 工具 ，然後游標自動變成  ； 

 拖動滑鼠選擇快照區； 

 程式將提示您選定區域已被複製到剪貼簿； 

 (可選) 滑鼠右擊選定區域並選擇複製已選圖形； 

 將選定區域的內容貼上至其他程式。 

注：此選定區域會被藍色螢光標示出來。 

快照整頁 

您還可以通過快照工具 複製整個頁面，即文字和圖像將被一起複製成一個圖像。 

 點擊 [主頁] > [快照]，選擇快照工具； 

 在頁面在任意的區域按一下，或滑鼠右擊頁面任意一處並選擇全選； 

要取消全選，請按一下頁面任意區域。 

 程式將提示您選定區域已被複製到剪貼簿； 

 (可選) 滑鼠右擊選定區域並選擇複製已選圖形； 

 將選定區域的內容貼上至其他程式。 

注意：此選定區域會被藍色螢光標示出來。 

將文字和圖像複製為單個圖像 

您可以使用快照工具將所有選擇的內容 (文字、圖像或兩者) 複製到剪貼簿或其他程式中。

文字和圖像將被複製為一個圖像。 

將文字和圖像複製為一個圖像，請執行以下操作： 

 選擇 [主頁] 功能表 > 點擊快照工具； 

 拖動滑鼠選擇文字和圖像； 

 程式將提示您選定區域已被複製到剪貼簿； 

 (可選) 滑鼠右擊選定區域並選擇複製已選圖形； 

 將選定區域的內容貼上至其他程式。 
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其他 

東亞語言包 

您可以通過Foxit PhantomPDF軟體直接開啟一個包含例如繁體中文、簡體中文、日文及韓文

這樣的東亞語言的PDF檔案。東亞語言包已被包含在Foxit PhantomPDF軟體壓縮包內，我們

將不再提醒您下載需要的語言包。Foxit PhantomPDF軟體讓您能夠直接閱讀、查詢和列印包

含語言文字的PDF檔案。 

注：如要更新東亞語言包，使用者可到幫助下的檢查更新中下載並安裝更新版本。 

PDF屬性 

查看 PDF屬性，請選擇 [檔案] > [文件屬性]。您可以查看以下相關資訊： 

描述 

此標籤描述了文件的基本資訊，包括標題、建立者、主題以及關鍵字等。您可以在 PDF 文

件中編輯此類資訊以便於搜尋和索引文件。 

初始視圖 

當開啟 PDF文件時，PDF文件將以其初始設定來顯示。您可以設定初始視圖，包括縮放比例、

頁面及頁面配置等。如果您的 PDF 是作為演示文件使用，您可以設定初始視圖為全螢幕模

式。設定好初始視圖後，您就可以給文件中所選頁面增加頁面轉場效果了。 
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初始視圖標籤 

定義初始視圖為全螢幕模式 

當設定初始視圖為全螢幕模式時，您需要定義如何開啟文件。 

1. 選擇 [檔案] > [文件屬性]；  

2. 在 [文件屬性] 對話方塊中，選擇 [初始視圖]。  

3. 請按下列步驟操作以達到最好的顯示效果： 

 在 [導覽標籤] 中選擇 [僅頁面]。 

 在 [頁面配置] 中選擇 [單頁]。 

 在 [開啟頁面] 選項中輸入您希望開始演示的頁面。 

4. 選擇以 [全螢幕模式開啟] 並點擊 [確定] (您可以儲存並重新開啟檔查看效果)。  

注：可以使用 Esc鍵退出全螢幕模式。在全螢幕模式中，使用者只能通過快速鍵使用各項命

令和工具。您也可以設定一些頁面動作來實現這個功能。  

安全 

此標籤描述了文件的使用權限。文件的所有安全資訊都列在這裡，如使用了密碼加密等。 
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安全標籤 

請參閱“查看 PDF安全性” 

字型 

顯示原始文件所使用的字型以及字型編碼。 

 

字型標籤 
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GPO功能 

GPO (Group Policy，群組原則)，微軟Windows NT系列作業系統中的一個功能，是為了控制

使用者和電腦的帳戶工作環境而設定的一系列規則。GPO 提供了作業系統的中央管理和配

置、應用及活動目錄 (Active Directory) 環境下使用者的設定。 

Foxit PhantomPDF 軟體的 GPO 使用說明，請見附件“Foxit PhantomPDF 軟體群組原則手

冊”    。如果您無法開啟此處兩個附件，請進入 [檔案] 功能表 > [偏好設定] > [信任管理

器]，取消勾選 [安全閱讀模式] 即可。 
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What is Group Policy?             


Group Policy (GPO), a feature of the Microsoft Windows NT family of operating systems, is a set 


of rules that control the working environment of user accounts and computer accounts. It offers 


the centralized management and configuration of operating systems, applications, and users' 


settings in an Active Directory environment. 


 


Group Policy can configure most system settings, save power by utilizing smart power settings, 


give individual users more control over their machines with administrator privileges and increase 


system security.  


 


This guide will introduce steps to help you master how to quickly add and modify the new GPO 


template for configuring your installation of Foxit PhantomPDF. 


 


Personal Computer Setting 


There are two file types of group policy template of Foxit PhantomPDF: .adm and .admx. 


Different types are compatible with different operation systems, but have the same settings. The 


template of .adm file type is compatible with Windows XP and later, while .admx is compatible 


with Server 2008, Server 2012, Windows Vista and later. 


Set Template Preference 


For .adm file, follow the steps as below: 


 Please click Start > Run or use the shortcut key Ctrl + R and type gpedit.msc to open Group 


Policy Editor. 


 Right-click the management template and choose Add/Remove Template in the context 


menu. In the opened dialogue box, add the group policy template of Foxit PhantomPDF. The 


Foxit PhantomPDF template will appear in the left navigation pane and you can set its 


template preferences. 



http://en.wikipedia.org/wiki/Windows_NT

http://en.wikipedia.org/wiki/Operating_system

http://en.wikipedia.org/wiki/Active_Directory
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For .admx file, put the .admx file in C:\Windows\PolicyDefinitions and do the setting. The .admx 


file should be used in combination with an .adml file. And the .adml file should be put in 


C:\Windows\PolicyDefinitions\language. For example, if in the English OS, the .adml file should 


be put in C:\Windows\PolicyDefinitions\en_us. 


Example: Not Show Community language 


 Choose Foxit PhantomPDF > Preferences > Not Show Community language. 


 Double-click Not Show Community language to open the dialog box and check the option 


Enabled. If Enabled only the official languages will show in the FILE > Preferences > 


Language. 


 If the option Not Configured or Disabled is checked, the languages translated by community 


will be displayed. 
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 Other settings can be configured in the same way. 


 To add tools to the default toolbar menu, please go to Foxit PhantomPDF > Toolbars > 


Custom Toolbars > double-click the target menu, check Enabled and check the desired tools 


to be shown on the default toolbar. 


 


Note: Group Policy setting includes computer configuration and user configuration.  


Computer configuration takes precedence over user configuration. The application will use the 


computer configuration if both the computer and user configure a specific function at the same 


time. Please note that if the option Disabled is a valid configuration, the setting will be shown in 


the help information. Otherwise, the corresponding registry entry will be removed as selecting 


Unconfigured. (The value of the option Disabled in the Group Policy Template of Foxit 


PhantomPDF is invalid.)  


 


GPO Deployment (for Server) 


Create GPO Management 


 If you already have an Active Directory domain and organizational unit configured, please 


skip to “Apply the Foxit Template” section. 


 Choose Start >Administration Tools> open “Active Directory Users and Computers”> 


right-click the field “wx.com”> choose New >Organization Unit in the right-click menu.   
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 In the opened New Organization Unit dialogue box, type the unit name (For this example, 


we have named the unit “qa”) and click OK. 
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 Right click the created organization unit “qa” and choose New > User in the right-click menu. 


For this example, we have named the user “King” 


 


 
 


 
 


 Click Start > Programs > Administration Tools > open the Group Policy Management Console 
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and right-click the created organization unit “qa” and choose Create a GPO in this domain, 


and Link it here…. 


 


 
If you cannot find the Group Policy Management in Administration Tools, please install the 


application package GPMC.MSI. You can download the package by clicking the link 


http://www.microsoft.com/en-us/download/details.aspx?id=21895. 



http://www.microsoft.com/en-us/download/details.aspx?id=21895
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Apply the Foxit Template 


 
 


 Type the GPO name in the “New GPO” dialogue box and click OK. 


 


 
 


 Right-click the new GPO and choose Edit in the right-click menu to open Group Policy Editor. 


 







GPO User Manual 


 ©  2014 Foxit Corporation  9 


 
 


 Right-click the Template Management and choose Add/Remove Template to add the 


template. Please refer to Set Template Preference.  


 


 


 


 For configuring options, please refer to Example: Not Show Community language. 
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GPO Items 


The following table introduces some simple manipulations in GPO to speed up your working 


process. 


 


Items in GPO Template 


 


Folder Path Item Options Description 


Foxit 


PhantomPDF 


> Plugin 


Remove 


Specific 


Plugins 


 Input the plugin names which need to be removed. 


Only support the one with .fpi extension in the 


application folder of Foxit PhantomPDF ('..\Foxit 


PhantomPDF\plugins). 


Remove 


Plugins 


 Check the plugin which need to be removed. 


Foxit 


PhantomPDF 


> 


Preferences > 


Rights 


Management 


Service 


Use 


Deprecated 


Encryption 


Algorithms 


 Check ‘Use deprecated encryption algorithms to be 


compatible with the previous version’ to support 


RSA 1024 for encryption and disable the related 


settings of RMS Setting in 'Preferences' menu. 


If you have no option, there is the enhanced AD 


RMS cryptographic implementation. It supports RSA 


2048 for encryption. 


Only operating systems in the following list can 


support 'Enhanced AD RMS cryptographic 


implementation'. 


AD RMS servers must be running Windows Server® 


2008 R2 with Service Pack 1 (SP1) 


AD RMS client computers running one of the 


following operating systems 


Windows® 8 


Windows® 7 with Service Pack 1 (SP1) 


Windows Vista® with Service Pack 2 (SP2) 


Windows Server® 2008 with Service Pack 2 (SP2) 


Windows Server 2008 R2 with Service Pack 1 (SP1) 


Encrypt 


metadata 


 Check 'Encrypt Metadata' to encrypt document 


metadata and disable the related settings of RMS 


Setting in 'Preferences' menu. 
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Forbid Web 


Viewing of 


Protected 


Content 


 Check 'Forbid Web View' to forbid users to view 


protected content using a browser add-on. 


Use AD RMS 


Plug-in V1 


 If you enable this option, it will use the RMS Plug-in 


V1 to support Windows XP. The PDF file protected 


by RMS Plug-in V1 will be saved in Foxit protected 


PDF format and can only be opened by Foxit 


product. RMS Plug-in V1 only supports SHA-1/RSA 


1024 for encryption and decryption. 


If you disable this option, it will use the RMS Plug-in 


V2 and support Windows Vista SP2 and later. The 


RMS Plug-in V2 supports SHA-1/RSA 1024 and 


SHA-2/RSA 2048 for encryption and decryption. 


Foxit 


PhantomPDF 


> Preferences 


‘About Foxit 


PhantomPDF’ 


Dialog 


Copyright 


Content 


Logo Path 


Frame Title Path 


Logo Path: Modify the path of logo image at the 


top-right corner. The original picture is 'Foxit'. 


Frame Title Path: Modify the path of frame title on 


the left. The original picture is 'Foxit PhantomPDF'.  


Note: 


1. Image Format can be png, jpg, gif, bmp, jpeg. 


2. Image size: (logo) 64x21 pixels, (title) 195x37 


pixels. 


3. Path can be an absolute path (such as 


D:\Picture\1.jpg) or a relative path (take Foxit 


PhantomPDF for example: \New About\1.jpg). 


Foxit 


PhantomPDF 


> Preferences 


Forbid 


Checking for 


Default PDF 


Viewer 


 If you enable this option, it will not pop up this 


dialog when Foxit PhantomPDF Reader is not your 


default PDF Reader. 


Foxit 


PhantomPDF 


> Preferences 


Home Page 


Setting 


Menu Name Modify the property of item 'Foxit Corporation 


Home Page' in 'Help' menu. URL 


Foxit 


PhantomPDF 


> Preferences 


Main 


Program 


Name 


Main Program 


Name 


Change the main program name. 


Foxit 


PhantomPDF 


> Preferences 


Set as Safe 


Reading 


Mode 


Set as Safe 


Reading Mode 


Check 'Set as Safe Reading Mode' to enable Safe 


Reading Mode. 


Check 'Forbid Modification' to disable the related 


settings of Trust Manager in 'Preferences' menu. 


Forbid 


Modification  
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Foxit 


PhantomPDF 


> Preferences 


Toolbar Mode Classic Toolbar 


Mode 


Check 'Classic Mode' to set Foxit PhantomPDF 


running under 'Classic Toolbar Mode. 


Check 'Forbid Modification' to remove the options 


of Change Toolbar Mode under UI Options in View 


menu. 


Forbid 


Modification  


Foxit 


PhantomPDF


> 


Menus >men


u name. 


Choose the 


menu you 


want to 


modify. 


(The menus 


and the 


items layout 


is the same 


with Foxit 


PhantomPDF 


User 


Interface.) 


Choose the 


item on the 


correspondin


g menu. 


Choose the 


option on the 


corresponding 


item. 


Check the options which need to be deleted from 


the menu. 


Foxit 


PhantomPDF 


>Toolbars> 


Custom 


Toolbars 


Toolbar Name Choose the tools 


which need to be 


displayed in the 


default toolbar. 


Check the desired tools to be displayed in the 


default toolbar. 


Foxit 


PhantomPDF 


> Toolbars > 


Delete 


Button 


Toolbar Name Choose the 


buttons which 


need to be 


removed from 


the toolbar. 


Check the desired tools to be removed from the 


corresponding toolbars. 


Foxit 


PhantomPDF 


>Preferences 


Not Show 


Community 


language 


 If you enable this option, it will merely show official 


languages. If you disable this option, it will show 


languages translated by community. 
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第四章 – 建立 

Foxit PhantomPDF 軟體建立 PDF 文件的速度是其他同類產品的 3 倍，在很大程度上簡化了

PDF及 PDF/A文件的建立流程。只需點擊滑鼠便可迅速將所有常用文件轉換為 PDF格式，並

且不需要開啟任何其他協力廠商程式。 

用不同方式建立 PDF文件 

使用 Foxit PhantomPDF軟體，您可以輕鬆地從不同的檔案格式的檔中建立 PDF文件。 

一鍵建立 

只需把要轉換的檔案拖入 Foxit PhantomPDF軟體的程式視窗中便可將其轉換成 PDF文件；

或者在 Windows 瀏覽器中您也可以用 Foxit PDF 處理軟體快速地將檔案直接轉換成 PDF 格

式。  

一鍵建立，請執行以下方式之一： 

 將文件直接拖至桌面 Foxit PhantomPDF軟體的圖示上 。 

 如果程式是開啟的，則可直接將文件拖入程式視窗。  

 滑鼠右擊需要轉換的文件，從下拉式功能表中選擇“在 Foxit PhantomPDF軟體中轉換成

PDF”。 

從 Foxit PhantomPDF軟體程式視窗中建立 PDF文件 

單一文件轉換 

您可以從辦公軟體、電子郵件、網站中建立 PDF 文件，或把任何可列印的文件轉換成 PDF

文件。 

1. 啟動 Foxit PhantomPDF軟體，選擇 [檔案] 功能表 > [建立] > [從文件]； 

2. 在 [開啟] 對話方塊中，當您從 [檔案類型] 功能表中選擇了 [所有支持檔 (如*.xls， 

*.xlt， …)]，您可以瀏覽所有檔案類型； 

3. 選擇您要轉換的檔案，點擊 [開啟] 將該檔轉換成 PDF文件； 

4. 在 [另存新檔] 對話方塊中，輸入檔案名稱，指定儲存路徑。 

注： 根據被轉換檔的不同類型，會彈出相應的轉換過程對話方塊，然後自動開啟 Foxit 
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PhantomPDF軟體視窗。 

多文件轉換 

通過簡單的操作，您可以將不同類型的檔轉換併合並為單一 PDF文件。 

1. 選擇 [檔案] 功能表 > [建立] > [從多個檔案]； 

2. 在“多個檔案轉換”對話方塊中，點擊 [增加檔案] 來選擇您要轉換的檔案； 

3. 通過 [上移]、[下移] 按鈕可以隨意調整檔順序，點擊表格標題或拖放檔來改變檔順序。 

4. 選擇轉換 PDF檔案的方式，然後點擊 [轉換]： 

 批次轉換成 PDF檔案 – 所有的檔案將被轉換成各自的 PDF檔案。 

 將多個檔案合併生成一個 PDF檔案 – 所有的檔案將被轉換成一個 PDF檔案。 

技巧：預設情況下，當選擇把多個文件轉換為單一的 PDF文件時，Foxit PhantomPDF軟體將

原始各檔的檔名作為書籤。 

空白頁轉換 

通過 Foxit PhantomPDF軟體，無需從一個檔案、剪貼簿圖片或掃描文件，您就可以從一個空

白頁開始建立 PDF文件。 

1. 選擇 [檔案]  > [建立] > [空白]； 

2. 選擇 [編輯] > [編輯內容] 標籤 > [文字和段落] 編輯工具，或選擇 [注釋] > [打字機] 標

籤 > [打字機] 工具； 

3. 滑鼠雙擊空白頁面開始輸入您要增加到空白頁的文字； 

4. 您可以根據需要選擇其他工具和選項對該 PDF文件進行其他應用；  

5. 選擇 [檔案] > [另存新檔]，選擇檔案名稱和位置儲存該 PDF文件。  

從剪貼簿中建立 PDF文件 

您還可以直接從剪貼簿中建立一個 PDF文件。 

1. 選擇 [檔案] > [建立] > [從剪貼簿]； 

2. 然後剪貼簿上的文字或圖形將被轉換成一個新的 PDF文件。 

在其他程式中建立 PDF文件 

Foxit PhantomPDF軟體是一款智慧的 PDF建立工具，允許您從微軟辦公軟體中直接將文件轉

換為 PDF檔案，並自動保留書籤、連結、超連結、佈局等元素。本小節以 word文件為例，

為您詳細說明使用方法。 

微軟辦公軟體 
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在微軟 word 2007/2010/2013中，Foxit PhantomPDF軟體作為一個標籤出現在 word的工作

區中。您只需簡單的幾個操作就可直接在 word文件中建立 PDF檔案。 

建立 PDF文件： 

從“Foxit PDF”標籤中選擇您所需要的 PDF設定，然後執行以下操作之一： 

 使用目前設定建立 PDF文件，請點擊建立 PDF按鈕 。  

 使用目前設定建立 PDF文件並將其作為郵件發送，請點擊按鈕 。 

建立 PDF/A-1b相容的 PDF文件： 

1. 在 [Foxit PDF] 標籤中，點擊 [設定] > [一般] > 勾選 [支援 PDF/A-1b標準] 並點擊 [確

定]。  

2. 點擊建立按鈕或建立並發送郵件按鈕。  

改變您的 PDF轉換設定： 

請點擊設定按鈕 進行設定。 

技巧：設定中的具體專案可參閱設定印表機屬性 。 

在微軟Word 2000和 2003中，Foxit PhantomPDF軟體為工具列的一組選項。 

記事本 

1. 開啟文字文件； 

2. 選擇 [檔案] > [列印]。 

瀏覽器 

1. 執行瀏覽器，並開啟一個頁面； 

2. 選擇主功能表上的 [檔案] > [列印]； 

3. 在列印選項中選擇 Foxit PhantomPDF Printer； 

4. 點擊“印表機內容”設定印表機屬性。具體操作可參閱設定印表機屬性； 

5. 點擊 [確定]； 

6. 在彈出的對話方塊中指定儲存路徑並輸入檔案名稱後，點擊 [儲存]。 

Outlook Express 

1. 執行郵件軟體並滑鼠雙擊開啟目標郵件； 
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2. 選擇 [檔案] > [列印]； 

3. 在列印選項中選擇 Foxit PhantomPDF Printer； 

4. 點擊“印表機內容”設定印表機屬性。具體操作可參閱設定印表機屬性； 

5. 點擊 [確定]； 

6. 在彈出的對話方塊中指定儲存路徑並輸入檔案名稱後，點擊 [儲存]。 

使用列印命令建立 PDF 

FoxitPDF虛擬印表機與普通印表機一樣，因此，您只需按照真實印表機的步驟對其進行操作

即可。 

1.  在程式中開啟檔案； 

2.  選擇 [檔案] > [列印]； 

3.  選擇[Foxit PDF虛擬印表機] 並點擊 [確定] 開始列印； 

4.  輸入檔案名稱並定義檔儲存位置； 

5.  點擊 [儲存]； 

6.  您將會看到建立的進度狀態列。完成後，PDF檔案將被自動開啟。 

從掃描器中建立 PDF文件 

Foxit PhantomPDF軟體為您提供一種簡單的方法，可將紙質文件直接掃描為 PDF檔案。 

將紙質文件掃描為 PDF檔案： 

1. 選擇 [檔案] > [建立] > [從掃描器]； 

2. 在“自訂掃描”對話方塊中設定輸入、輸出及文件選項並點擊 [掃描]； 

3. 指定儲存位址並輸入檔案名稱，點擊 [儲存]； 

4. 如有需要，可選擇 [繼續掃描] 繼續掃描其他文件； 

5. 或選擇 [完成掃描] 退出。 
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“自訂掃描”對話方塊 

 掃描器：選擇您所安裝的掃描器。確認電腦裡已安裝掃描軟體。 

掃描器選項 (僅Windows)：點擊開啟掃描器選項對話方塊。(選擇了掃描器後可用)。  

 轉換方式：“本機模式”用預設模式轉換掃描器，一次傳輸所有資料；“緩存模式”

用緩存模式轉換掃描器，分多次傳輸資料。 

 使用者介面：您可以選擇顯示或隱藏掃描器生產商提供的視窗和對話方塊。 

 輸入 

單雙面：指定單面或雙面掃描。 

色彩模式 (僅 Windows)：選擇您所安裝的掃描器支援的基本顏色模式 (彩色、黑白或

灰色)。如果在掃描器選項中設定使用 Foxit掃描對話方塊代替掃描器軟體，則此選項可

用。  

解析度 (僅 Windows)：選擇您的掃描器所支持的解析度。如果在掃描器選項中設定使

用 Foxit掃描對話方塊代替掃描器軟體，則此選項可用。  

注：如果您設定了掃描器不支援的顏色模式或解析度程式會彈出提示資訊，並讓您重新

選擇。 

頁面大小 (僅Windows)：選擇紙張大小，或者指定自訂寬度和高度。 

 輸出 

新建 PDF 文件：: 選擇此項建立新的 PDF 文件；若您要將掃描的頁面附到現有的 PDF



Foxit PhantomPDF Business for HP 

用戶手冊 

47 

文件，則取消勾選。 

附加到：如果您需要將產生的 PDF 附加到已存在的 PDF 中，則可勾選此項。您可以使

用瀏覽按鍵找到文件。 

 文件 

最佳化：點擊選項可自訂壓縮和篩選等相關專案。“最佳化選項”對話方塊中的圖像設

定選項，可以設定對 PDF 文件中的掃描圖像進行壓縮的方式。預設設定適用于各種文

件頁面，但是您可能要自訂設定以獲得更高品質的圖像和較小的檔案體積。 

 

彩色/灰度：當掃描彩色或灰度頁面時，請選擇下列選項之一： 

 高壓縮：縮小體積，使用高壓縮演算法壓縮圖像 (適用於企業版)。 

 JPEG：使用 JPEG壓縮法至整個灰色或 RGB輸入頁面。 

低/高品質：拖動游標以設定檔案大小和品質之間的平衡點  

黑白：當掃描黑白或單色圖像時，選擇以下任一選項： 

 高壓縮：運用高品質縮小體積圖像壓縮法。 

 CCITT Group 4：在輸入的頁面圖像上運用 CCITT Group 4壓縮法。 

 JBIG 2：bi-level圖像的壓縮標準，適用於無損失真壓縮。 

文字識別：請參閱“識別文字”。 

從書籤中建立 PDF文件的目錄 

閱讀 PDF 文件時，若需要從 PDF 文件中現有的書籤建立一個有階層結構的目錄，Foxit 

PhantomPDF軟體提供了兩種方式來建立目錄，產生的目錄將被插入到 PDF文件的首頁中： 

 將多文件建立成單一 PDF 文件時，在“批次轉換檔”對話方塊中選擇“從書籤生成新

的目錄頁”，將按各個所選檔的檔案名稱建立目錄頁面。 

 在目前 PDF文件中建立目錄，請按一下書籤面板的增加目錄按鈕 ，將按目前 PDF文

件中的書籤建立目錄。 
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第五章 – 編輯 

您可以使用基本編輯功能建立書籤、增加連結、附加檔案、插入圖片、播放多媒體檔案及執

行 JavaScript。您可以直接進入 [編輯] 功能表運用這些功能。 

復原和重複 

當快速對您的文件進行調整時，你需要對最近的操作進行復原或重複。在 Foxit PhantomPDF

軟體中，您最多可進行此項操作 10,000 次。  

復原上一次操作，請執行以下操作之一： 

 點擊程式視窗快速工具列中的復原按鈕 。 

 使用快速鍵 Ctrl +Z。 

注意：一些操作不能被復原，例如在檔功能表中增加命令。如果操作無法被復原，復原命令

將會變為灰色。. 

重複操作，請執行以下操作之一： 

 點擊快速工具工具列上的重複鍵 。 

 使用快速鍵 Press Shift + Ctrl + Z。 

增加頁眉頁腳、浮水印和背景 

為 PDF 檔增加頁面頁腳、浮水印和背景不僅可以使檔案更為專業，還能幫助您更方便地閱

讀、導覽文件及放置標記。 

頁眉及頁腳 

 增加頁眉頁腳，請執行以下操作： 

1. 開啟 [頁面管理] 功能表 > [頁面標記] 標籤> [頁眉頁腳] > [增加]； 

2. 在“增加頁眉頁腳”對話方塊中編輯文字； 
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增加頁眉頁腳對話方塊 

3. 點擊 [儲存] 儲存目前設定，該設定也可以直接用於之後的文件應用當中。 

4. 點擊 [確定] 來啟動該操作。 

 更新頁眉頁腳，請按下列步驟操作： 

1. 開啟 [頁面管理] 功能表 > [頁面標記] 標籤 > [頁眉頁腳] > [更新]； 

2.  在“更新頁眉和頁腳”對話方塊中更新內容； 

3. 點擊 [確定]。 

 移除頁眉頁腳，請按下列步驟操作： 

1. 開啟 [頁面管理] 功能表 > [頁面標記] 標籤 > [頁眉頁腳] > [移除]； 

2. 在確認提示中點擊 [確定]。  

背景 

 增加背景，請按下列步驟操作： 

1. 選擇 [頁面管理] 功能表 > [頁面標記] 標籤 > [背景] > [增加]； 

2. 在“增加文件背景”對話方塊中設定背景： 

 選擇一種顏色或增加電腦中的檔案作為背景。如果檔案頁數較多，可選擇其中一

頁，並調整其比例。 

 調整背景的旋轉角度、透明度以及與目標頁的相對比例。點擊 [外觀選項] 可設定

此背景設定何時顯示。 

 設定放置的垂直距離和水平距離。 

 選擇應用背景的頁面範圍。 

 勾選 [顯示預覽] 可預覽增加後的效果。 
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3. 點擊 [儲存設定] 以後使用； 

4. 點擊 [確定] 啟用該背景設定。 

 更新背景，請按下列步驟操作： 

1. 選擇 [頁面管理] 功能表 > [頁面標記] 標籤 > [背景]> [更新]； 

2. 在“更新文件背景”對話方塊中更新內容； 

3. 點擊 [確定]。 

 移除背景，請按下列步驟操作： 

4. 選擇 [頁面管理] 功能表 > [頁面標記] 標籤 > [背景] > [移除]； 

5. 在確認提示中點擊 [確定]。  

浮水印 

 為文件增加浮水印，請按下列步驟操作： 

1. 選擇 [頁面管理] 功能表 > [頁面標記] 標籤 > [浮水印] > [增加]； 

2. 在“增加文件浮水印”對話方塊中編輯浮水印： 

 輸入文字並選擇字型、大小和顏色作為浮水印。或從電腦中增加一個檔案作為浮

水印。如果檔案包含多個頁面，請選擇其中一頁，並調整比例。 

 選擇浮水印的旋轉角度、透明度以及與目標頁面的相對比例，同時選擇在文件中

顯示的位置。點擊“外觀選項”可設定此浮水印設定何時顯示。 

 若您選擇 [在頁面下方顯示]，則頁面內容將覆蓋浮水印的部分內容。 

 若您選擇 [在頁面上方顯示]，則該浮水印將覆蓋部分頁面內容，但您可以通
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過設定浮水印的透明度進行調整。 

 調整浮水印與文件的垂直距離和水平距離。 

 選擇增加浮水印的頁面範圍。 

 勾選 [顯示預覽] 可以預覽增加後的效果。 

 

3. 點擊 [儲存設定] 以後使用；  

4. 點擊 [確定] 啟用該浮水印設定。 

 更新浮水印，請按下列步驟操作： 

1. 選擇 [頁面管理] 功能表 > [頁面標記] 標籤 > [浮水印] > [更新]； 

2. 在“更新文件浮水印”對話方塊中更新內容； 

3. 點擊 [確定]。 

 移除浮水印，請按下列步驟操作： 

a) 選擇 [頁面管理] 功能表 > [頁面標記] 標籤 > [浮水印] > [移除]； 

b) 在確認提示中點擊 [確定]。 

貝茨數字 

貝茨數字是什麼？ 

貝茨數字經常用在法律、醫學和商業領域中，用來在圖像或文件中放置識別編號、日期或時
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間等識別字。這些編號只包含數位或字母或數位字母的混合體。每個文件的每頁都有單獨的

貝茨數字，這也是一種方便的識別和檢索索引法律文件的方法。  

增加貝茨數字 

1. 選擇 [頁面管理] 功能表 > [頁面標記] 標籤 > [貝茨數字] > [增加]； 

2. 在“增加貝茨數”對話方塊中，選擇 [增加文件]、[增加資料夾] 或 [增加開啟的文件] 

增加要增加的文件或資料夾。在檔案列表中，您可以點擊 [上移] 和 [下移] 來調整順

序或點擊 [移除] 來刪除檔案； 

 

3. 點擊 [輸出選項]，您可以設定目的檔案夾、命名檔案和建立日誌檔，然後點擊 [確定]； 

4. 點擊 [確定] 後，在彈出的 [增加文件頁眉頁腳] 對話方塊中，您可以插入貝茨數字； 
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 點擊 [插入貝茨數]； 

 在彈出的對話方塊中，設定貝茨數位數、起始數、首碼/尾碼等，設定完成後點擊 [確

定]； 

 

 最後請按一下 [確定]。 

移除貝茨數字 

選擇 [頁面管理] 功能表 > [頁面標記] 標籤> [貝茨數字] > [移除]。 

連結 

此功能幫助您將讀者引導至相關的文章、資料或網頁中。  
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Foxit PhantomPDF軟體提供了矩形連結工具 和書籤 。 

增加矩形連結 

矩形連結工具使您在 PDF上增加的連結帶有矩形框。 

請按下列步驟增加矩形連接： 

 選擇 [編輯] > [插入] > ； 

 將滑鼠指標移至需要增加連結的位置，按住左鍵並拖動滑鼠畫出矩形框。 

技巧：按下 shift鍵並用滑鼠拖畫即可得到正方形的連結框。 

 在彈出的“建立連結”對話方塊裡選擇外觀及跳轉的目標位置。 

 外觀 

A. 線寬：矩形框四條邊框的寬度。值越高，則變寬越粗。該項值的範圍為 0-12，預設

為 1。 

B. 線型：矩形框四條邊框的類型。程式提供三種類型供選擇： 

                           

實線                  虛線                    底線 

C. 螢光標示：點擊矩形連接時呈現的效果。程式提供四種效果供選擇： 

無：不改變連結的外觀。 

反色：變為相反的顏色。 

邊框：邊框顏色變為相反色。 

凹陷：矩形框呈現嵌入狀態。 

                      

無             反色             邊框            凹陷  
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D. 顏色：矩形框邊框的顏色。直接點擊選擇顏色或在調色板中自訂一種顏色。預設顏

色為紅色。 

 

選擇顏色 

 目標位置 

連結目標位置可以是目當前文件種的任何一個位置，任何一點，或者是一個網頁、指定

的檔案等等。程式提供四個選項： 

A. 跳轉到資料頁檢視：點選連結可跳轉到指定的資料頁檢視。您不僅可以指定目前文

件的某一頁，也可以指定其他 PDF 文件中的頁面。同時，您也可以改變目前的縮放設

定然後再設定位置。 

選擇 [跳轉到資料頁檢視] 並點擊 [下一步]： 

 將文件中的某一頁設為目標位置：捲動頁面至跳轉的目標位置後點將此處設為目標

位置。 

 跳轉至其他 PDF文件：在快速工具列上按一下開啟按鈕 並選擇需要跳轉的 PDF

文件。開啟文件後，捲動至目標位置並點擊將此處設為目標位置。  

注：新文件需在已開啟視窗中開啟，不能用新的視窗開啟。  

 改變縮放比率：捲動目當前文件或其他文件至目標位置並更改該處的縮放比率，然

後點擊將此處設為目標位置。 

 點擊取消取消該操作。 

B. 跳轉到命名位置：跳轉到已被目前文件的建立者設定並命名的位置。 
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選擇此項並點擊 [下一步] > 在彈出的命名位置的功能表中選擇一項 > 點擊 [確定]。 

注：如先前沒有命名任何位置則彈出錯誤提示。 

C. 開啟/執行某個檔：指定連結到其他檔案。請按下列步驟操作： 

 選擇 [開啟/執行檔] > 點擊 [下一步] > 選擇目的檔案 > 點擊 [開啟]。 

D. 開啟 web頁面：指定連結到某一個網頁。請按下列步驟操作： 

 選擇此項並點擊 [下一步] > 輸入目標頁面的 URL或點擊下拉鍵，選擇一個您曾經

開啟的頁面 > 點擊 [確定]。 

E. 其它 (開啟動作屬性對話方塊設定)：為連結增加一個動作，具體操作請參照“按鈕

屬性動作標籤”。 

移動或調整連結 

 用選擇標注工具 或連結工具選擇一個連結，並將游標移動至連結處直到游標變為三

角形； 

 然後執行以下任一操作： 

A. 移動連結，使用滑鼠將其拖動到目標位置。 

B. 調整連結，使用滑鼠拖動邊框上標注的點來調整邊框大小。 

刪除連結 

 用選擇標注工具 或連結工具選擇一個連結，並將游標移動至連結處直到游標變為三

角形； 

 按一下選中連結； 

 按下刪除鍵即可。 

附件 

您可以將 PDF 檔案或其他格式的檔案增加至 PDF 檔案中。程式提供兩種增加附件的方法：

增加檔案作為注釋和增加檔案至整個 PDF 文件中。如果增加檔案作為注釋，則在頁面中會

出現附件圖示  ，點擊此圖示即可開啟附件檔；而增加檔案至這個 PDF 文件中，該檔案

無法顯示在 PDF 文件中，只有點擊導覽面板中的附件按鈕才能顯示該檔案的圖示，可通過

滑鼠雙擊該檔案圖示來開啟它。 
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增加檔案作為注釋 

1. 選擇 [注釋] > [圖釘] > [檔案]； 

2. 移動游標至頁面上需要增加附件的目標位置 > 按一下滑鼠增加附件； 

3. 在增加附件對話方塊中選擇作為附件的檔案，並點擊開啟。 

備註：如果您試圖附上特定的檔案格式（例如 exe檔），Foxit PhantomPDF Business會做

出下列提示：由於您的安全設定您的附件將會被拒絕。 

4. 檔附件圖示  將出現在您指定的目標位置。 

5. 儲存 PDF檔案。 

編輯附件 

您可以開啟該附件文件、增加描述、移動或刪除檔案及其他設定等。 

 開啟附件 

選擇手形工具  或選擇標注工具  並執行下列操作： 

1. 滑鼠雙擊附件圖示 ； 

2. 在彈出的對話方塊中選擇一項並點擊確定； 

 

A. 開啟此附件：開啟當前圖示所代表的附件。當您滑鼠雙擊附件圖示時，程式總是彈

出此對話方塊。 

B. 總是開啟此類型的附件：開啟目前附件。當您滑鼠雙擊附件圖示時，程式自動開開

此類型的附件，不再彈出對話方塊。 

C. 從不開啟此類型的附件：禁止開啟此類型的附件。當您滑鼠雙擊附件圖示時，系統

將不會開啟此類型的附件，並會彈出提示框提示：由於安全許可權限制，無法開啟

此類型附件。 

請參照“安全設定”。 
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注意：如果您處於安全閱讀模式下，您將無法開啟附件。請選擇 [檔案] > [偏好設定] > [信任

管理器] > 取消安全閱讀模式。 

 移動附件 

選擇手形工具  或選擇標注工具 ，點擊並拖動滑鼠將附件移至目標位置。 

 刪除附件 

選擇手形工具  或選擇標注工具 ，並執行以下任一操作： 

 滑鼠右擊附件圖示並選擇刪除。 

 按一下附件圖示並使用刪除鍵。 

 其他操作 

您可以在附件上進行跟普通注釋相同的操作，包括：設定狀態、開啟彈出備註、增加描述等。

具體請參閱“第七章 注釋”。 

增加文件至整個文件 

1. 按一下導覽列上的附件按鈕 點擊增加按鈕 或選擇 [編輯]> [插入] > [檔案附件] 

按鈕 ； 

2. 在彈出的對話方塊中選擇目的檔案並按一下開啟； 

3. 增加的檔案將會顯示在附件面板中。 

 管理附件 

您可以開啟、儲存、刪除以及設定附件。請點擊導覽列上的附件圖示  > 開啟 /儲存

/增加 /編輯描述 /設定 /刪除附件 。 
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附件面板 

 安全設定 

為附件進行安全設定，請點擊附件面板上的設定按鈕 ，並按下列步驟操作： 

 增加新的副檔名，請點擊增加按鈕，在安全設定對話方塊中輸入副檔名稱。 

 刪除副檔名，請點擊已存在的副檔名並使用刪除鍵。 

 改變開啟附件的方式，請選中一個副檔名並在下面的設定列表中選擇一個執行方法。 

  

書籤 

書籤是導覽工具，您可以使用它快速方便的瀏覽文件。PDF文件裡的書籤提供互動式連結，

您只要按一下書籤就可以跳到指定的頁面進行閱讀。使用書籤可以方便地跳轉到做過標記的

位置。同時，您可以建立自己想要的書籤結構、名稱，如果安全許可，還可以編輯、刪除書

籤。 

增加書籤 

1. 定位至需要增加書籤的位置； 

2. 選擇需要增加書籤的位置的上一條書籤。因為如果選擇了某個現有的書籤，然後點擊新

建按鈕，則新增加的按鈕會被增加到該書籤的下一條 (同一級)。如果您沒有選擇某個現

有的書籤，則新增加的書籤將自動被增加到書籤清單的末尾； 

3. 點擊 [書籤] 面板頂部的 [新建書籤] 圖示 。或滑鼠右擊選中的書籤，在下拉式功能

表中選擇 [增加書籤]； 
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4. 輸入或編輯新書籤的名稱，按 Return鍵即可。 

移動書籤 

選擇您想要移動的書籤，執行以下任一操作： 

 按下滑鼠左鍵不放，直接拖動書籤圖示 放到您想要放置的任何地方。這個虛線圖示

顯示了您將要放置的位置。 

 滑鼠滑鼠右擊書籤圖示 ，在彈出的功能表裡選擇“剪下”，滑鼠滑鼠右擊想要移動

到該位置上的書籤，選擇 [貼上到所選書籤後面] 或 [貼上到所選書籤下面]，若選擇前

者，則把書籤移動到所選書籤的後面，和選中的書籤是同級；若選擇後者，則把書籤

移動到所選書籤的下一級。 

注：移動後，書籤所連結的頁面不變。 

重組書籤 

書籤是階層結構，是不同層級的大綱。書籤是快速瀏覽和定位 PDF 文件的一種有效方式，

它覆蓋文件的各個章節，使用者可以制定不同層級的書籤顯示文件內容。書籤可通過拖動書

籤圖示進行重組階層。 

嵌套書籤或將書籤從嵌套中移出，請參閱移動書籤。 

 展開或折疊書籤 

按一下書籤前的”+”，顯示所有的子書籤；按一下書籤前的”-”隱藏所有的子書籤（折疊）。 

編輯書籤 

Foxit PhantomPDF軟體中，在許可權允許的情況下，您可以根據需要重命名書籤、更改書籤

連結目標或自訂書籤外觀。  
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 重新命名書籤 

滑鼠右擊書籤，在彈出的功能表裡選擇重新命名。或者滑鼠雙擊需要重新命名的書籤，然後

輸入名稱。 

 更改書籤連結目標 

 在文件區，移動頁面到您想要設定的新的連結位置； 

 (可選) 調整瀏覽視圖； 

 滑鼠右擊書籤，選擇設定目標位置，然後在確定提示框中點擊 [確定]。 

 自訂書籤外觀 

 在書籤面板裡，滑鼠右擊書籤，選擇 [屬性]； 

 在屬性對話方塊裡，按一下 [外觀] 選項，選擇字型的類型和顏色。 

注：如需將目前設定的外觀作為預設的書籤外觀，可滑鼠右擊書籤，在右鍵功能表中選擇 [設

定目前外觀為預設]。 

 增加動作到書籤 

 滑鼠右擊書籤，選擇 [屬性]； 

 在屬性對話方塊裡，選擇 [動作] 選項； 

 從動作選項功能表裡選擇一個動作，然後按一下 [增加]。具體請參閱“按鈕屬性動作

標籤”。 

 刪除書籤，請按以下方式之一操作： 

 選擇您想要刪除的書籤，按一下書籤面板上的刪除按鈕 。 

 滑鼠右擊您想要刪除的書籤，選擇 [刪除]。 

注：書籤所包含的下階層書籤也會同時被刪除。 

圖像 

您可以在文件頁面任何區域指定一個矩形，然後插入圖片。此功能在您需要強而有力的解釋

或展示某些事物時特別有幫助。  

增加圖像 

您可以使用圖像工具 為 PDF增加圖片。完成增加後，還可以對圖像進行編輯。 
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請按下列步驟增加圖像： 

 選擇 [編輯] > [插入] > [圖像] 工具 . 

 在頁面中拖動滑鼠畫出圖像增加的區域； 

 在彈出的“增加圖像”對話方塊中點擊 [瀏覽] 選擇一個圖像並點擊 [開啟]，在 [位置] 

框中可以看到所選圖片的位址； 

 點擊 [進階] 按鈕對圖像進行設定。 

  

圖像設定對話方塊 

    A. 何時開始縮放：選擇何時縮放您插入的圖片。 

    B. 比例：按比例縮放圖像或不按比例縮放圖像。如果您在 [何時開始縮放] 中選擇從不

縮放圖像，則該選項不可用。 

C．邊框：拖動華動桿改變圖像中矩形框中的位置，隨著滑動桿的移動座標也相應改變。 

 點擊 [確定] 使設定生效；點擊 [重設] 則重新恢復原始設定； 

 點擊 [確定] 完成圖像的增加。 

增加圖像到其他頁面 

在頁面中增加一個圖像後，如有需要您還可以在其他頁面的相同位置也增加相同的圖片。 

要增加圖片到其他頁面，請按以下步驟操作： 

1. 滑鼠右擊您要增加到其他頁面的圖片； 

2. 在下拉式功能表中選擇 [放置到其他頁面]； 
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3. 指定頁面範圍； 

4. 點擊 [確定]。 

移動和調整圖像 

請按下列步驟移動圖像： 

1. 選擇標注工具 或圖像工具 ，並把滑鼠移至圖像上，這時滑鼠指標變成三角形 ； 

2. 按一下圖片不放並拖至目標位置。 

請按下列步驟調整圖像： 

1. 選擇標注工具 或圖像工具 。把滑鼠移至圖像上，這時滑鼠指標變成三角形 後

按一下圖像。 

 將游標移至圖像邊框的各個紅點上，滑鼠按一下並拖動紅點即可改變圖像大小。 

 

調整圖像 

 往外拖矩形的四個角將按比例增大圖像，向內拖則縮小圖像。 

設定圖像屬性 

1. 滑鼠雙擊圖像，或滑鼠右擊圖像並在右鍵功能表中選擇 [屬性]。 

2. 在外觀標籤中，你可以選擇 [隱藏注釋] 及設定圖片邊框。 

 鎖定：勾選此項將阻止之後對任何多媒體的修改。  

 關閉：應用且儲存目前屬性並關閉對話方塊。 

3. 設定標籤的設定，請參閱“增加圖像”。 

4. 動作標籤的設定，請參閱“按鈕屬性動作標籤”。 

刪除圖像 

1. 選擇標注工具 或圖像工具 。把滑鼠移至圖像上這時滑鼠指標變成三角形 後按

一下圖像； 

2. 使用刪除鍵或滑鼠右擊圖像 > [刪除]。 
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選擇多個圖像 

1. 選擇標注工具 或圖像工具 ； 

2. 按住 Shift鍵或 Ctrl鍵，點擊需要的圖片。 

對齊圖片 

 請選擇您要對齊的兩張或多張圖片。 

 按右鍵參照圖片，選擇相應的對齊模式： 

A. 縱向排列圖片，選擇 [靠左對齊] 將向參照圖片的左邊緣對齊、[靠右對齊] 將向參

照圖片的右邊緣對齊、[垂直對齊] 將向參照圖片的縱軸對齊。 

B. 橫向排列圖片，選擇 [頂部對齊] 將向參照圖片的頂邊對齊、[底部對齊] 將向參照

圖片的底邊對齊、[水平對齊] 將向參照圖片的橫軸對齊。 

注：當您按右鍵或按 Ctrl鍵並按一下選定的圖片時，它將以紅色螢光標示，表明它是參照圖

片。”對齊”功能表命令將移動其它選定圖片使其向參照圖片的邊緣對齊。 

請參閱以下示例： 

 

A. 假設以 A為參照圖像。 

A    
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居中圖像 

此功能説明您使選中的圖像水平、垂直居中或同時水平並垂直居中。 

請看下圖示例： 

 

 

B. 選擇這兩個圖像 > 右擊 A 圖

像並選擇  [對齊 ] > [靠左對

齊]。如左圖所示，您將看到另

一個圖像以 A 圖為參照，左邊

框對齊排列。 

A. 選中兩個圖像。右擊其中一個

圖片 > [居中] > [垂直居中]。 
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分佈圖像 

此功能僅在您選擇三張或三張以上的圖片時可用。 

 要均分最頂部和最底部的圖片，請選擇 [分佈] > [垂直分佈]。 

 要均分最左邊和最右邊的圖片，請選擇 [分佈] > [水平分佈]。 

請看下圖示例： 

 

  

調整圖片大小 

您可以將多個圖片設定為相同的高度、寬度和大小。選擇其中一個圖像作為參照，其餘圖像

的高、寬或大小將會調整為與參照圖像相等。 

請看下圖示例： 

A. 選擇 ABC 三個圖像。A 為頂層

圖像，C為底層圖像。 

A 

B 

C 

B.  右擊其中一個圖像 > [分佈] > [垂

直分佈]。您可以看見 B分佈在 A

和 C的中間。 

A 

B 

C 
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設定多個圖像屬性 

 選擇多個圖像 > 滑鼠右擊其中一個 > [屬性]； 

 在彈出的對話方塊中進行設定。具體操作請參閱“設定圖像屬性”。 

PDF最佳化 

使用PDF最佳化功能，使用者可以壓縮影像檔、清除PDF物件中重復的資料。 

 選擇 [檔案] > [PDF最佳化]； 

 在 PDF最佳化對話方塊中設定屬性。 

A. 選擇 AB兩個圖像。設定 A為參

照圖。 

A 

B 

A 

B 

B.  右擊 A圖 > [調整大小] > 設

置等高。B圖的高度將會與 A

圖一致。 
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PDF 最佳化對話方塊 

 圖像 – 您可以對顏色/灰度圖像和黑白圖像進行設定，包括平均縮小取樣、次取樣、雙

立方縮小取樣，或關閉取樣，並設定合適pixel和壓縮格式 (包括保留目前壓縮、JPEG和

高品質壓縮）。 

注：如果勾選 [僅在體積減小時最佳化圖像]，當沒有重復資料時，圖像將不會被最佳化。 

 字型 – 將需要取消的嵌入字型移動到右邊的面板中。 

 放棄物件 – 勾選需要放棄的物件。 

 放棄使用者資料 – 勾選需要放棄的資料。 

 清理 – 選擇進行文件最佳化的清理選項。 

 點擊 [確定] 並儲存完成最佳化的PDF檔。 

多媒體 

Foxit PhantomPDF軟體不僅支援在 PDF檔裡播放多媒體，而且允許使用者在 PDF中增加多媒

體並且可以對多媒體檔案進行編輯。 

播放視訊或音訊 

一些 PDF 文件可能包含多媒體，包括聲音、音樂以及視訊短片。每個視訊和音訊檔通常包

含可以被啟動的播放區。播放區在 PDF 頁面中通常顯示為一個隱藏的圖像或空白矩形框。

播放媒體文件，請確認您的電腦裡裝有多媒體播放器。 

請按下列步驟播放視訊或音訊： 

 選擇手形工具 並點擊視訊或音效檔的播放區。 
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注意：為了防止您的電腦感染病毒，Foxit PhantomPDF軟體在播放多媒體檔前將會彈出一個

對話方塊確認您的操作。 

  

關閉文件前記住目前選擇：如果勾選此選項，則下一次點擊播放此多媒體檔時，程式將直接

播放檔不會再次詢問。 

增加視訊或音訊剪輯 

增加視訊或音訊檔與插入圖像一樣，是很簡單的操作。視訊格式可以為 FLV、AVI、QuickTime

以及MPEG，且檔副檔名為 .avi、.wmv、.mov、.qt、.mpg以及.mpeg。音訊格式可以為 midis、

wavs以及 mp3 檔。 

注：如果程式彈出資訊告訴你沒有媒體檔可處理，則您在增加剪輯前必須先安裝合適的播放

器。如果您想在 PDF中嵌入MOV檔，請安裝 QuickTime。 

增加視訊或音訊 

1. 選擇 [編輯] > [插入] > [視訊&音訊] ； 

2. 按一下滑鼠並在文件的目標位置拖畫出一個區域。如果媒體為視訊，播放區的大小為視

訊框架的實際大小； 

3. 在彈出的 [增加視訊&音訊] 對話方塊中將會看到如下選項： 
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 嵌入內容到文件：此選項為預設選項。它將會增加 PDF 檔案的體積。但是，如果取消

對其的勾選，當您在其他電腦上開啟文件時，程式將不能播放多媒體。 

 海報設定：選擇在不播放視訊時是否顯示圖像。您可以選擇不使用海報或從檔案建立海

報。 

編輯播放區 

移動、調整、對齊、居中、分佈多媒體剪輯，請參照“圖像”。 

設定視訊和音訊屬性 

使用 Foxit PhantomPDF軟體，您可以為您增加的多媒體檔設定相關屬性，如：可以指定視訊

的播放區外觀、視訊是否一次或連續播放等。 

設定視訊和音訊屬性，請執行以下操作： 

1. 選擇視訊和音訊工具 或選擇標注工具 ； 

2. 滑鼠雙擊播放區或滑鼠右擊並選擇屬性； 

3. 外觀標籤的設定，請參閱“設定圖像屬性”。 

注：如果您選擇鎖定標籤，則多媒體檔的所有選項均被鎖定。 

4. 在設定標籤中，有下列選項： 

  

 註解標題：輸入視訊或音訊的名稱。此標題無法決定播放哪個文件。 
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 替換文字：在“備用文字”對話方塊中輸入對多媒體檔的描述。 

 節目：允許您建立備用的或其他節目確保使用者可以在他們的系統中播放視訊或音

訊。 

A. 節目事件回應列表：您可以設定節目在頁面中對不同的動作的不同反應。放開滑鼠為

預設選項，意思是當滑鼠點擊並放開時，節目開始播放。 

B. [增加] 節目：程式提供三種方法增加節目，分別為使用檔案、使用 URL以及複製已存

在的節目。 

C. [編輯] 節目：點擊編輯按鈕，編輯節目對話方塊將彈出。您可以在對話方塊中對多媒

體檔進行一系列編輯。 

多媒體設定 – 設定視訊或音訊剪輯的一般屬性： 

  

 節目名稱：輸入節目名稱，名稱將會顯示在節目清單中。 (此標題無法決定播放

哪個文件。) 

 多媒體剪輯位置：通過瀏覽或輸入位址指定剪輯的位置。 

 內容類別型：當您指定剪輯位置後，程式將自動為您選擇類型。改變內容類別

型可能會引起多媒體播放的問題。 

 嵌入內容到文件：此選項為預設選項。它將會增加 PDF 檔的體積。如果取消對

其的勾選，當您在其他電腦上開啟文件時，程式將不能播放多媒體。 

 替換節目文字：輸入對節目的描述資訊。 

 允許暫存檔案：指定是否允許寫入暫存檔案。部分多媒體檔在播放視訊或音訊

剪輯時會寫入暫存檔案。如果您希望阻止使用者在安全文件裡輕易就能複製多

媒體內容，您可以不允許建立暫存檔案。但是，勾選此項會使視訊或音訊在部

分需要使用暫存檔案的播放器中無法播放。 
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重播設定：在此標籤中可以設定怎樣播放剪輯。 

  

 保持播放器開啟：選擇是否希望播放器在播放完剪輯後關閉。 

 內容音量：指定剪輯播放的音量。 

 顯示播放器控制項：選擇是否在播放區的底部顯示控制項以便使用者停止、暫

停或播放多媒體。 

 重複：允許重複播放一段剪輯。 

 播放器列表：點擊增加指定播放器以及需要的設定或不允許播放剪輯。選擇播

放器名稱以及狀態。如果您設定多個播放器狀態為必選，程式將只使用其中一

個播放器播放節目。若您設定播放器狀態為首選，則系統會優先選擇此播放器，

但是其優先程度不超過必選。如果您設定狀態為禁止，則播放器將不能用於播

放節目。 

 增加/編輯/刪除按鈕：允許您增加新的播放器或編輯、刪除選中的播放器。 

重播位置：設定是否在 PDF中播放剪輯時，隱藏播放區 (推薦播放音訊時使用)，是否

全螢幕或在浮動視窗中播放。此選項只有在您選擇浮動視窗時才能使用。 
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 重播位置：選擇播放剪輯的位置。 

 背景色：選擇媒體播放器的背景顏色。 

 顯示標題列：選擇在浮動視窗中播放多媒體時，是否顯示標題列。 

 顯示控制關閉的視窗：選擇是否在浮動視窗的上方顯示關閉按鈕。 

 標題文字：為多媒體增加標題。此標題將會顯示在浮動視窗的標題列上。 

 調整大小：選擇是否允許使用者調整浮動視窗的大小。程式提供三個選項供選

擇。 

 窗口位置：視窗位置跟文件視窗、程式視窗、虛擬桌面或文件顯示器相關聯。 

 寬度/高度：指定浮動視窗的寬度值和高度值。 

 如果視窗在螢幕外：選擇當浮動視窗脫離螢幕時是否播放剪輯或移動視窗到螢

幕上再播放。 

   D. 刪除節目：刪除選中的節目。 

   E. 上移/下移：調整播放清單中的節目順序。如果第一個節目無法播放，程式自動跳至

下一個節目。 

3. 視訊和音訊屬性中的動作標籤 

請參閱“按鈕屬性動作標籤”。 

編輯物件 

當閱讀 PDF 文件時，您常常需要編輯文字、圖片或其他 PDF 文件中的物件。在 Foxit 

PhantomPDF軟體中，提供這些基本編輯功能的是物件工具。 

使用物件編輯工具 
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使用物件編輯工具，您可以增加文字物件，或設定文字的字型、字型大小及顏色，及移動、

調整、刪除、旋轉物件等。請按下列步驟增加文字物件： 

 增加文字物件 

 選擇 [編輯] > [編輯內容] > [文字和段落] 編輯工具 ； 

 點擊 [編輯] > [字型] 您可以設定字型、字型大小和顏色。 

 

 在需要增加文字的位置按一下滑鼠，游標呈現閃爍狀態時即可輸入新的文字。當然，您

也可以貼上或刪除輸入的文字。 

 移動和編輯物件 

選中的對象通常被邊框包圍框起來。當指標移至物件上時，游標旁會出現一個十字。這時，

按一下滑鼠不放並拖動，就可以把物件拖動到指定位置。 

選擇 [編輯] > [編輯內容] > [圖像和物件] 編輯工具 ，並執行下列操作之一： 

1. 選擇一個或多個物件 

 按一下選中一個物件，或按下 Ctrl鍵不放並按一下滑鼠選擇多個物件。 

 用滑鼠拖畫出一個邊框包圍需要選中的物件。 

 滑鼠右擊某個物件並在右鍵功能表中選擇全選，或使用 Ctrl+A鍵即可選中目前頁面

面中的所有物件。 

 取消對物件的選擇，在頁面空白處按一下即可。 

2. 移動對象 

 選中並拖拽對象到指定位置。如需移動物件到其他頁面，請使用剪下和貼上。 

3. 調整或旋轉物件 

 要調整物件，請選中物件，並拖拽邊框周圍的黑色小點即可。按住 shift 鍵並拖動

小點可按比例調整物件大小。 

 要旋轉對象，請將游標移至被選中對象邊框的轉角處，這時，游標會變為弧形的箭

頭，點擊並拖動它旋轉，對象便會以中心為軸心旋轉。或滑鼠右擊物件，選擇旋轉

選定物件，在彈出的對話方塊中輸入想要旋轉的角度，點擊 [確定]。 

4. 旋轉物件，可通過以下三種方式： 
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 選擇“圖片和物件”編輯工具 選中物件，選擇“編輯”功能表 > “排列” > 

“旋轉”，在文字欄位中輸入旋轉角度的值即可。 

 “圖片和物件”編輯工具 模式下右擊物件，選擇“旋轉選定物件”，在文欄位

中輸入旋轉角度的值即可。 

 選擇“圖片和物件”編輯工具 選中物件，請將游標移至被選中對象邊框的轉角

處，這時，游標會變為弧形的箭頭 ，點擊並拖動它旋轉，對象便會以中心為軸

心旋轉。 

注： 

 當您在文字欄位輸入角度值時，正數（如 30、60、90等）表示順時針旋轉，負數

（如-30、-60、-90等）表示逆時針旋轉。 

 按一下選中物件並在游標閃爍處輸入新內容時，若您的系統中已安裝物件所用的字

體，則可以增加、粘貼或替換具有相同字體的文字。 

注：滑鼠單擊選中物件並在游標閃爍處輸入新的內容。如果您的系統中裝有物件所用的字型，

則可以增加、貼上或替代文字。 

5. 刪除對象 

 選中一個或多個物件，使用鍵盤上的刪除鍵或滑鼠右擊物件並在右鍵功能表中選擇

刪除。 

6. 放置圖像 

 滑鼠右擊物件並在右鍵功能表中選擇放置圖像。 

使用“文字和段落”編輯工具 

您可以通過“文字和段落”編輯工具編輯段落文字，而且像微軟辦公軟體Word一樣，可以

設定字型、字型大小和顏色。 

在段落中編輯文字，請執行以下操作： 

 選擇 [編輯] > [編輯內容] > [文字和段落] 編輯工具 ； 

 點擊 [編輯] > [字型] 您可以設定字型、字型大小和顏色； 

 在需要增加文字的位置按一下滑鼠，游標呈現閃爍狀態時即可輸入新的文字。當然，您

也可以貼上或刪除輸入的文字。Foxit PhantomPDF軟體會自動重排文字及格式。您也可

以按 return鍵另起一行。 

設定物件屬性 
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1. 滑鼠右擊圖像、路徑或文字物件並選擇屬性。 

2. 在圖像物件屬性對話方塊中，請執行下列操作： 

  

圖像物件屬性對話方塊 

 點擊填充色標籤並指定填充色和透明度。點擊選擇顏色空間並通過拖拽華動桿調整

顏色。 

注：當物件為圖像時，顏色空間不可用，但可更改透明度。 

3. 在路徑物件屬性對話方塊中，請執行下列操作： 

  

路徑物件屬性 

 點擊填充色標籤指定填充色和透明度。填充色用於描繪路徑的邊框和文字。在顏色
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空間中選擇一種顏色並通過拖拽滑動桿調整顏色。顏色的透明度將決定其明顯與否。

通過拖拽滑動桿調整填充色的透明度。 

4. 在文字物件屬性對話方塊中，請執行下列操作： 

 

字型：改變選中文字的字型。 

字型大小：指定文字的字型大小。 

水平比例尺：通過橫向拉伸或縮小字元來調整字元的寬度。100%的比例即普通寬度。

下列圖像顯示百分比對應的效果： 

 

文字模式：程式提供四種文字模式以供選擇：填充文字、描邊文字、填充並描邊文字、

文字既不填充也不描邊 (不可見)。 

 

1          2          3           4 

    1. 填充文字   2. 描邊文字  3. 填充並描邊文字   4. 文字既不填充也不描邊 
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字元間距：調整選中文字中的字元間距。 

 

字間間距：調整選中文字中的文字間距。 
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第六章 – 頁面管理 

Foxit PhantomPDF軟體的頁面管理功能説明您根據頁碼以及頁面範圍合併多個 PDF文件，或

將單個 PDF 文件拆分成多個單頁或多頁的 PDF 文件，並通過重排頁碼、撰寫大綱等方式管

理 PDF檔案。程式允許拆分、合併、重排 PDF文件頁面。  

插入頁面 

從檔案中插入頁面 

Foxit PhantomPDF軟體允許您將一個 PDF檔案插入到另一個 PDF檔案中： 

開啟需要被插入頁面的檔案作為基礎檔案，選擇“頁面管理”> 「頁」> [插入]  > [從文

件]。 

1. 選擇需要增加至基礎檔案中的檔案或資料夾並點擊開啟 (支持一次性增加多個 PDF、doc、

jpg等格式的檔案)； 

2. 在插入檔案對話方塊中，選擇您所增加到檔案，定義插入檔案的頁面範圍並指定在基礎

文件中插入的位置； 

3. 勾選左下角的顯示預覽，即可在下方的預覽框中預覽基礎檔案和插入檔案，點擊 [確定] 

進行文件合併； 

4. 如需另存合併後的檔案，請選擇“檔案”> [另存新檔]，並為新檔命名及指定儲存路徑。  
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“插入檔案”對話方塊 

從掃描器中插入頁面 

使用掃描器即可將紙質頁面直接插入到 PDF檔案中。 

1. 開啟需要被插入頁面的檔案作為基礎檔案，選擇“頁面管理”> 「頁」 > [插入]  > [從

掃描器]； 

2. 在“自訂掃描”對話方塊中選擇掃描器，選擇掃描器後，設定 [輸入] 及 [文件] 選項並

點擊 [掃描]。 
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“自訂掃描”對話方塊 

具體操作請參照“從掃描器中建立 PDF文件”。 

插入空白頁 

1. 開啟需要被插入頁面的檔案作為基礎檔案，選擇“頁面管理” > 「頁」 > [插入]  > 

[從空白頁面]； 

2. 在“插入空白頁”對話方塊中定義插入空白頁的位置及頁數並點擊 [確定]； 

  

插入空白頁對話方塊 
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3. 如需另存合併後的檔案，請選擇“檔案”> [另存新檔]，並為新檔命名及指定儲存路徑。 

刪除頁面 

您可以插入頁面來合併 PDF檔案，也可以刪除不需要或空白的頁面。  

使用刪除命令刪除頁面 

1. 開啟需要被刪除頁面的檔案； 

2. 選擇“頁面管理” > 「頁」 > [刪除] ； 

  

3. 選擇需要刪除的頁面範圍並點擊 [確定]。  

注：如需保留原文件，請另存刪除頁面後的檔案。 

使用頁面縮圖刪除頁面 

1. 在左邊的導覽列中點擊頁面縮圖按鈕 開啟面板，並選擇需要刪除的頁面：  

 拖動滑鼠選擇頁面。 

 Shift/Ctrl+滑鼠左鍵選擇頁面。 

2. 按下鍵盤上的刪除鍵刪除選中的頁面。或滑鼠右擊選中頁面選擇 [刪除頁面] 再點擊 

[確定]。 

擷取頁面 

擷取是指在文件裡使用另一個文件中的頁面。擷取頁面不僅包括擷取文件所包含的內容，還

包括與原始頁面內容相關的表單欄位資訊、注釋、連結等等。跟我們熟悉的剪下、複製、貼
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上過程相比，擷取過程以頁面為基礎並在原始文件裡保留被擷取的頁面。程式則新建包括已

擷取的頁面在內的 PDF文件。 

注：無法擷取任何跟頁面有關的書籤或系列文章資訊。 

1. 在程式中開啟文件，並選擇“頁面管理” > 「頁」 > [擷取] ；  

2. 在“擷取頁面”對話方塊中，選擇擷取頁面的範圍；  

3. 如需將擷取的頁面另存新檔新的 PDF檔案，請勾選擷取頁面到一個單文件；  

A.僅擷取隔頁，選擇奇數頁或偶數頁 

B. 擷取單一頁面或者一個範圍的頁面，選擇選項“Form”，並在選項“From”“和“To”

中輸入頁碼 

4. 在另存新檔對話方塊中輸入檔案名並點擊 [儲存]，所儲存的檔案不會自動在程式中開

啟； 

5. 如果沒有選擇擷取頁面到一個單文件，那麼，擷取完成後，程式將自動開啟由被擷取的

頁面所組成的 PDF 檔案；程式將不會自動儲存此檔案，請手動進行儲存；如需在擷取

頁面後，將這些頁面從原文件中刪除，請勾選提取後刪除相應頁面； 

6. 擷取頁面組成的 PDF檔案將被自動命名為“匯出頁面自…[原檔案名稱].pdf”。 

注：文件建立者可以進行安全設定，保護文件不被擷取。選擇“檔案”> [文件屬性] > [安全]。 

替換頁面 

您可以使用 PDF頁面替換另外一個 PDF頁面。允許替換文件中的文字、圖像和注釋。 

如需快速更新 PDF文件，您可以替換單個頁面。 

1. 開啟包含需要被替換頁面的檔案； 

2. 選擇“頁面管理” > 「頁」 > [替換] ；  

3. 選擇用於替換的檔並點擊 [開啟]； 
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4. 在彈出的替換頁面對話方塊中選擇原文件中需要被替換的頁面範圍以及替換檔案中用

於替換的頁面的範圍； 

5. 點擊 [確定] 開始替換。 

注：替換後，原文件中的書籤將不可用。 

交換頁面 

在同一個 PDF檔案中，交換不同的頁面。   

1. 開啟需要交換頁面的檔案； 

2. 選擇“頁面管理” > 「頁」 > [交換] ； 

3. 在交換頁面對話方塊中，輸入需要交換的兩個頁面的頁碼； 

4. 點擊 [確定]。 

複製頁面 

1. 開啟需要複製頁面的檔案； 

2. 選擇“頁面管理” > 「頁」 > [複製] ； 

3. 在複製頁面對話方塊中，指定需要複製的頁面範圍及複製後的位置；如需在複製後刪除

原始位置的頁面，可勾選複製後刪除相應頁面；  

4. 點擊 [確定]。 
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移動頁面 

在文件中移動單個或多個頁面 

1. 開啟需要移動頁面的檔案； 

2. 選擇“頁面管理” > 「頁」 > [移動] ； 

3. 在移動頁面對話方塊中，指定需要移動的頁面範圍及移動後的位置； 

4. 點擊 [確定]。 

注：標記書籤會影響閱讀設備閱讀的順序，如提供視覺障礙者使用的設備。標記書籤不會改

變 PDF文件中頁面的順序。  

使用縮圖移動單個或多個頁面 

1. 按一下導覽列上的縮圖標籤並選擇需要移動的頁面； 

2. 在縮圖面板中拖動縮圖至目標位置。 

拆分頁面 

此功能可將一個 PDF文件平均拆分為多個子文件。 

1. 開啟文件； 

2. 用下列一種方法開啟拆分頁面對話方塊： 

 選擇“頁面管理” > 「頁」 > [拆分] 。 

 在頁面縮圖中滑鼠右擊，彈出功能表中選擇 [拆分頁面]。 

3. 在拆分文件對話方塊中輸入拆分後每個文件的頁數和大小，如果文件設有書籤，

是否按階級書籤進行拆分； 

4. 在輸出選項中設定輸出後儲存的位置以及拆分後的檔案名稱； 

5. 點擊 [確定]。 

剪裁頁面 

剪裁頁面功能可以調整可視頁面區域。您可以建立包含不同大小頁面的 PDF文件。 

裁剪單個或多個頁面 

1. 開啟文件； 

2. 在頁面縮圖中右擊，從彈出功能表中選擇“裁剪頁面…”； 
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3. 在“裁剪頁面”對話方塊中，選擇邊距框（有剪裁框、藝術框、修剪框和溢出框，

分別以黑色、紅色、綠色和藍色表示）、設定邊距並調整比例；勾選“顯示所有

邊框”預覽頁面，可看到裁剪後的效果； 

  

   剪裁框 – 定義頁面在顯示和列印時的內容邊界。 

   藝術框 – 定義頁面上有意義的內容，包括空白區域。 

   修剪框 – 定義裁剪後頁面的最終尺寸。 

   溢出框 – 定義頁面在專業列印時的裁切路徑以允許剪裁和折疊頁面。“列印標記”

可以在出血區域之外。 

強制比例 – 鎖定裁剪的比例，且頁面內容的每個邊緣距離紙張邊框的尺寸相同。 

刪除空白邊距 – 將頁面裁剪至成品邊界，該選項對於剪裁那些保存為 PDF 檔的示範

文稿幻燈片的邊緣特別有用。 

設為零邊距 – 恢復所有裁剪邊距為 0。 

重置 – 將邊距恢復至原始尺寸。 

4. 預覽框中的頁面縮圖上顯示的矩形框表示剪裁區域的邊界； 

5. 設定頁面範圍； 

6. 選擇頁面剪裁的數值的單位； 
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7. 點擊“確定”。 

旋轉頁面 

您可以旋轉文件中的頁面，旋轉角度基於 90度增量旋轉。  

1. 開啟文件； 

2. 用下列一種方法開啟旋轉頁面對話方塊： 

 選擇“頁面管理” > 「變換」 > [旋轉頁面]。 

 在頁面縮圖中滑鼠右擊，彈出功能表中選擇 [旋轉頁面]。 

3. 在“旋轉頁面”對話方塊中，選擇方向； 

4. 設定頁面範圍； 

5. 點擊 [確定]。 

注：如果只需要暫時改變視角，選擇“視圖”> 「頁面顯示」 > [旋轉視圖] > [向左/向

右]。下次開啟文件時，程式將自動恢復預設設定。   

扁平化頁面 

此功能使互動性的注釋無效化並將其變為文件物件的一部分。 

1. 開啟目的文件； 

2. 選擇“頁面管理” > 「變換」 > [扁平化]。 

3. 在“扁平化頁面”對話方塊中，設定頁面範圍。點擊 [確定]。 

注：如果您想保留原始檔，請用 [另存新檔…] 命令儲存修改後的檔案。 
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第七章 – 注釋 

注釋是對某個事實或觀念表達個人見解和態度的解釋、說明或陳述。您可以通過在 PDF 中

增加文字資訊或增加一條直線、一個形狀表達對內容的理解。同時，您也可以編輯、回復、

刪除以及移動注釋。 

注釋工具 

通過 Foxit PhantomPDF軟體注釋工具，您可以輕鬆增加 PDF 文件注解。程式提供了不同類

型的注釋工具：文字標注工具、圖釘工具、打字機工具、繪圖工具、測量工具和圖章工具。

您可以在“注釋”功能表上找到這些注釋工具。 

 

文字標注工具 

您可以使用文字標注工具指示哪些文字需要編輯或引起讀者的重視。文字標注不會更改 PDF 

中的真實文字。Foxit PhantomPDF軟體提供的文字標注工具包括文字螢光標示工具、底線工

具、刪除線工具、波浪底線工具、替換文字工具和文字插入工具。 

選擇文字標注工具： 

 選擇“注釋” > 「文字標注」 > 選擇標注工具。然後用滑鼠拖畫需要標注的內容。 

文字標注工具一覽表 

按鈕 工具名稱 描述 

 
螢光標示

工具 

通常用於螢光標示文件中的重要段落或語句，供閱讀者參閱或引起

閱讀者的注意。 
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波浪底線

工具 
在文字下方增加波浪線，類似文字底線工具。 

 底線工具 在文字下方增加底線，為強調或突出作用。 

 
刪除線工

具 
在文字上增加刪除線，指示應刪除該部分文字。 

 
替換文字

工具 

在文字上增加刪除線，增加校對符號(^)提供替換刪除文字的文字資

訊。 

 
插入文字

工具 

在文件中增加校對符號(^)，用於提示某個位置應該增加哪些文字資

訊。 

圖釘工具 

您可以通過圖釘工具向文件增加備註和檔案。在備註注釋中您可以輸入文字資訊，通過檔案

工具您可以在文件中增加檔案作為注釋。 

增加備註 

點擊選擇備註工具 ，在需要增加備註的位置點擊然後在備註框中輸入批註文字。 

 

增加檔案附件注釋 

請執行以下操作： 

 在“注釋”功能表下的「圖釘」標籤中選擇 [文件] 工具 ； 

 將游標置於需要增加附件注釋的地方並點擊所選位置； 

 在 [開啟] 對話方塊中選擇需要增加的檔案，再點擊 [開啟]； 

 檔案附件圖示會出現在您的指定位置。 
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打字機工具 

打字機工具包括打字機工具、注釋框工具和文字方塊工具。 

打字機工具 

通過打字機工具，使用者可以在 PDF 檔中手動輸入文字資訊。您可以使用打字機工具在 PDF

文件的任何地方增加評論，這種評論不以上述提到的注釋的形式出現。 

注：打字機工具能用於表單填寫，請參閱“填寫非互動式表單”。 

 

打字機注釋 

 使用打字機工具增加注釋 

 選擇“注釋” > 「打字機」 > [打字機工具]； 

 將指標移至需要增加文字的位置，按一下滑鼠； 

 如果需要另起一行，請使用 Enter鍵； 

 按一下文字外的任何一處結束文字輸入。 

 編輯打字機注釋 

 選擇“注釋” > 「打字機」 > [打字機工具]； 

 將指標移動至文字欄位中並滑鼠雙擊啟動文字欄位； 

 編輯輸入的文字內容； 

 按一下文字外的任何一處結束編輯。 

技巧：您可以使用鍵盤上的方向鍵移動游標。 

 使用拼寫檢查工具 

在安全設定允許的情況下，您可以使用拼寫檢查工具。由於，該工具的元件已合併進 Foxit 

PhantomPDF軟體中，所以，在您第一次安裝 Foxit PhantomPDF軟體時，不需要安裝此工具。

但是，您必須到 Foxit伺服器上，手動下載更新的組件。您可以到程式的説明功能表下檢查

更新。 

如果您已經安裝了拼寫檢查工具，在使用打字機工具輸入任何英文文字時，該工具將會嘗試

找出拼寫錯誤並使用波浪線螢光標示該處。 

 滑鼠右擊拼寫錯誤的單字，您可以看見推薦單字的列表； 

 選擇其中一個單字糾正錯誤或直接忽略。 
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 移動打字機注釋 

選擇下列操作之一： 

 選擇“注釋” > 「打字機」 > [打字機工具]，然後把游標置於打字機注釋上方，此時

游標變成 狀，按住滑鼠拖動注釋到目標位置。  

技巧： 

 您可以使用鍵盤上的起始、結束或方向鍵來移動文字中的游標。 

 當移動注釋時，注釋周圍會出現矩形框。 

 選擇手型工具 或選擇標注工具 按一下文字域並將注釋拖動到目標位置。 

 刪除打字機注釋 

 選擇“注釋” > 「打字機」 > [打字機工具]，將游標置於注釋文字的起始處或結尾處，

拖動游標選擇所有的注釋文字，然後按下刪除鍵。 

 (推薦使用) 按一下選擇標注工具或手形工具，按右鍵文字區，然後選擇刪除。 

 設定打字機參數 

請使用格式工具列設定打字機參數。請選擇“編輯” > 「字型」 > 選擇各種格式工具。  

 

格式工具 

在注釋框或文字方塊中增加注釋 

注釋框工具和文字方塊工具可以讓使用者在注釋框或文字方塊中建立注釋。 

注釋框用於指出文件中的某一區域。  
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文字方塊允許使用者輸入文字資訊。文字方塊常常在文件頁面中被設定為可見。它也不像彈

出型備註那樣可以關閉。 

 

注：如果增加的注釋為日語、中文或韓語，您需要先安裝東亞語言元件。注釋框及文字方塊

注釋只能橫向輸入。 

 增加注釋框或文字方塊 

 選擇“注釋” > 「打字機」 > [注釋框/文字方塊]； 

 按一下需要增加注釋框或文字方塊的位置； 

 輸入文字內容。當文字輸入到末尾時將自動換行。 

 調整、移動、編輯或刪除注釋框或文字方塊 

選擇手形工具 、選擇標注工具 或相應的圖形標注工具，然後執行以下任一操作： 

 要調整注釋框或文字方塊大小，請選中標注並拖動其中一個手柄，調整至您滿意的大

小。 

 要移動注釋框或文字方塊，請選中它，拖動至目標位置。 

 要編輯注釋框或文字方塊，請滑鼠雙擊標注，然後編輯文字。 

 要刪除注釋框或文字方塊，請選中它並按刪除鍵，或滑鼠右擊注釋框或文字方塊並在

下拉式功能表中選擇刪除。 

 設定注釋框或文字方塊參數 

請參閱“設定打字機參數”。 

繪圖工具 

您可以通過繪圖工具在 PDF 文件中繪製箭頭、線條、正方形、矩形、圓形、橢圓、多邊形、

折線、雲形，等等。通過它們您可以對文字或圖形做一些標記。  
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繪圖工具一覽表 

按鈕 工具名稱 描述 

 矩形工具 用於繪製由四個直角和四條邊組成的平面圖形。 

 橢圓工具 用於繪製橢圓圖案或同時按住 Shift鍵可繪製出圓形。 

 多邊形工具 用於繪製由三條或更多的線段圍成的一個封閉的平面圖形。 

 雲形工具 用於繪製雲狀圖案。 

 箭頭工具 用於標注箭頭形符號，用於指示方向。 

 線條工具 用於繪製線條。 

 折線工具 用於繪製由三條或更多的線段圍成的一個開放的平面圖形。 

 鉛筆工具 用於繪製任意的形狀。 

 橡皮工具 用於擦除鉛筆工具所繪製的所有形狀。 

注意：如果您順時針使用雲形圖案，效果如下 ；如果逆時針使用，效果則是 。 

技巧： 

 要繪製水平或垂直或 45 度的線，請在拖畫時按住 Shift 鍵。 

 要通過矩形工具繪製正方形，或通過橢圓工具繪製圓形，請在拖畫時按住 Shift 鍵。 

編輯、調整或移動圖形標注 

 選擇手形工具 、選擇標注工具 或相應的圖形標注工具； 

 要編輯或調整標注大小，請選中標注並拖動其中一個手柄，將標注調整至您滿意的大

小。 

 要移動標注，請選中標注，拖動至目標位置。 

 要增加彈出式注釋框，請選中標注，然後滑鼠雙擊該標注，或者可以滑鼠右擊標注然後

選擇開啟注釋彈出框。 

 如果您作了線條或箭頭標注，您還可以通過勾選標注屬性的 “線條上顯示文字”選項，

將注釋框中的內容顯示在線條上。 
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刪除圖形標注 

要刪除標注，請選中它並按刪除鍵，或滑鼠右擊標注或文字方塊並在下拉式功能表中選擇刪

除。 

圖形標注群組 

通過群組圖形標注您可以將它們組合在一起並作為一個單一的注釋。您可以移動或刪除標記

組合、設定狀態和更改外觀等。 

選擇手形工具 或者選擇標注工具 ，執行以下任一操作： 

 要群組注釋或取消群組：按住 Ctrl 鍵，選擇您想要群組的所有標記，然後滑鼠滑鼠

右擊任一選中的標記，選擇“群組”或“取消群組”。  

 編輯群組：選擇任意一個選中的標記，可以像編輯單個標記一樣編輯標記群組。 

測量工具 

請參閱“使用測量工具”。 

圖章 

圖章工具是 Foxit PhantomPDF電子文件軟體中的進階工具，幫助您為您的 PDF文件內容增加

圖章或浮水印。支援多種格式的圖像 (JPEG, GIF, BMP, WMF等) 作為圖像圖章及 PDF文件圖

章。您建立的圖章可從系統中獲取姓名、日期、時間，也可以直接導入已有的圖章。本章將

具體介紹如何用圖章工具增加圖章以及如何建立自己的圖章。特別是當您需要告知讀者文件

的狀態或敏感度時，圖章工具能達到這個目的。  
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增加圖章 

在為 PDF 增加圖章之前，可以從系統自帶圖章中選擇，或建立自訂圖章。您所導入或建立

的圖章會在圖章工具的功能表及圖章面板中顯示。應用圖章工具，請按下列步驟操作： 

1. 選擇“注釋”> 「圖章」 > [圖章] 工具，或選擇“注釋”> 「圖章」 > [建立] > [顯示

圖章面板]； 

2. 在圖章面板中，選擇圖章種類，從中選擇一個圖章； 

3. 在需要增加圖章的頁面按一下。 

注：所有導入的或是建立的圖章都會在圖章工具的功能表中顯示，您只需直接從中選擇即

可。 

建立圖章 

您可以自訂建立圖章和動態圖章。 

 建立自訂圖章 

1. 選擇“注釋” > 「圖章」 > [建立] > [建立自訂圖章]； 

2. 在“建立自訂圖章”對話方塊中，點擊 [瀏覽]，選擇一個影像檔或是 PDF 檔。如果選

擇的檔包含多個頁面，可以拖動捲軸選擇需要的頁面。 

3. 定義一個新的類別，或從下拉式功能表中選擇已有種類，為自訂圖章命名，點擊 [確

定]。  

標準圖章 

創建自訂動態圖章                       

創建自訂圖章 

動態圖章 
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注：如果所選圖章為影像檔，您可以通過拖動滑動桿調整它的透明度。 

  

“建立自訂圖章”對話方塊 

您也可以從剪貼簿中建立圖章，按以下操作： 

 將圖形複製到剪貼簿； 

 選擇“注釋”> 「圖章」 > [建立] > [將剪貼簿圖像貼上為圖章]，這時游標變成矩形框

狀； 

 將游標置於目標位置並點擊即可。  

 建立自訂動態圖章 

您可以選擇導入動態圖章或建立包含姓名、日期、時間及其他文字內容的動態圖章。 

1. 選擇“注釋”> 「圖章」 > [建立] > [建立動態圖章]； 

2. 從對話方塊左邊的圖章範本中選擇一個作為範本或自己建立圖像或 PDF 格式範本，定

義圖章類別並為圖章命名； 

3. 設定字型和顏色； 

4. 如果直接在圖章文字下拉清單中選擇一項，在應用圖章後，程式將以系統目前使用者名、

日期和時間作為文字內容； 

5. 建立的圖章可在對話方塊的右上方看到預覽圖； 

6. 設定完成後，點擊 [確定] 建立圖章。 
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“建立自訂動態圖章”對話方塊 

管理圖章 

 選擇“注釋” > 「圖章」 > [建立] > [圖章管理] 開啟“管理自訂圖章”對話方塊，選

擇圖章； 

 點擊 [建立]，您可以從下拉式功能表中選擇所要建立的圖章種類。請參閱建立圖章。 

 點擊 [編輯]，改變圖章類別、名稱，用檔或圖像替換已有圖章等。請參閱建立自訂動

態圖章。 

 點擊 [刪除]，移除圖章。 

  

“管理自訂圖章”對話方塊 
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注：刪除一個自訂圖章種類將會刪除這個種類下的所有圖章。 

 剪下/複製和貼上圖章 

 選中需要剪下或複製的圖章； 

 滑鼠右擊圖章 > [剪下/複製]，或使用快速鍵 Ctrl+X/C來剪下/複製； 

 滑鼠右擊需要貼上圖章的頁面並選擇貼上，或選擇使用快速鍵 Ctrl+V來貼上。 

 復原/重複圖章 

點擊快速訪問工具列上的復原工具 和重複工具 。 

 調整/移動圖章 

 選擇手形工具 或注釋工具 ； 

 點擊圖章，將游標移到紅色小點上，拖動滑鼠，根據需要調整圖章； 

 點擊圖章，將游標放在圖章上，拖動滑鼠，移動圖章； 

 選中圖章並滑鼠雙擊，或滑鼠右擊圖章並選擇開啟彈出注釋，為其增加彈出注釋。 

 刪除圖章 

選擇下列操作之一： 

 選擇手形工具 或注釋工具 選中圖章並使用鍵盤上的刪除鍵。 

 選擇手形工具 或注釋工具 選中圖章並在右鍵功能表中選擇刪除。 

設定最愛圖章 

 選擇“注釋”> 「圖章」 > [建立] > [設定常用圖章]； 

 在所有圖章面板中選擇一個圖章並增加到常用圖章列表中； 

 從常用圖章列表中移除圖章，則點擊 [移除] 選項。 
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設定常用圖章 

更改注釋外觀 

建立注釋後您可以更改注釋的顏色及外觀等，您也可以將新建的外觀設為預設。 

更改備註的外觀 

1. 在建立備註之後，請按右鍵備註圖示，然後選擇屬性，或者從備註快顯視窗右上角選項

功能表裡選擇屬性； 

  

2. 在備註屬性對話方塊中，執行下列操作後點擊關閉： 

 按一下“外觀”標籤更改注釋的顏色和透明度。 

 按一下“備註類型”標籤更改注釋圖示類型。 

 按一下“一般”標籤更改作者姓名及注釋主題。 

 按一下“審閱歷史”標籤查閱所有對注釋狀態的修改。 
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請參閱“設定狀態”。 

 勾選鎖定鍵將阻止注釋被更改或刪除。 

更改文字標注外觀 

 請參閱“更改備註外觀”。 

 在此對話方塊中沒有備註類型標籤。 

更改圖形標注外觀 

 

在屬性對話方塊中，執行下列操作後點擊關閉： 

 在“外觀”標籤中設定圖形的線寬、線型、顏色、填充色和透明度。 

 按一下“一般”標籤更改作者姓名及注釋主題。 

 按一下“審閱歷史”標籤查閱所有對注釋狀態的修改。 

請參閱“設定狀態”。 

 勾選鎖定鍵將阻止注釋被更改或刪除。 

更改打字機注釋外觀 

  



Foxit PhantomPDF Business for HP 

用戶手冊 

101 

在屬性對話方塊中，執行下列操作後點擊關閉： 

 按一下“外觀”標籤更改透明度。 

 按一下“一般”標籤更改作者姓名及注釋主題。 

 按一下“審閱歷史” 標籤查閱所有對注釋狀態的修改。 

請參閱“設定狀態”。 

 勾選鎖定鍵將阻止注釋被更改或刪除。 

更改注釋框或文字方塊外觀 

請參閱“更改圖形標注外觀”。 

設定工具的預設外觀 

 選擇手形工具、選擇標注工具，或者相應的注釋工具，按右鍵注釋然後選擇設定目前屬

性為預設。 

 這種類型的注釋將全部用您設定的屬性預設值。 

管理注釋 

查閱注釋 

注釋面板顯示所有 PDF 中的注釋方便您的查尋。同時，面板的工具列上有多個基本功能選

項，如：全部展開、全部折疊、上一個、下一個、排序以及顯示/隱藏注釋。 

 注釋評論通常顯示在彈出式備註或標注圖示中，當彈出式備註處於關閉狀態時，這些注

釋就充當為提示工具。  

 如果您增加了較多的注釋評論，當滑鼠不在彈出式備註框內時，將只顯示部分注釋評論，

其餘部分可以點擊備註框並拖動捲軸進行查閱。 

 注釋面板上可顯示 PDF 文件中所有注釋，瀏覽注釋時選擇一個注釋，系統將自動顯示

當前注釋並進入注釋所在頁面。 

開啟注釋面板： 

 點擊導覽面板中的注釋按鈕 ； 

 導覽列提供以下功能： 
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 展開全部 ：展開每個注釋。 

 全部折疊 ：折疊所有注釋。 

 上一個 /下一個 ：瀏覽注釋。如果沒有選中任何注釋，這兩個按鈕均不可用。  

 排序 ：您可以按照作者、頁面、類型、日期對注釋排序。含有一系列回覆的注

釋只按第一條資訊排序，在同一類別中回覆資訊均按第一條資訊排序。 

 顯示/隱藏注釋 ：顯示或隱藏頁面上的注釋。 

注： 

1. 您可以通過點擊注釋旁邊的加減號展開或折疊注釋。 

2. 注釋所在的頁面與所選的注釋是同步的。在面板中點擊注釋便能跳至該注釋所在的頁

面。 

剪下、複製和貼上注釋 

剪下注釋 

 選擇要剪下的注釋，使用 Ctrl+滑鼠按一下選擇多個注釋； 

 從右鍵功能表中選擇 [剪下]，或使用快速鍵 Ctrl+X； 

複製注釋 

 選擇要複製的注釋，使用 Ctrl+滑鼠按一下選擇多個注釋； 

 從右鍵功能表中選擇 [複製]，或使用快速鍵 Ctrl+C； 

貼上注釋 

 複製或剪下注釋； 

 將滑鼠移至目前文件或其他文件中需要貼上注釋的位置； 

 從右鍵功能表中選擇 [貼上]，或使用快速鍵 Ctrl+V。 

復原和重複注釋 

請參閱“復原與重複”。 
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設定和更改狀態 

設定狀態 

設定狀態可以追蹤您瀏覽過的或需要進一步操作的注釋。您可以使用狀態接受、拒絕、取消

或完成對文件的注釋。通過設定審閱狀態，您可以顯示或隱藏某些注釋並讓審閱人知道您對

注釋做了哪些處理。一旦設定了審閱狀態，即使您將狀態改為無，您也不能在審閱歷史中移

除審閱狀態。通過設定移植狀態，您可以確認某些注釋是否被匯出到其他文件並讓審閱人知

道該結果。一旦設定了移植狀態，即使您將狀態設為無，您也不能在審閱歷史中移除移植狀

態。 

更改注釋狀態 

 使用手形工具、選擇標注工具或相應的注釋工具滑鼠右擊注釋，然後選擇“設定狀態” 

> 選擇一個選項； 

 查閱標注改變歷史： 

A. 滑鼠右擊標注並選擇 [屬性]； 

B. 在屬性對話方塊中點擊審閱歷史標籤即可查閱到標注的修改歷史。 

回覆注釋 

通過回覆注釋，參與者可以閱讀其他人的注釋，也可以讓審閱人查閱到自己對注釋的建議和

理解。所有的回覆將出現的注釋的彈出框中並列出原始文件的下方。通過回覆的標題和標記

您可以查閱相應的回覆。 

1. 在彈出注釋框中回覆原始文件，並執行以下任一操作： 

 使用手形工具、選擇標注工具或相應的注釋工具開啟注釋的彈出框並在彈出框的 [選

項…]中選擇 [回覆]。  

 滑鼠右擊被注釋的原始文件並選擇 [回覆]。 

 在彈出框裡出現的文字方塊中輸入回覆的內容。 

2. 回覆其他審閱人的注釋 

 使用手形工具、選擇標注工具或相應的注釋工具開啟注釋的彈出框； 

 滑鼠右擊其他審閱人所做注釋的標題並選擇 [回覆該主題]。 

3. 刪除回覆資訊 

在彈出框中滑鼠右擊文字資訊並選擇 [刪除該回覆]。 

4. 改變回覆資訊視窗的顏色 

在彈出框中滑鼠右擊文字資訊標題並選擇 [修改顏色]。 

5. 標記注釋 

您可以滑鼠右擊某注釋，選擇勾選給注釋增加標記，開啟導覽面板的注釋窗格，該注釋
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會出現勾選標記 。或您可以直接在注釋窗格中勾選注釋。通過標記您可以對注釋進

行排序等。 

6. 更改作者名稱 

滑鼠右擊注釋，選擇 [修改使用者名]。 

排列注釋 

選擇多個注釋 

1. 選擇 [選擇標注工具] ； 

2. 按住 Shift鍵或 Ctrl鍵，點擊需要編輯的注釋。 

對齊注釋 

請選擇您要對齊的兩張或多張圖片，然後執行以下任一操作： 

 選擇“注釋”>「繪圖」> [排列] > [對齊]，然後選擇一個命令進行操作： 

A. 縱向排列注釋，選擇左 、右 和縱軸線 按鈕分別向參照注釋的左邊緣、

右邊緣和縱軸中心對齊。  

B. 橫向排列注釋，選擇上 、下 和橫軸線 按鈕分別向參照注釋的頂邊、底

邊和橫軸中心對齊。 

注：當您按右鍵或按 Ctrl鍵並按一下選定的注釋時，它將以紅色螢光標示，表明它是參照注

釋。 [對齊] 功能表命令將移動其它選定注釋使其向參照注釋的邊緣對齊。 

 具體請參閱“對齊圖片”。 

居中注釋 

這個功能可以讓您將注釋垂直或水準地居中, 您可以選擇兩項或者兩項以上您將要居中的

注釋。然後執行下列操作之一： 

選擇注釋 > 繪圖 > 整理 > 頁面中心，然後選擇，或者垂直、平居中。 

分佈注釋 

對於注釋在單張頁面上的編排，基於相鄰注釋的中心，您可以給予它們均勻的間距。這個功
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能允許選擇三個或三個以上的注釋。 

要發佈注釋，選擇注釋 > 繪圖 > 整理 > 發佈，而後執行選擇將其垂直或水平分佈。具體

請參閱“分佈圖像”。 

小結注釋 

小結注釋可以幫助您整理與PDF文件相關的所有注釋。您可以建立一個關於注釋小結的新

PDF文件。 

建立注釋摘要文件，請執行以下操作： 

1. 選擇“注釋”>「管理注釋」> [小結注釋]； 

2. 在“建立小結注釋”對話方塊中，請執行下列操作： 

 

A. 您可以從五種小結注釋的頁面配置選項中選擇一種： 

 L1—多頁面上包含連接線的文件和注釋  

 L2—單獨頁面上包含連接線條的文件和注釋 

 L3—僅包含注釋 

 L4—多頁面上包含順序編號的文件和注釋 

 L5-- 單獨頁面上包含順序編號的文件和注釋 
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L1                                                 L2 

                

L3                                               L4 

 

L5 

B. 注釋類型 – 選擇您要總結的注釋類型。 

C. 頁面大小 – 選擇注釋摘要的紙張大小。 

D. 字型大小- 選擇注釋摘要的字型大小。 

E. 注釋排序 – 選擇注釋的排序方式。 

F. 頁面範圍 – 選擇需要整理注釋的頁面範圍。 

3. 點擊建立自動生成一個檔案名為“[原檔案名稱].pdf的標注概要”的PDF文件。您可以在

儲存該文件前重新命名該文件。 
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發送經過注釋的 PDF文件 

Foxit PhantomPDF軟體幫助您輕鬆共用文件及其審閱過程。您可以將經過注釋的PDF文件發送

給任何審閱人以便他們確認並回覆您的注釋。  

發送經過注釋的文件，請按下列操作執行： 

 點擊儲存按鈕 儲存所有注釋； 

 選擇“分享”>「發送到」> [電子郵件] 將其發送。  

導入&匯出注釋資料 

此功能為 PDF 審閱工作帶來極大的方便。當您接受到一封審閱 PDF 文件的邀請郵件時，該

郵件中的 PDF文件通常為一個附件或郵件提供一個 PDF文件所在的 URL。或者，您可能收到

一封表單資料格式（FDF）的附件。FDF 檔案在開啟時，會配置您的審閱設定並在網路瀏覽

器中開啟 PDF。此時，您需要知道怎樣從 FDF檔中導入注釋。同樣地，您可能需要將資料匯

出文件並將其作為 FDF檔發送給其他參與者。 

導入注釋資料 

 滑鼠雙擊 FDF文件，用 Foxit PhantomPDF軟體將其開啟； 

 選擇“注釋”>「管理注釋」> [導入]  > 選擇目的檔案 (如果需要導入多個注釋檔，

您可以按住 Ctrl或 Shift鍵並逐個點擊選擇) 並開啟，您將會得到注釋資料已被成功導

入的提示資訊。 

匯出注釋資料 

 匯出為 FDF文件 

A. 選擇“注釋”>「管理注釋」> [匯出] ； 

B. 在彈出的對話方塊中輸入檔案名並指定檔儲存位置，點擊 [儲存]； 

C. 匯出成功後，將得到提示資訊。 

 匯出並作為電子郵件發送 

A. 選擇“注釋”>「管理注釋」> [郵件發送 FDF] ； 

B. 您預設的郵件程式自動彈出且匯出的注釋將作為郵件的FDF格式附件； 

C. 輸入郵寄地址和標題並點擊發送； 

D. FDF格式的注釋將被單獨發送。 

注：只有當PDF文件中存在注釋時，匯出選項可用。 
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技巧：使用者可以從txt以及dbf檔中導入注釋資料，或將PDF中的注釋資料匯出並儲存為FDF

格式檔。您也可以從FDF檔匯出注釋資料並將其作為郵件附件發送。 
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第八章 – 表單 

您可以使用 Foxit PhantomPDF軟體填寫和建立表單。本章詳細介紹了互動式、非互動式表單

的填寫方法。 

互動式表單和非互動式表單 

PDF表單可分為兩種：第一種是包含互動式表單欄位的PDF檔案，填寫這種表單無需使用其

它工具，您只要直接點擊表單欄位然後進行填寫即可，這種表單即為“互動式PDF表單”。

第二種表單是普通的帶有空白橫線和文字方塊的PDF檔，填寫這種表單您必須使用Foxit 

Phantom中的打字機工具，這種表單被稱作“非互動式PDF表單”。 

互動式表單 

開啟一個互動式表單時，您可以在程式的工具列和文字欄位之間看到一個文件消息列。如果

您不希望在再次開啟該文件時再度看到該消息列，請選擇“檔案”> [偏好設定] > [表單] > 

勾選 [總是隱藏文件消息列]。要顯示文件消息列，請重複以上步驟。 

 

文件消息列的左邊通常會提示該PDF表單包含互動式表單欄位，其右邊有兩個按鈕。第一個

是“螢光標示欄位”選項，其將所有要填寫的空白欄位的背景著色，並框出所有必須的空白

欄位，使表單欄位能夠顯而易見。根據您的需要可以選擇或取消選擇該選項。另外一個按鈕

為關閉按鈕。 

Acro表單和 XFA (XML Forms Architecture)表單 

Foxit PhantomPDF軟體支持Acro表單和XFA (XML Forms Architecture) 表單。您可以使用手形工

具 填寫表單，其操作與填寫普通表單 (也稱Acro表單) 一致。  

非互動式表單 

非互動式表單中不會彈出文件消息列。這種表單檔與其它普通的PDF檔一樣，沒有任何互動

式表單欄位可以填寫。您只能通過Foxit PhantomPDF軟體的打字機工具來填寫這種表單檔。 

填寫 PDF表單 

Foxit PhantomPDF軟體不僅能夠填寫 PDF表單並將其列印出來，還新增了許多進階功能。例
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如：儲存填寫的表單、導入/匯出資料等。 

填寫互動式表單 

如果 PDF表單包含互動式表單欄位，您則可以使用手形工具 直接填寫表單。當您將游標

放在互動式表單欄位上時，指標圖示將更改為以下圖示中的一個： 

 手形  -- 當滑鼠處於按鈕、單選框按鈕、核取方塊按鈕或清單中的項上時顯示。 

 I型游標圖示  -- 當您在表單欄位中鍵入文字時顯示。 

要填寫互動式表單，請執行下列操作： 

 如有必要，請選擇手形工具 ； 

 (可選) 要使表單欄位容易識別，請按一下文件消息列上的“螢光標示欄位”選項。表

單欄位顯示為彩色背景（預設顏色為灰色）； 

 選擇“表單”>「表單識別」> [執行表單自動識別]，然後請在您要填寫的第一個表單欄

位中按一下，選擇該選項或在欄位中放置“I型游標”指針 並開始鍵入文字資訊； 

 您也可以按右鍵文字欄位，然後選擇 [貼上] 或 [全選] 進行其它操作； 

 當您選擇選項或輸入文字後，請執行以下任一操作： 

A. 請按 Tab鍵或 Shift + Tab鍵來接受表單欄位的更改並跳至下一個或上一個欄位。 

B. 請按“上”方向鍵來選擇一組單選鈕中的上一個單選鈕，或按“下”方向鍵來選擇

下一個單選鈕。 

 您填寫完表單欄位後，請執行以下任一操作： 

A. 如果有提交表單按鈕，請按一下。按一下此按鈕可將表單資料發送到網路上的資

料庫或公司內部網的資料庫。 

B. 按一下工具列中的儲存按鈕 ，或者選擇“檔案”> [儲存]。 

C. 選擇“檔案”> [另存新檔…] 並指定儲存路徑來儲存副本。 

注：只有當表單的原作者授權您儲存副本時，儲存的副本才包含您填入的資料，否則，即為

空。 

清除一個表單欄位內容 

請按一下您想要清除表單欄位，按下倒退鍵或刪除鍵進行清除。 

清除未儲存的所有表單項 
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選擇“表單” >「表單資料」> [重設表單] 。 

清除瀏覽器中的表單 

請執行以下任一操作： 

 如果有重設表單按鈕，請直接按一下。本動作無法復原。 

 退出瀏覽器，然後重新執行。 

注：按一下網路瀏覽器的 [重新下載] 或 [刷新] 按鈕，[後退] 或 [返回] 按鈕，或按照連結

跳至其它頁面可能不會完全清除表單。 

填寫表單中較長的項 

某些 PDF表單可以包含動態文字欄位，它能根據文字欄位的大小自動改變輸入的文字大小，

也就是說如果您鍵入的文字超過該文字欄位的大小時，您輸入的文字則會逐步變小。當您完

成輸入且未選中該文字欄位時，鍵入的文字縮小顯示，當您重新選中該文字欄位時，輸入的

文字則會以正常大小顯示。 

拼寫檢查表單項 

購買 Foxit PhantomPDF軟體後，您即可使用拼寫檢查工具來檢查您輸入的表單內容。如果您

已安裝英文拼寫檢查工具，那麼當您在填寫英文表單時，這個工具可以幫助您檢查英文拼寫

並把錯誤單字用波浪線螢光標示。 

要進行英文拼寫檢查，請執行以下操作： 

 請按右鍵拼寫錯誤的單字，您會看到一份建議替換的單字表。 

 從替換列表中選擇正確的單字，或者忽略拼寫錯誤。 

 如果替換列表中沒有您想要的正確單字，那麼您可以自己糾正單字的拼寫。 

填寫非互動式表單 

如果一個PDF表單中不包含任何互動式表單欄位，您則需要使用打字機工具 來填寫表單。

當您將游標置於非互動式表單欄位內時，指標圖示不變。 

您可以列印出非互動式表單然後手動進行填寫。您也可以選擇“注釋” >「打字機」> [打字

機] 工具 來填寫非互動式表單，然後進行儲存、列印或者複製。 

要使用打字機工具填寫非互動式表單並且對您的填寫進行拼寫檢查，請參閱“打字機工

具”。 
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增加表單注釋 

您可以在 PDF 表單中增加注釋，其操作過程與普通的 PDF 檔案一樣。請注意，只有在您獲

得表單作者的同意下，才可以對其增加注釋。 

這些表單注釋是否能和表單一起提交上去，這取決於表單提交的方式。例如，如果您使用

Foxit PhantomPDF軟體列印該表單，並以郵件或傳真的方式發出，則不會出現您增加的注釋。

但是，如果您選擇將已填寫的表單作為一個完整的 PDF 檔案附件，並以電子郵件的形式發

出，那麼對方則可以看到您增加的所有注釋。同時，您也可以將這些注釋作為電子郵件的附

件單獨發送。 

請參閱“第七章 – 注釋”。 

導入&匯出表單數據 

導入匯出表單資料與導入匯出注釋資料操作類似。但是，此功能僅適用於 PDF互動式表單。

當您開啟其他普通 PDF檔或非互動式表單時，所有導入匯出表單資料的選項按鈕均不可用。  

具體操作請參閱“導入&匯出注釋資料”。 

技巧：Foxit PhantomPDF軟體的使用者可以從txt、xml、CSV、dbf或Excel格式的檔中導入表單

資料或經PDF中的表單資料匯出並儲存在FDF格式檔中或另存新檔txt、xml、CSV、dbf或Excel

格式檔。 

表單欄位 

Foxit PhantomPDF軟體中通過一組工具建立及設計互動式表單中的表單欄位。您可以增加核

取方塊、下拉式列示方塊、清單方塊、文字欄位等按鈕進行互動式表單的建立及屬性的確認。 

建立互動式表單 

您可以在空白頁面上建立一個新的互動式表單，還能將其增加到已存在的電子表單中。 

請按下列步驟，在空白頁面中建立表單： 

 建立空白頁面，請選擇“檔案”> [建立] > [空白頁]； 

 開啟空白頁面，並在“表單” >「表單欄位」> 選擇一種工具增加各種表單欄位。 

從表單增加表單欄 > 表單欄位 > 按一下標單欄位類型按鈕。游標將變成十字型，設計器助

手將會自動選取。 
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根據您選擇的表單欄位類型按鈕，設計器助手會自動識別並用方框對可填寫欄位進行標注。 

如果您想要增加一項表單識別欄位，點擊相應區域即可，或者您可以拖動一個方框來指定相

應的按鈕。 

若想要進一步編輯表單，請透過“按鈕”來參考不同按鈕的屬性。 

基本按鈕 

Foxit PhantomPDF軟體有七種基本工具供您建立互動式表單。具體描述請看以下列表： 

按鈕 工具名稱 描述 

 
按鈕工具 

用於建立動作按鈕，例如：開啟檔案、提交資料至伺服器或重設表單

等。此按鈕也可用文字或圖像自訂。 

 
核取方塊 

提供單項是或否的選項。如果表單中含有多個核取方塊，使用者便可

根據需要進行選擇。 

 
單選框 提供使用者呈現一組選擇，可在此組選擇其中一項。 

 

下拉式列

示方塊 
讓使用者可以從下拉式功能表中任選一項。 

 
清單方塊 提供一系列選項以供選擇。 

 
文字欄位 使用者可鍵入文字，例如姓名、位址、電話號碼等。 

 
簽名區域 建立空白簽名欄為以便文件審閱者在文件中簽名。 
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PDF 表單 

按鈕工具 

 建立新按鈕 

選擇“表單”>「表單欄位」> [按鈕工具] ，這時游標呈 狀，然後執行以下操作： 

 拖動滑鼠，建立大小適中的按鈕； 

 在彈出的按鈕屬性框中輸入按鈕名稱和標籤名稱； 

 您也可以點擊 [所有屬性] 進入更多設定。 
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 移動和調整按鈕 

 使用注釋工具 或按鈕工具 ，按一下按鈕將按鈕移動到新的位置。 

 使用注釋工具 或按鈕工具 ，按一下按鈕，拖動按鈕邊界，調整大小。  

 刪除按鈕 

 使用注釋工具 或按鈕工具 ，按一下想要刪除的按鈕； 

 按刪除鍵，或滑鼠右擊按鈕，選擇 [刪除]。 

 複製多個按鈕 

您可以建立按鈕的副本，複製的按鈕名稱為原按名稱加上編號，也可重複命名。所有按鈕將

會被按順序建立，並使用標準格式。 

 使用注釋工具 或按鈕工具 選中單個或多個需要複製的按鈕 (選擇時，按住 shift或

ctrl鍵)； 

 滑鼠右擊按鈕，選擇 [建立多個副本]； 

 在“建立多個副本欄位”對話方塊中，按下列步驟操作： 

 

“建立多個副本欄位”對話方塊 

A. 設定縱向複製的數量，在文字方塊中選擇數值，或自行輸入，預設值為 2。 

B. 設定橫向複製的數量，在文字方塊中選擇數值，或自行輸入，預設值為 2。 

C. 調整所有按鈕的寬度，在文字方塊中選擇數值，或自行輸入，預設值為 0.11。 

D. 調整所有按鈕的高度，在文字方塊中選擇數值，或自行輸入，預設值為 0.11。 

注：高度和寬度的選擇並不會改變單個按鈕的大小，而是調整全選擇或新建立欄位的整
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體空間大小。 

E. 在對話方塊中選擇上移、下移、左、右調整按鈕位置。 

F. 勾選 [預覽]，查看效果。 

G. 勾選 [同名]，是所有副本都與原按鈕同名。點擊 [確定]。 

注意：所有副本按鈕的功能是獨立的，您可以用不同的程式複製這些按鈕，並在這些按

鈕中建立資訊共用的關係。 

 在多頁中複製按鈕 

 選中需要複製的按鈕； 

 右鍵點擊按鈕，選擇 [複製…]。 

注意：[複製…] 工具在只含一個頁面的 PDF文件中不可用。 

 然後請按下列步驟操作： 

A. 在每個頁面上都複製按鈕，請勾選 [全部]。點擊 [確定]。 

B. 在奇數頁或偶數頁上複製按鈕，請勾選 [奇數頁] 或 [偶數頁]。點擊 [確定]。 

C. 在一定範圍內複製，請設定頁面範圍。點擊 [確定]。 

注意：選擇的範圍不管包不包括原始按鈕所在的頁面，都不會影響複製。若包含該頁面，原

始按鈕不會被再次複製到該頁面；若不包含該頁面，原始按鈕也不會被移除。 

 設定標籤順序 

您可以將建立好的按鈕設定標籤順序，生成的序號將顯示在按鈕的左上角。 

 選擇 [選擇標注] 工具 ，選中您要排序的按鈕，將游標移至其中一個按鈕； 

 滑鼠右擊該按鈕選擇“設定定位停駐點次序”即可。 

 設定按鈕屬性 

在屬性中可設定按鈕的外觀、佈局等。 

屬性對話方塊中，除一般、外觀、選項、動作四個標籤外，每個標籤上還有 [鎖定] 及 [關

閉] 兩個項目： 

 鎖定 – 勾選 [鎖定] 按鈕，阻止以後對所有按鈕的屬性的修改。 

 關閉 – 關閉控制項，應用並儲存按鈕屬性，同時關閉按鈕屬性對話方塊。 

注：在任何標籤內選擇鎖定，將鎖定所有標籤內的選項。 
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1. 一般 

 名稱：為選中的按鈕命名。 

 提示：為不熟悉按鈕使用功能的使用者提供幫助。使用者指標在按鈕上浮動時，便會出

現提示。 

 表單欄位：選定按鈕是否可見或可否列印。此區域提供四個選項：可見、隱藏、可見但

不能列印、隱藏但可列印。 

 方向：旋轉按鈕角度，可轉角度為：90°、180°及 270°。 

 唯讀：阻止使用者點擊按鈕。 

 必填：此項不可選。 

2. 外觀 

 線型：選擇按鈕外框的樣式：實線、虛線、斜面、凹陷及底線。 

                           

實線             虛線             斜面              凹陷            底線 

按鈕不同外觀 

注：如果您沒有為邊框選擇顏色，則無法分辨這些差別。 

 線寬：選擇邊框的寬度：細、中、粗。 

 邊框顏色：為邊框選擇顏色，如只需要邊框框架，可不選顏色。 

 填充色：為按鈕選擇顏色，如不需要顏色，可不選顏色。 

注：填充色中，所有顏色都會將圖像隱藏在按鈕後面。 

 字型大小：設定按鈕標籤上文字的大小。  

 文字顏色：為按鈕標籤中的文字選擇顏色。 

 字型：為標籤中的文字選擇字型。 

 

按鈕 

3. 選項 

設定按鈕選項決定按鈕上的標籤和圖示的出現形式。一個按鈕可以有標籤或圖示，或兩者

字型大小：30 

文本顏色：綠色  

字體：Times New Roman 
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兼具。 

 佈局：設定標籤或圖示顯示的方式。 

                 

A           B          C          D          E           F          G 

A. 只顯示標籤  B.只顯示圖示  C. 圖示居上，標籤居下  D. 標籤居上，圖示居下  E.圖示

居左，標籤居右  F.標籤居左，圖示居右  G. 標籤位於圖示之上 

按鈕佈局 

 進階 

    A. 何時開始縮放： 

    總是：縮放圖示，使之符合畫出的按鈕大小。 

從不：從不縮放圖示，使之以原來的大小顯示。 

圖示太大：在圖示比按鈕大時，縮小圖示至符合大小，或使之以原來的大小顯示。 

圖示太小：在圖示比按鈕小時，放大圖示至符合大小，或使之以原來的大小顯示。 

B. 比例  

按比例：當縮放率被改變時，縮放圖示至符合按鈕的大小。 

不按比例：按圖示本身的比例縮放圖示。 

C. 符合外框：將圖示縮放至與按鈕的外框吻合，不考慮邊框的寬度。 

D. 按鈕——拖動滑動桿，調整標籤在按鈕中的位置。 

 行為：按一下按鈕時，按鈕呈現的形態。 

無：滑鼠點擊和未點擊一樣。 

按下：指定滑鼠的鬆開、按下和移入狀態的外觀。在“狀態”下選擇選項，然後指定標

籤或圖示選項。 

滑鼠鬆開：點擊前按鈕的外觀。 

滑鼠按下：點擊後按鈕的外觀。 
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滑鼠移入：滑鼠在按鈕上方時按鈕的外觀。 

邊框：螢光標示按鈕邊界。 

反色：點擊後，按鈕的亮色和暗色對調。 

 

 

按鈕行為 

 圖示和標籤 

A. 若是“佈局”功能表中的標籤模式，在標籤中輸入文字內容。 

B. 若是“佈局”功能表中的圖示模式，點擊 [選擇圖示] > [瀏覽] > 從目錄中選擇檔案，

滑鼠雙擊檔案名，點擊確定。 (要刪除所選圖示，請點擊 [清空] 按鈕。)  

 點擊關閉，確認此設定。 

4. 動作 

為您的按鈕增加相關動作。例如：跳轉到資料頁檢視、開啟一個網路連結等。 

 選擇觸發方式：為按鈕增加觸發下列方式：滑鼠鬆開、滑鼠按下、滑鼠進入、滑鼠移開、

得到焦點及失去焦點。 

 選擇動作：在下拉式功能表中選擇當使用者觸發按鈕時，按鈕所執行的動作：跳轉到資

料頁檢視、開啟一個網路連結等。 

A. 跳轉到資料頁檢視：不僅可以轉到當前 PDF的頁面，也可轉到其他 PDF文件中。同

時，可以改變目前頁面面的縮放率後再定位。 

點擊增加，選擇下列操作之一： 

a) 在目前文件中設定位置：捲動目前文件至目標頁面，按一下將此處設為目標位置即

可。 

b) 在其他文件中設定位置：在工具列中點擊開啟按鈕，選擇目的文件。開啟文件後，

拖動捲軸至目標位置，點擊將此處設為目標位置即可。 

注：新的 PDF文件必須在目前的程式視窗中開啟，不能用新視窗開啟。 

c) 改變縮放率：捲動目前文件或另一文件至目標位置，改變此位置的縮放率，點擊將

此處設為目標位置即可。  

按下 無 邊框 反色 
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d) 點擊 [取消]，取消操作。 

B. 開啟/執行一個檔案：開啟或執行檔案命令，您可以選擇 [開啟/執行一個檔案] > 點

擊 [增加] > 選擇目的檔案 > 點擊 [確定]。 

C. 開啟一個網路連結：執行開啟網站連結操作，請選擇 [開啟一個網路連結] > 點擊 

[增加] > 輸入目標網頁的 URL位址。 

D. 顯示/隱藏一個表單欄位：點擊 [增加]，選擇需要增加或隱藏的按鈕 > [隱藏]/[顯示] 

> [確定]。 

E. 執行一個功能表項目：點擊 [增加]，選擇一個項目執行，點擊 [確定]。 

F. 提交表單：點擊 [增加] ，選擇匯出格式、提交方式及提交的表單欄位並點擊 [確

定]。 

G. 重設表單：點擊 [增加]，選擇需要重設的表單欄位並 [確定]。 

H. 導入表單數據：點擊 [增加]，選擇需要導入的表單所在的檔案，點擊 [開啟]。 

I. 執行一段 JavaScript：點擊 [增加]，輸入 JavaScript，點擊 [確定] 後關閉。 

 動作：動作框中列出了您所定義的滑鼠觸發方式及按鈕行為。 

 上移及下移：改變觸發方式下的行為執行順序。 

 編輯：開啟設定行為的對話方塊，您也可以滑鼠雙擊行為開啟對話方塊。 

 刪除：刪除所設定的行為。 

 預設設定屬性 

可將目前新設定成功的按鈕屬性設定為以後即將建立的所有按鈕的預設屬性。滑鼠右擊按鈕，

選擇 [設定當前屬性為預設]。 

核取方塊 

核取方塊按鈕允許使用者同時選中多項。如何使用核取方塊，請參閱“按鈕工具”。 

 設定核取方塊屬性 

核取方塊屬性對話方塊中也有一般、外觀、選項和動作四個標籤。 

對於一般、外觀和動作標籤的設定，請參閱設定按鈕屬性。 

選項標籤 

核取方塊樣式 – Foxit PhantomPDF軟體提供六種核取方塊風格： 

           

 A      B      C      D       E      F 
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核取方塊風格 

A. 勾選    B.圓形   C. 交叉   D. 菱形   E. 方形   F. 星形 

匯出值 – 標識核取方塊並區別於其他享有相同名稱值的核取方塊。 

預設選中 – 設定當使用者首次開啟表單時，顯示選定的核取方塊。 

注：如果您想建立多個核取方塊，請確保相關核取方塊的表單欄位名稱和輸出值都不相同。 

單選框 

單選框是一組選項，使用者僅可以從中選擇一項。如何使用單選框，請參閱“按鈕工具”。 

技巧：怎樣觸發單選框 

相關聯的單選框一定擁有相同的表單欄位名稱但是不同的輸出值。這就保證了單選框的觸發

和其正確值將被儲存在資料庫中。   

1. 如果擁有多個相同名字的表單欄位，請使用複製貼上建立多個副本。之後，確定值可用。

您必須改變單選框的值保證所有單選框擁有相同的欄位但是輸出的值不同。  

2. 請注意如果多個單選框名稱相同，則不能使用 [建立多個副本] 命令。如果您使用此命

令，程式將彈出資訊提示。 

 設定單選框屬性 

單選框的行為可以通過設定其屬性來決定，您可以在單選框屬性對話方塊中設定一般、外觀、

選項等屬性。 

單選框的屬性除了一般、外觀、選項和動作這四個按鈕外，還擁有以下兩個控制項： 

 勾選鎖定單選框，阻止之後對所有單選框的屬性修改。 

 關閉控制項，應用並儲存單選框屬性，並關閉單選框屬性對話方塊。 

注：在任何標籤內選擇鎖定，將鎖定所有標籤內的選項。 

1. 一般 

 名稱：為選中的按鈕命名。 

 提示：為不熟悉按鈕使用功能的使用者提供幫助。當使用者指標在按鈕上浮動時，便會

出現提示。 

 表單欄位：選定按鈕是否可見，或可否列印。此區域提供四個選項：可見、隱藏、可見

但不能列印、隱藏但可列印。 

 方向：旋轉按鈕角度，可轉角度為：0°、90°、180°及 270°。 

 唯讀：阻止使用者點擊按鈕。 
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 必填：勾選此項，如果使用者試圖在沒有選擇必須的單選框的情況下提交表單，將會彈

出錯誤的資訊提示。 

2. 外觀 

 線型：選擇單選框的樣式：實線、虛線、斜面、凹陷及底線。 

                                 

實線          虛線            斜面         凹陷         底線 

單選框不同線型 

注：如果您沒有為邊框選擇顏色，則無法分辨這些差別。 

 線寬：擇邊框的寬度：細、中、粗。 

 邊框顏色：為邊框選擇顏色，如只需要邊框框架，選擇沒有顏色。 

 填充色：為單選框按鈕後面的背景選擇顏色，如不需要顏色，選擇沒有顏色。 

注：填充色中，所有顏色都會將圖像隱藏在單選框後面。 

 文字顏色：開啟調色板，為單選框的選項標記選擇顏色。 

  

單選框按鈕 

注：在單選框按鈕屬性的外觀標籤中，文字字型和字型大小不可用。 

3. 動作 

 請參考“按鈕屬性動作標籤”。 

4. 選項 

 按鈕樣式：選擇單選框的形狀，其中包括勾選、圓形、交叉、菱形、方形及星形，其中，

圓形為預設形狀。該屬性不會改變單選框的外形。 

 匯出值：標識單選框並區別於其他享有相同名稱值的單選框。單選框的狀態是“Yes”，

您可以在此文字方塊中輸入其他內容。 

 預設選取 – 設定當使用者首次開啟表單時，顯示選定的核取方塊。 

邊框顏色 

文字顏色 

填充顏色 
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 同時選定同名同值的單選框：使用者只需按一下其中一個單選框，則所有同名及相同匯

出數值的單選框都被選中。 

 關閉確認設定。 

 設定單選框屬性為預設 

如果您想把目前設定的屬性變為所有將來新建立的單選框的預設屬性。請滑鼠右擊目前單選

框，選擇“設定目前屬性為預設”即可。 

下拉式列示方塊 

下拉式功能方塊是常用的 GUI部件，它是下拉式功能表、清單方塊以及單線文字方塊的結合

體，允許使用者直接輸入數值命令或從已存在的命令列表中選擇。 

建立下拉功能方塊，請參考“按鈕工具”。 

 設定下拉式列示方塊屬性 

下拉式功能方塊的行為可以通過設定其屬性來確定，您可以在下拉式功能方塊屬性對話方塊

中設定一般、外觀、選項等屬性。 

1. 一般 

請參閱“單選框屬性一般標籤”。 

2. 外觀 

請參閱“按鈕屬性外觀標籤”。 

3. 動作 

請參閱“按鈕屬性動作標籤”。 

4. 選項  

 選項：輸入希望出現在功能表中的欄位。 

 增加：將目前輸入的命令移至專案列表中。 

 匯出值：輸入當資料被匯出時，顯示欄位的數值。如果未填，一般名稱將會使用匯出數

值。 

 選項清單：顯示將在清單中出現的項目。 

注意：列表中選中的項目為下拉式功能方塊中的預設項，如需改變預設，選中其他項目即可。 

 上移或下移：改變欄位清單中，欄位的順序。如勾選了排序欄位，這兩個控制項不可用。 

 刪除：刪除列表中選中的項目。 



Foxit PhantomPDF Business for HP 

用戶手冊 

124 

 選項排序：按數字及字母排序，數字排序先於字母排序。 

 允許使用者輸入自訂文字：允許使用者輸入與列表中的項目不同的數值。 

 立即提交所選值：使用者一旦選中，立即儲存此數值。如不勾選此項，只有當使用者退

出目前表單，或點擊其他表單時，才儲存數值。 

5. 格式 

幫助格式化表單欄位。 

 無——不接受任何增加的選項。含該屬性的下拉式功能方塊中的文字或下拉清單中輸入

時不要求任何特定格式。 

 數字——自動增加選取格式選項中的數字資料欄位。 

A. 小數位數：設定保留的小數位。 

B. 分隔符號樣式：設定逗號出現的位置。 

C. 貨幣符號：選擇使用的貨幣，如：美元、馬克、英鎊等。 

D. 負數樣式：可選擇負數樣式是使用圓括號還是使用紅色文字，或二者都選。 

 百分比——設定專案中以百分比表示的專案。 

A. 小數位數：設定保留的小數位。 

B. 分隔符號樣式：設定逗號出現的位置。 

 日期——設定日期專案。在目前列表中選擇日期格式，列表包含一個“－”、兩個“－”

和四個“－”的數字，d 表示日，m 表示月而 y 表示年。或點擊自訂，輸入您所需要

的日期格式。 

 時間——設定時間項目。列表中的 H代表 24小時制的小時，h代表 12小時制中的小時，

MM代表分鐘，ss代表秒鐘，tt代表 AM或 PM。或點擊自訂，輸入您所需要的時間格

式。 

 特殊格式——提供下列五種選項： 

A. 郵遞區號：允許輸入含有五位數的郵遞區號。 

B. 郵遞區號+4：允許輸入含有九位數的郵遞區號。 

C. 電話號碼：允許十位數的電話號碼。 

D. 社會保障編碼：允許九位數的 US社會保障編號。 

E. 隨機遮罩：自訂格式類型。可自訂使用者在何處用何種格式輸入文字，在表單中，

如何顯示資料。 

a. A—只允許字母（A—Z，a—z） 

b. X—只允許空格及所有可印刷的文字，包括標準鍵盤上的所有字元及在32–126、 

128–255範圍內的 ANSI字元。  

c. O—字母 O允許包括文字及數位的字元（A—Z，a—z， 0-9）  

d. 9—只允許數位字元（0-9） 

例如：遮罩設定成 AAA--p#999，允許輸入 BDF--p#367；遮罩設定成 OOOOO@XXX

允許輸入 vad12@3Up。 
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   隨機遮罩設定舉例 

 自訂：提供給需要自己編寫格式及按鍵的 JavaScripts使用者。 

A. 自訂格式 Script：顯示您為格式所增加的 Script，點擊 [編輯]，在 JavaScript編輯器

中建立或編輯新的 Script。 

B. 自訂按鍵 Script：顯示您為按鍵所增加的 Script，點擊 [編輯]，在 JavaScript編輯器

中建立或編輯新的 Script。 

6. 驗證 

 不驗證欄位值——關閉驗證。 

 欄位值範圍——設定在下拉式功能方塊中，您可以輸入的數值（數位或百分比）的範圍，

此項僅在選項中含有數字項或百分比項時可選。 

 執行自訂驗證 Script——用您所建立或提供的 JavaScript驗證。點擊 [編輯]，在 JavaScript

編輯器中建立或編輯新的 Script。 

7. 計算 

可以幫助您在已存在的表單項目中進行數學運算並顯示結果。 

 不計算——如果您希望使用者自行操作，選擇此項。 

 數值是以下欄位值——選擇本項後，有更多選項可用： 

A. 選擇運算方法：相加、相乘、取平均值、取最大值、取最小值。 

B. 點擊 [選擇]，選擇或刪除您所需要進行運算的欄位。 
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 簡化欄位標記法——使用欄位名稱、簡單的運算子號及 JavaScript，點擊 [編輯]，在

JavaScript編輯器中建立或編輯新的 Script。 

 自訂計算 Script——顯示您為運算所新增的自訂 Script。點擊 [編輯]，在 JavaScript編輯

器中建立或編輯新的 Script。 

 設定下拉式功能方塊屬性設定為預設 

如果您想把目前設定的屬性變為所有將來新建立的下拉式功能方塊的預設屬性。請滑鼠右擊

目前下拉式功能方塊，選擇 [設定當前屬性為預設] 即可。 

清單方塊和文字欄位 

清單方塊是一個 GUI視窗，允許使用者可以在一個列表裡選擇單項或多項，您也可以設定屬

性為 shift+按一下或 ctrl+按一下，以選擇多項。 

文字欄位為使用者程式介面的普通構成要素，也是程式設計 GUIs 時的相應組件類型。允許

使用者輸入文字，如：姓名、地址、電話號碼等。 

建立清單方塊或文字欄位，請參閱“建立按鈕”。 

 設定清單方塊屬性 

請參閱“設定下拉式功能方塊屬性”。 

 設定文字欄位屬性 

1. 所有文字欄位屬性中，除選項外的標籤，請全部參照“設定下拉式功能方塊屬性”。 

2. 文字欄位屬性的「選項」標籤 

 對齊：在文字欄位中，左對齊、右對齊或居中文字。 

 預設值：定義在文字欄位中顯示的文字。當使用者在文字欄位中直接鍵入文字時，該預

設文字被覆蓋。 

 多行：允許在文字欄位中輸入多行。 

 捲動顯示長文字：捲動顯示超過文字欄位框架的文字。 

 允許 RTF格式：允許使用者提供文字設定資訊，例如加粗或斜體。有利於突出重要資訊。 

 限制：設定允許輸入的最多字元數。 

注意：如果輸入預設值，超出此限制的數值將被自動剪下掉。 

 密碼：使您輸入的文字以*號顯示，此選項只在取消拼寫檢查後有效。 

 用於文件選擇的欄位：允許使用者輸入與表單一起提交的檔案路徑，此選項只在 [滾動

顯示長文字] 是唯一被勾選的欄位時有效。 

 拼寫檢查：檢查輸入文字的拼寫是否有誤。 
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 組合：當使用者輸入的文字超出組合中所設的字元時，文字被與邊框相同風格的線截斷。

此選項只能作為選項中唯一一項被選擇。 

                 

A                                      B 

A. 使用組合屬性               B. 不使用組合屬性 

 設定文字欄位屬性設定為預設 

如果您想把目前設定的屬性變為所有將來新建立的文字欄位的預設屬性。請滑鼠右擊目前文

字欄位，選擇 [設定目前屬性為預設] 即可。 

簽名區域 

簽名欄未用於建立空白數位簽章欄位以便審閱者簽名。您可以將簽名欄為放置在任何需要審

閱者簽名的位置。 

 建立新的簽名區域 

選擇“表單”> 「表單欄位」 > [簽名區域] ，您的游標將變成 狀，然後執行下列操作： 

 用滑鼠在目標位置拖拽出簽名區域的大小； 

 在按鈕下的彈出框中輸入名稱； 

 您也可以點擊 [所有屬性] 進入更多設定，或滑鼠雙擊按鈕開啟簽名屬性對話方塊。 

如何使用簽名區域，請參閱“按鈕工具”。 

設定簽名區域的一般、外觀、動作屬性，請參閱“設定按鈕屬性”。 

簽名區域簽署標籤 

 簽名時不做任何反應為預設選項。 

 標記為唯讀：阻止其他讀者更改簽名區域。 

 所有欄位：阻止對任何欄位的更改。 

 除了這些外的全部欄位：允許更改選擇的欄位。勾選您希望審閱者更改的簽名

區域。 

 只有這些欄位：勾選不希望被更改的欄位。 

 該欄位被簽名時執行此 Script： 
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當使用者簽名時，啟動自訂 Script。點擊 [編輯] 改變或建立新的 JavaScript動作。 

排列表單欄位 

選擇多個表單欄位 

重排表單欄位之前，您必須要選中表單欄位。 

選擇多個表單，請按下列步驟之一操作： 

 選擇標注工具  > shift+按一下或 ctrl+按一下每個表單欄位。 

 選擇標注工具  >拖動選擇框，將所需要的表單欄位包圍在內。 

Ctrl+按一下，取消選擇單個表單。 

注：以紅色螢光標示的表單欄位是參照表單欄位，當您選擇多個表單欄位時，最後一個選中

的表單欄位為固定或參照表單欄位。 

對齊多個表單欄位 

您可以使選擇的表單欄位左對齊、右對齊、頂部、底部、水平或垂直對齊。選擇其中一個表

單欄位作為固定表單欄位，其餘所有表單欄位向這個表單欄位的左邊緣、右邊緣、頂邊、底

邊、橫軸或縱軸對齊。選中兩個或兩個以上的表單欄位，然後按以下任一方式操作： 

 滑鼠右擊固定表單欄位，選擇“表單”> 「編輯」 > [排列]，在 [對齊] 類別中選擇一

種進行對齊。 

 滑鼠右擊固定表單欄位，然後從下拉式功能表中選擇一種命令： 

A. 縱向排列表單欄位，根據固定表單欄位的左邊緣、右邊緣或縱軸線，分別選擇左、

右或垂直排列表單欄位。 

B. 橫向排列表單欄位，根據固定表單欄位的頂邊、底邊或橫軸線，選擇上、下或橫向

排列表單欄位。 

注：當您滑鼠右擊滑鼠或 Ctrl+按一下一個表單欄位時，此表單欄位會作為固定表單欄位用

紅色螢光標示，此表單欄位的邊緣也同樣被用紅色螢光標示。 

居中多個表單欄位 

選中多個表單欄位，然後執行以下任一操作： 

 選擇“表單”> 「編輯」 > [排列]， 在 [頁面居中] 類別中選擇一種進行居中。 
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 或者滑鼠右擊其中一個表單欄位 > 選擇 [居中] > 再選擇 [垂直/水平/垂直和水平] 居

中。 

分佈多個表單欄位 

此功能適用於三個或三個以上表單欄位。選中多個表單欄位，然後執行以下任一操作： 

 選擇“表單”> 「編輯」 > [排列]， 在 [分佈] 類別中選擇一種進行排列。  

 滑鼠右擊固定表單欄位，選擇 [分佈] > [垂直分佈]，均分最頂部和最底部的圖片；或選

擇 [分佈] > [水平分佈]，均分最左邊和最右邊的圖片。 

調整表單欄位 

可將所有表單調整為等高、等寬或者即等高又等寬的表單。選擇一個表單作為基準表單，其

餘所有表單都會按照這個表單的高和寬進行調整。例如： 

 選擇 A和 B兩個表單，設定 A為基準表單； 

 滑鼠右擊表單 A > [調整大小] > [設定等高/設定等寬/等高等寬]，則 B表單的高寬與 A一

致。 

設定制位表次序 

在完成表單後，可以簡單的設定所建標籤的位置。如果不使用此功能，標籤將按普通順序自

動排放。 

按照下列步驟操作： 

 使用注釋工具 ，滑鼠右擊表單欄位，選擇 [設定定位停駐點次序]； 

 按一下您需要變為第一個的標籤，則該標籤的左上角數字將會變為 1； 

 按照您需要的順序，逐個點擊標籤。 

注：如果你不需要重排定位停駐點次序，只需在頁面的空白處或任何不屬於表單欄位的地方

按一下即可。 

設定計算順序 

如果您在一個表單中，設定了兩個或以上運算時，計算結果將根據您所確定的計算順序確定。

在這種情況下，您必須修改必要的順序以得到正確的運算結果。  

例如，如果您希望使用從兩個表單欄位計算得到結果來計算第三個表單欄位的值，必須先計
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算前兩個表單欄位來獲得正確的最終值。 

 選擇“表單”> 「編輯」 > [計算順序] ： 

計算順序對話方塊中將顯示表單中的所有可計算的欄位及計算的順序。 

 從清單中選擇需要調整的計算，根據需要，點擊上移和向下按鈕進行調整； 

 點擊 [確定]。 

設定多個表單欄位屬性 

 選中多個表單欄位 > 滑鼠右擊其中一個 > 選擇 [屬性]； 

 彈出包含有一般和外觀標籤的屬性對話方塊，按上述屬性設定的步驟操作。 

執行 JavaScript 

JavaScript 是優秀的、動態的、基於原型的語言，為簡易地建立互動式網頁服務。在 Foxit 

PhantomPDF，您可以輕易地將這種水準的互動性融入 PDF文件中。 

使用 Foxit PhantomPDF軟體，您可運用文件、書籤、連結及頁面所連帶的動作來執行 JavaScript

程式碼。程式為您提供了三種選擇——文件 JavaScript、文件動作和 JavaScript控制台。文件

JavaScript命令讓您能夠建立文件級的 JavaScript行為，並應用于整個文件。文件動作讓您建

立文件級別指令碼語言並應用到整個 PDF文件中。JavaScript控制台為測試 JavaScript碼以及

實驗物件屬性和方法提供了互動式、方便快捷的控制台。 

文件 JavaScript 

文件 JavaScript是對文件普遍起作用的變數和功能設定。但除文件之外，不適用於其他地方。 

 變數設定：設定文件變數，讓所有執行 Script都可見。 

 功能設定：在文件水準上，設定功能，讓使用者能夠跟文件互動。這些功能可能是一些

系統功能，執行操作字串或數位的普通任務，或是執行與使用者表單欄位、書籤、改變

頁面等行為相關的大量程式語言。 

在程式中，建立或接受文件級的大量程式語言，選擇“表單”> 「JavaScript」 > [文件

JavaScript] >“JavaScript功能”對話方塊。在此對話方塊中，您可以增加、刪除、修改 JavaScript

文件級描述語言。所有文件級描述語言都儲存在 PDF文件中。 

在“JavaScript功能”對話方塊中，有下列控制項： 

 關閉——關閉對話方塊。 
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 增加——在鍵入一個 Script 名稱後，點擊 [增加]，將彈出一個 JavaScript 編輯方塊。在

此處，您可以編輯或文件級描述語言。 

 編輯——彈出 JavaScript編輯區後，編輯修改您所建立的 JavaScripts。 

 刪除——刪除選中的 JavaScript。 

文件動作 

您可以建立文件級別 JavaScript動作應用到整個文件。例如，選擇 [文件已經儲存]，在文件

關閉後執行 JavaScript。 

  

使用 JavaScript控制台 

JavaScript控制台是用於執行和排除 JavaScript程式碼的控制台。對於執行 JavaScript和顯示

錯誤資訊有很大説明。 

執行 JavaScript控制台，選中“表單” > 「JavaScript」 > [JavaScript控制台]，然後執行下

列操作： 
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您可以點擊 [儲存]，儲存程式碼的副本，或點擊 [取消]，取消您的操作。 

連結資料庫至Windows ODBC 

開放資料庫互連（Open Database Connectivity，ODBC）外掛程式是 Foxit PhantomPDF軟體內

部的一個 JavaScript物件，允許您連接到Windows ODBC的資料來源。它提供了一些基本的

JavaScript 屬性和方式從而獲得新增的定制選項和資料精確度並以此來獲取資訊資料庫。更

重要的是，您可以用 JavaScript來執行 SQL命令和檢索資料，反過來，這也能用於填充 PDF

檔案。同時，開發人員可通過建立文件級別的 Script連接資料庫來插入新資料、更新資訊和

刪除資料庫欄目。 

目前，ADBC僅適用於Windows並要求微軟的 ODBC來支持。 

  

A. 在 彈 出 的 Javascript 

Console 對話方塊中 , 

鍵入您的 JavaScript 程

式碼, 或點擊打開並選擇

一個此格式的檔案。 

B. 點擊  [ 執 行 ] ，執 行您 的

JavaScript 程式碼。 彈出提示

框提示執行成功。如果程式碼錯

誤, 將彈出錯誤資訊提示。 
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第九章 – 安全 

PDF安全功能為您的 PDF文件內容提供了強而有力的保障。您可以通過為 PDF加密，阻止資

訊未經授權被查看、編輯或篡改等。PDF文件的安全功能對保護含有商業資訊或重要機密資

訊的文件具有重要作用。 

查看 PDF文件安全性 

查看 PDF文件是否設定了列印、編輯、複製等操作的許可權，請按下列步驟操作： 

 選擇“檔案”> [屬性]，或“保護”標籤 >「文件安全」> [安全屬性]。 

在彈出的“文件屬性”對話方塊中，您可以在“安全”標籤中查看到安全資訊。 

密碼保護和證書保護 

在 Foxit PhantomPDF軟體中，您可以為 PDF文件增加密碼保護、證書保護、許可權管理服

務以及安全許可權，限制可以開啟、複製、編輯或列印檔案的讀者。 

密碼保護 

為 PDF文件增加密碼以限制某些功能，如列印、複製及編輯等操作。 

用於保護 PDF 檔的密碼有兩種：開啟文件密碼和文件許可權密碼。如果您設定了開啟文件

密碼，所有使用者都必須在開啟 PDF 文件前輸入您所設定的密碼才能將其開啟；如果您設

定了文件許可權密碼，則必須先輸入密碼才能對許可權進行更改。請注意，如果在一個文件

中使用兩種加密方式，那麼，其中任意一種加密方式的密碼都可以開啟文件，但只有文件許

可權密碼能夠對許可權進行更改。 

技巧：如果您忘記 PDF 的密碼，程式無法對其進行恢復。因此，我們推薦您保留一份沒有

加密的副本。 

增加密碼 

1. 選擇“保護”>「文件安全」> [密碼保護]； 

2. 在“密碼保護”對話方塊中，執行以下操作： 

文件開啟設定：  

需要輸入開啟密碼開啟此文件：使用者必須輸入正確密碼才能開啟文件。 
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設定密碼：輸入您想設定的開啟密碼。 

確認密碼：再次輸入密碼確認。 

文件許可權設定： 

所有文件許可權：向 PDF文件增加許可權，如列印和編輯等。 

設定密碼：輸入您需要設定的密碼。此設定允許使用者開啟 PDF 文件並閱讀，但必須輸入

正確的密碼才可以對受密碼保護的設定進行操作。 

確認密碼：再次輸入密碼確認。 

許可權詳情： 

您所設定的安全設定均在許可權清單左邊顯示，點擊“許可權”可進行許可權設定，在

“PDF許可權”對話方塊中： 

許可權設定：勾選需要設定許可權的選項，可在“許可權說明”框中查看每個選項下的

子選項。 

列印許可權：指定允許使用者用於 PDF文件的列印級別。 

A. 低解析度列印：允許使用者在低於 150-dpi解析度的狀態下列印。 

B. 高解析度列印：允許使用者在任何解析度下列印。 

修改許可權：定義文件中可做的修改。 

A. 填寫表單：允許使用者填寫表單，但不允許建立表單。 

B. 增加注釋：允許使用者為 PDF文件增加注釋。 

C. 管理頁面和書籤：允許使用者插入、旋轉、刪除頁面或書籤。 

D. 編輯文件：允許使用者修改文件，但不允許增加注釋。如勾選了此項，則填寫表單

及管理頁面和書籤選項都將自動被勾選。 

內容擷取許可權：設定 PDF文件的擷取許可權。 

A. 為視障人士啟用螢幕閱讀器閱讀文字的功能。 

B. 擷取文件中的內容：允許使用者擷取文字、圖像，複製文字，截圖，播放多媒體片

段等。 

加密設定： 

加密演算法：設定較難被未授權使用者破解的資料轉換。Foxit PhantomPDF軟體支持 128位

AES、256位 AES以及 128位 ARC-FOUR。 
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不加密 metadata資料：加密 PDF文件內容，但仍然允許搜尋引擎接收文件 metadata資料。 

設定另存新檔新原則：儲存目前設定，使之可以被運用于所有文件。 

3. 設定完成後，點擊 [確定] 並儲存文件使其生效。 

修改密碼及安全設定 

1. 選擇“保護”>「文件安全」> [安全屬性]； 

2. 在文件屬性對話方塊的“安全”標籤中，選擇“文件安全”> [密碼保護]，點擊“更改設

定”； 

3. 參照“增加密碼”進行修改並點擊 [確定]； 

刪除密碼及安全設定 

您必須擁有許可權才能對此進行修改。 

1. 開啟 PDF文件，選擇下列步驟之一進行操作： 

 選擇“保護”>「文件安全」> [移除安全設定]。 

 選擇“保護”>「文件安全」> [安全屬性]，在“文件屬性”對話方塊的“安全”標籤中，

從“安全方式”功能表中選擇 [未加密]。 

2. 在彈出的“安全”對話方塊中選擇是否確定從文件中刪除安全設定。 

證書加密 

作者可為每個使用者設定唯一的許可許可權。例如，作者可允許一個使用者填寫表單及增加

注釋，而允許另一使用者編輯文字或刪除頁面。您可以從磁碟中的檔案選擇證書或是 

Windows 憑證存儲區，只有一部分特別的使用者身分可被認證才能擁有管理文件的權利。

證書包含著一個公共鑰匙以及其他認證資訊，用於保護文件安全或驗證電子簽名。被證書保

護的文件只有對應的私人鑰匙才能將其解密。 

一般情況下，用於保護文件的證書由協力廠商供應商提供。如果證書丟失或被偷竊，可由發

行主管單位進行更換。如果自行簽名的證書被刪除，所有用此證書保護的文件將永久對使用

者開放。 

增加證書 

1. 選擇“保護”>「文件安全」> [證書保護]； 

2. 在“證書保護”對話方塊中，建立接收者列表： 
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 點擊“新 ID”建立並選擇儲存您簽名數位身份證的位置： 

新建 PKCS#12數位憑證文件：將數位憑證資訊存儲在檔案中，該檔案在Windows 中

副檔名為.pfx，在Mac OS 中副檔名為.p12。此檔案可在作業系統之間互換使用。  

“Windows 憑證存儲區”： 將數位憑證存儲到公共位置，其它 Windows 應用程

式也可以從該位置檢索到此數位身份證。 

 點擊 [導入]，從Windows憑證存儲區中導入證書； 

 點擊 [瀏覽]，從磁碟中導入證書。 

 點擊 [移除]，將收件人從收件人列表中移除。 

 點擊 [許可權]，為選中的接收者做相應的文件許可權設定。許可權設定選項，請

參考密碼加密選項中的“增加文件許可權”。 

3. 選擇加密演算法 (支援 128位元 AES, 128位 ARC-FOUR以及 256位 AES AES)； 

4. 選擇是否加密 metadata資料； 

5. (可選) 選擇是否另存設定為新原則以用於其他文件； 

6. 點擊 [確定] 並儲存文件。 

請參閱“關於數位 ID”。 

修改或移除證書保護 

您必須擁有相關許可權，才能對安全設定進行修改或刪除。如果需要更改或移除證書，則需

擁有文件相關許可權。 

請按下列步驟更改證書加密： 

1. 選擇“保護”>「文件安全」> [安全屬性]； 

2. 在“文件屬性”對話方塊的“安全”標籤中，點擊 [更改設定…]； 

3. 在“證書保護”對話方塊中，請參考“增加證書”。 

4. 點擊 [確定] 並儲存文件使其生效。 

刪除證書保護，請按下列步驟之一操作： 

1. 選擇“保護”>「文件安全」> [移除安全設定]； 

2. 選擇“保護”>「文件安全」> [安全屬性]， 在“文件屬性”對話方塊的“安全”標籤

中，選擇 [未加密]。 

設定安全性原則 

如果您常常對多個文件進行安全設定，可以選擇將設定儲存為安全性原則，以便應用於其他

PDF文件。安全性原則包括安全方法、密碼加密、許可權設定等。 
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建立安全性原則 

1. 選擇“保護”>「文件安全」標籤 > [安全性原則]； 

2. 點擊 [新建]； 

3. 從功能表中選擇加密方式並設定原則名稱和描述； 

4. 點擊 [編輯詳細資訊] 設定密碼保護等，編輯完後核對資訊並點擊 [確定]； 

5. 然後關閉對話方塊。 

使用安全性原則 

您可以指定一個安全性原則並將其應用於 PDF檔案中以保證其安全。 

1. 開啟 PDF文件； 

2. 選擇“保護”>「文件安全」> [安全性原則]； 

3. 在“安全性原則管理”對話方塊中，選擇一個原則用於 PDF檔案 

4. 選擇 [應用到目前文件]； 

5. 儲存文件，使原則得以應用。 

管理安全性原則 

在建立原則成功後，您可以複製、編輯或刪除策略。 

1. 選擇“保護”>「文件安全」> [安全性原則]； 

2. 在“安全性原則管理”對話方塊中，在左邊的面板中選擇原則，並做如下操作： 

 點擊 [新建]，建立一個新的原則 

 點擊 [複製]，複寫原則。當您需要在已有原則的基礎上建立新的原則，可使用此

選項。 

 點擊 [編輯詳細資訊]，編輯原則。 

 點擊 [刪除]，刪除原則。 

 點擊 [關閉]。 

活動目錄許可權管理服務（AD RMS） 

微軟Windows許可權管理服務 (Microsoft Windows Rights Management Services)，是一種與

AD RMS協作來保護數位內容的資訊安全技術，以防使用者未經授權擅自使用敏感資訊。Foxit 

PhantomPDF 軟體的 RMS 外掛程式實現了與 Windows 許可權管理服務相結合，將文件保護

範圍從 Office擴展到 PDF檔案。如果您已經過授權，您可以使用 Foxit PhantomPDF軟體開啟

被 RMS 技術保護的文件，這大大提高了資訊安全性。另外，應廣大使用者需要，Foxit 

PhantomPDF軟體目前已相容微軟®AD RMS 2.1版本。 

一旦安裝了 Foxit PhantomPDF軟體，所有的 PDF文件將能加入微軟活動目錄許可權管理服務 

(AD RMS) 的保護。 

如果使用Windows Azure活動目錄許可權管理服務（AAD RM），請參閱Windows Azure活動
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目錄許可權管理服務快速入門    。 

RMS加密 

1. 選擇“保護” > “AD RMS加密” > “限制訪問”； 

2. 選擇您所需要的範本。如果您有多個伺服器，請先將游標移至伺服器名稱上，在子功能

表上將顯示該伺服器上的所有範本。您可以在子功能表中點擊“刷新範本”來獲取該伺服器

上最新的官方範本。當然，您也可以建立自訂範本，具體請參考“建立範本”； 

3. 如果您不想使用範本，請點擊“限制訪問”； 

 當您首次登錄 RMS伺服器時，請輸入您的用戶名和密碼。 

 點擊圖示 增加您要授予閱讀許可權的用戶；如允許所有人閱讀該檔，請

按一下右邊的 圖示；（如果您的系統預設郵箱為 Outlook 郵箱且擁有 Outlook 郵箱帳

戶，點擊圖示 時，將彈出您郵箱內的連絡人列表供您直接選擇郵箱地址。

您也可以直接輸入郵箱位址的若干字母，然後點擊圖示 ，系統將根據連絡人清單自

動幫您輸入完整的位址。然後進入更多選項步驟。） 

 

 選擇物件類型（使用者或群組）和伺服器。然後輸入被授權使用者郵寄地址或點擊“進

階”打開伺服器上的郵寄地址列表直接按一下選擇。 
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Quick Start for Windows Azure  


AD Right Management 


1. Enable Windows Azure AD Rights Management for your organization: 


 Download the Windows Azure AD Rights Management administration module 


(WindowsAzureADRightsManagementAdministration.exe) for Windows PowerShell 


from here. 


 In the local folder where you downloaded and saved the Rights Management 


installer file, double-click the file 


WindowsAzureADRightsManagementAdministration.exe to launch installation of 


the Rights Management administration module. 


 Open Windows PowerShell. 


 Type the following commands: 


 Import-Module AADRM 


 Connect-AadrmService -Verbose 


 Enter your Office 365 credentials when prompted, for 


example“user@company.onmicrosoft.com”. 


 Type the following commands: 


 Enable-Aadrm 


 Disconnect-AadrmService 


2. Install Active Directory Rights Management Service Client 2.1:  


X86 Download 


X64 Download 


 



http://go.microsoft.com/fwlink/?LinkId=257721

mailto:%E2%80%9Cuser@company.onmicrosoft.com

http://us-request.foxitservice.com/products/redirect.php?title=ad_rms_sdk_x86&language=en_us

http://us-request.foxitservice.com/products/redirect.php?title=ad_rms_sdk_x64&language=en_us

http://us-request.foxitservice.com/products/redirect.php?title=ad_rms_sdk_x64&language=en_us



		Quick Start for Windows Azure  AD Right Management
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 點擊“確定”退出“選擇用戶或群組”對話方塊。 

 在“許可權”對話方塊中點擊“更多選項”，可以看到您所選擇的使用者顯示在文字方

塊中，這時也可以根據需要增加或刪除使用者。 

用戶的附加許可權： 

該文件過期日：勾選該選項設定過期時間，在指定有效日期後該文件則無法打開。 

列印內容：勾選此項則上述所有用戶將有許可權列印該 PDF檔。 

允許擁有閱讀許可權的使用者複製內容：使僅有閱讀許可權的使用者可以複製內容。 

以程式設計方式訪問內容：使用戶能夠執行文件中的 JavaScript。 

附加設定： 

用戶可以從這裡請求附加許可權：勾選此項後，若使用者需要申請許可權，程式將自動

打開郵件用戶端程式並將您輸入的郵寄地址填寫到“接收者郵寄地址”欄。您也可以輸

入 URL。 

需要連接到網路驗證使用者許可權：勾選此項後用戶在每次打開加密過的文件時需要驗

證他們的證書。 

安全浮水印：勾選此項增加安全浮水印，具體操作請參閱安全浮水印。 
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設為默認：勾選此項將使該附加設定變為默認。 

保存為範本：勾選此項後上述安全設定將被保存為一個範本以便將來進一步使用。 

 

建立和編輯範本 

建立自訂範本，請執行以下操作： 

1. 選擇“保護” > “AD RMS加密” > “設定” >“範本管理”； 

2. 點擊“建立”打開“增加範本標識資訊”； 
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3. （可選）如果您需要編輯現有的範本，請點擊“編輯”； 

4. 選擇語言並編輯範本名稱和描述，然後點擊“確認”，在“範本識別”清單裡將顯示該

範本名稱和描述，您也點擊“增加”用不同語言為相應範本輸入名稱和描述； 

5. 點擊“下一步”增加用戶許可權，然後在“用戶和許可權”一欄中點擊旁邊的“增加”

按鈕； 

6. 在彈出的“增加用戶或群組”對話方塊選擇“用戶或群組的郵寄地址”，點擊“瀏覽”

迅速增加您要分配許可權的用戶，若選擇“任何人”則表示所有用戶都有許可權使用該加密

檔；您也可以直接在文字方塊中輸入多個郵寄地址； 

 

7. 核選以上用戶的 PDF 許可權，您可以為所有用戶設定相同的許可權或根據不同的使用者

設置不同的許可權； 
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8. 用戶可以從這裡請求附加許可權：勾選此項後若使用者需要申請許可權，程式將自動打

開郵件用戶端程式並將您輸入的郵寄地址填寫到“接收者郵寄地址”欄；您也可以輸入

URL； 

9. 點擊“下一步”指定過期策略； 

 

內容有效期 

從不過期：指使用者可以無限期查閱該 PDF文件內容。 

將在下述日期過期：指該 PDF文件內容在指定日期後將無法閱讀。 

在以下週期（天）後過期：指在指定一段時間以後，該 PDF文件內容將無法閱讀。 

使用授權過期 

在下述日期後需要使用者連接到服務器重新驗證許可權：您可以輸入指定天數，在這段指定

時間過後用戶必需重新申請新的證書來打開該加密檔。 

10. 點擊“下一步”增加安全浮水印，具體操作請參閱安全浮水印； 
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11. 點擊“完成”完成建立範本。 

安全浮水印管理 

1. 建立設定檔 

增加浮水印前您必須先建立一個設定檔，然後程式將設定檔中的內容應用到 PDF文件中。 

注：您只能選擇某個設定檔而不是某個浮水印來增加浮水印。故請在同一設定檔中建立您所

需要應用到 PDF檔中的浮水印。 

 選擇“保護”> “AD RMS加密” > “設定” > “安全浮水印管理”； 

 點擊“新建設定檔”建立一個設定檔並命名該檔。 
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2. 增加安全浮水印 

增加新浮水印，請執行以下操作： 

 打開“安全浮水印管理”、選擇一個您建立好的設定檔並點擊“增加”，增加設定檔中

的浮水印； 

 輸入該浮水印名稱； 

 在文字方塊中輸入浮水印內容，並設定字體、字體大小及顏色、底線和對齊方式；（注：

您只能設定文字作為浮水印。） 

 動態文字：當打開 PDF 檔時，該浮水印將動態顯示文件資訊且您可以同時使用多個文

字； 

 

文件標題：顯示文件標題。 

作者：顯示目前文件的作者。 

當前用戶：顯示目前正在閱讀該文件的用戶。 

日期：顯示目前系統打開該文件時的日期。 

日：顯示目前系統打開該文件時的日期。 

月：顯示目前系統打開該文件時的月份。 

年：顯示目前系統打開該文件時的年份。 

時間：顯示目前系統打開該文件時的時間。 

小時：在目前系統打開該文件時顯示小時。 

分鐘：在目前系統打開該文件時顯示分鐘。 

秒：在目前系統打開該文件時顯示秒鐘。 

 

 選擇旋轉角度和透明度設定外觀，您也可以根據目標頁面調整比例； 

 設定目標頁面與浮水印間垂直和水準方向的距離； 

 選擇您要應用該浮水印的頁面範圍； 

 您可以在右邊面板中預覽該浮水印； 

 點擊“確定”完成。 
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3. 編輯或刪除安全浮水印 

編輯浮水印 

 打開“安全浮水印管理”並選擇您要編輯的浮水印； 

 點擊“編輯”打開“編輯安全浮水印”對話方塊； 

 編輯浮水印，請參閱“增加安全浮水印”； 

 點擊“確定”完成操作。 

刪除浮水印 

 打開“安全浮水印管理”並選擇您要刪除的浮水印； 

 點擊“刪除”移除所選浮水印。 

4. 導入或匯出浮水印 

導入浮水印 

 打開“安全浮水印管理”並點擊“導入”； 

 選擇一個.xml格式的浮水印； 

 點擊“打開”。 

匯出浮水印 

 打開“安全浮水印管理”並選擇您要匯出的浮水印；  

 點擊“匯出”，然後選擇匯出檔案類型和保存路徑； 

 根據您選擇該浮水印將被匯出為.xml格式檔或編碼格式檔。您可以將匯出的浮水印增加

到許可權策略範本中，並應用到加密的 PDF文件中。 

注： 

1. 匯出 XML格式的浮水印，支持直接通過 Foxit PhanotmPDF Business企業版導入後增加到
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自訂的許可權策略管理範本中，並應用到加密的 PDF文件中。 

2. 匯出編碼格式的浮水印（.txt格式），支持通過 AD RMS API腳本（AD RMS Scripting API 

Architecture）增加到官方策略範本中。（請點擊這裡查看示例，並在被匯出的編碼檔中找

到“appData.Name”和“appData.Value”的值）。 

稽核日誌 

Foxit PhantomPDF 軟體的稽核日誌功能可以説明您跟蹤 RMS 加密檔的被使用情況並記錄下

所有對該文件的各種操作過程，如哪些使用者訪問了該文件、他們訪問了哪些文件內容、他

們是以什麼方式訪問的及他們是否成功訪問等等。 

執行稽核日誌功能，首先要先從 http://cdn04.foxitsoftware.com/pub/foxit/rms/配置工具/RMS

配置工具 110.exe下載一個配置工具。該工具目前僅提供英文版： 

1. 在“配置工具”對話方塊中，選擇 [Foxit PhantomPDF] 並勾選“Audit Log Setting”選

項； 

 

2. 按照以下程式碼在伺服器上建立資料庫表： 

USE [Database] 

GO 

/****** Object:  Table [dbo].[Table_Name]  ******/ 

SET ANSI_NULLS ON 

GO 

SET QUOTED_IDENTIFIER ON 

GO 

CREATE TABLE [dbo].[Table_Name]( 

 [User] [nvarchar](50) COLLATE SQL_Latin1_General_CP1_CI_AS NOT NULL, 

 [Action] [nvarchar](50) COLLATE SQL_Latin1_General_CP1_CI_AS NOT NULL, 

http://msdn.microsoft.com/en-us/library/windows/desktop/bb403260%28v=vs.85%29.aspx
http://cdn04.foxitsoftware.com/pub/foxit/rms/configtool/RMSConfigTool110.exe
http://cdn04.foxitsoftware.com/pub/foxit/rms/configtool/RMSConfigTool110.exe
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 [FileName] [nvarchar](max) COLLATE SQL_Latin1_General_CP1_CI_AS NOT NULL, 

 [DateTime] [datetime] NOT NULL, 

 [PrinterName] [nvarchar](max) COLLATE SQL_Latin1_General_CP1_CI_AS NULL, 

 [Copies] [numeric](18, 0) NULL, 

 [Result] [nchar](10) COLLATE SQL_Latin1_General_CP1_CI_AS NULL 

) ON [PRIMARY] 

3. 然後在“配置工具”對話方塊的“Specify SQL Server”中 (如下圖) 輸入所有 SQL伺服器

資訊，如 SQL伺服器名稱、資料庫和表的名稱及使用者名稱和密碼，然後點擊 [連線測試] 按

鈕，測試該連線是否有效，如果測試連線成功將有資訊框彈出提示連線成功； 

 

4. 點擊 [匯出…] 按鈕，將根據管理員的配置產生一個.reg文件； 

5. 系統管理員需要將該.reg檔分發給各個電腦使用者端。 

限制本地列印許可權 

為避免敏感資訊遭到任意列印，您也可以通過指定某些網路印表機來設定使用者的列印許可

權。 

 網路印表機配置 

設定列印許可權，您必需先配置網路印表機，請先從 http://cdn04.foxitsoftware.com/pub/fo

xit/rms/配置工具/RMS 配置工具 110.exe 下載一個配置工具，執行該工具並在“配置工具”

對話方塊中勾選“有效網路印表機設定”選項並執行以下操作： 

http://cdn04.foxitsoftware.com/pub/foxit/rms/configtool/RMSConfigTool110.exe
http://cdn04.foxitsoftware.com/pub/foxit/rms/configtool/RMSConfigTool110.exe
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1. 您應先獲得“印表機埠”。請點擊“開始” > “設備和印表機” > 滑鼠右擊一個網路

印表機 > 選擇“印表機屬性”，在印表機屬性對話方塊中，選擇“埠”標籤可查看到相關

資訊，如印表機的“埠”。（如下圖） 

 

2. 在“配置工具”對話方塊中點擊“Add”按鈕增加印表機埠。  

注：如何增加網路印表機，請參閱“增加網路印表機”。 

3. 點擊“Export…”按鈕將根據管理員的設定生成一個.reg文件。 

4. 管理員需要將該.reg檔分發給各個電腦使用者端。 
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 增加網路印表機 

您可以從以下兩種方式中選擇一種增加網路印表機方法： 

 進入“開始” > “設備和印表機” > 點擊“增加印表機”，在“增加印表機”對話方

塊中點擊“我所需要的印表機不在清單中”進入下一步； 

 

在 “增加印表機”對話方塊中按照提示完成增加印表機。 

 

 

 另一種方法增加網路印表機：按快速鍵“Win + R[開 啟]執行”並在框內輸入您要增
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加的印表機的網址，點擊 [確定]； 

 

在彈出的對話方塊中，滑鼠右擊該印表機並選擇 [連接…] 即可。 

RMS設定 

加密 PDF 文件前，您可以先對 RMS進行設定： 

點擊“檔” > “偏好設定” > “RMS設定”，預設情況下，以下兩項均未勾選。 

將加密檔另存為名為’檔案名稱(protected).pdf’的檔副本 – 對文件增加RMS加密後自動另存

為一份名為’檔案名稱(protected).pdf’的加密過的 PDF檔。 

加密中繼資料 – 加密文件的同時也加密中繼資料。 

加密演算法： Foxit PhantomPDF Business和 Foxit閱讀器都能打開 SHA-1/RSA 1024加密過的

檔，但只有 Foxit閱讀器 5.4版本和 Foxit PhantomPDF Business 5.5版本及其更高版本才可以

打開 SHA-2/RSA 2048加密過的檔。 

SharePoint服務 

使用者可通過 Foxit PhantomPDF軟體簽入/簽出 SharePoint伺服器上的 PDF文件。 

使用 Foxit PhantomPDF軟體的 SharePoint服務前，請滑鼠雙擊附件    “SharePoint配置”

文件配置您的 SharePoint伺服器。 

 登錄 SharePoint伺服器並選擇文件庫。 

 點擊某個 PDF文件通過 Foxit PhantomPDF軟體中開啟。如果您選擇 [簽出並開啟]，其他

使用者無法對其進行編輯。如果您只選擇 [開啟]，其他使用者在您編輯時也能對其進

行修改。  

 (可選) 如果您要取消 [簽出]，請進入“分享”> 「SharePoint整合」> [放棄簽出]。 

 根據需要對 PDF文件進行編輯。 

 設定 PDF文件屬性。 




 ©  2014 Foxit Corporation 1 


SharePoint Integration Configuration 


Before using the check in/check out features in Foxit Reader/PhantomPDF, please configure the 


SharePoint Server. 


 Download PDF icon from http://www.foxitsoftware.com/images/icons/pdficon.gif. 


 Open regedit.exe and navigate to HKEY_CURRENT_USER\Software\Foxit Software\Foxit 


PhantomPDF 6.0\Preferences\Others. 


    Change the key and value to the following: 


    Key: bEnableSharePointFeatures 


    Value: 1 


 SharePoint 2007: Copy the downloaded.GIF file to "Drive: \Program Files\Common 


Files\Microsoft Shared\Web Server Extensions\12\Template\Images". 


SharePoint 2010: Copy the downloaded.GIF file to "Drive:\Program Files\Common 


Files\Microsoft Shared\Web Server Extensions\14\Template\Images" 


 SharePoint 2007: Edit the file “Drive:\Program Files\Common Files\Microsoft Shared\Web 


server extensions\12\Template\Xml\DOCICON.XML”. 


SharePoint 2010: Edit the file “Drive:\Program Files\Common Files\Microsoft Shared\Web 


server extensions\14\Template\Xml\DOCICON.XML”. 


SharePoint 2013: Edit the file “Drive:\Program Files\Common Files\Microsoft  


Shared\Web server extensions\15\Template\Xml\DOCICON.XML”. 


To edit the file, please refer to the following steps: 


a. Right-click DOCICON.XML file > click Open With > select Notepad. 


b. Add an entry for the file with .pdf extension and take it as the file’s name. For example, 


type the ICPDF as the name of the .gif file:  


<Mapping Key="pdf" Value="pdficon.gif" 


OpenControl="FoxitPhantomPDF.OpenDocuments"/> 


 



http://www.foxitsoftware.com/images/icons/pdficon.gif
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c. Click Save on the File menu, and then quit Notepad. 


 Perform an iisreset: 


a. Click Start > Run > type “cmd” in the Open dialog box>click OK > type “iisreset” in 


the command prompt window>click Enter. 


 


b. Close the windows. 
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1. 請選擇“分享”> 「SharePoint整合」> [準備文件屬性]。 

2. 在“文件屬性”對話方塊中，選擇一個欄位名稱並在“編輯”文字方塊中編輯相應

的值。例如：選擇“標題”，將彈出“編輯”文字方塊，在文字方塊中輸入您需要

的內容並點擊 [確定] 完成編輯。 

注：目前可供編輯的欄位有單行文字、多行文字、是/否和日期與時間。 

 

 

 選擇“分享”>「SharePoint整合」> [簽入]。 

在“簽入”對話方塊中，根據所修改的文件選擇一個版本號並輸入適當的版本注釋。如

需禁止其他使用者修改該文件，請選擇 [簽入該版本後保持文件的簽出狀態] 選項即

可。 

 點擊 [確定]，修改好的文件將自動被上載至伺服器上。 
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密文 

密文功能允許您將文件中的機密資訊設定為不可見。您也可以先標記需要密文處理的文字或

圖形，確定後再應用密文功能。 

標記密文 

請按照下列步驟為文字或圖形增加密文標記： 

 選擇“保護” > “密文” > “標記為密文”，游標將變為 ； 

 （可選）按兩下圖片標記整張圖片，被標記的圖片將被紅色邊框圍起。 

 （可選）用滑鼠在需要標記的文字上拖拽出一個矩形框。 

 將滑鼠指標移至矩形框上，矩形框的填充色將變為黑色，文字和圖片均被黑色遮蓋。 

應用密文 

在標記完需要密文處理的文字或圖形後，您需要對其進行密文處理。請按下列步驟操作：  

 選擇“保護” > “密文” > “應用密文”； 

 程式將彈出對話方塊確認您的操作； 
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 選擇“確定”密文處理所有標記過的文字或圖形。  

搜索並刪除文字 

 選擇“保護” > “密文” > “查詢&密文”； 

 在搜索框內輸入您要增加密文的文字，更多詳情請參看“進階搜尋”； 

 按一下“搜尋並增加為密文”按鈕； 

 從搜尋結果中勾選以增加密文； 

 

 點擊搜索框底部的“標記選擇項以增加密文”按鈕； 

 選擇“保護” > “密文” > “應用密文”。 

注：應用密文後該操作無法撤銷，且所選內容也將永久刪除，故如有需要請在應用密文前請

做好備份。 

數位簽章 

數位簽章和傳統的手寫簽名一樣，可以證明使用者身份和文件內容的真實有效。它提供了簽

名者簽名的日期、時間以及簽名時的文件狀態。 

關於數位 ID 

數位 ID是個人或組織的身份證明，包含有姓名、Email地址、序號、有效期、公司名稱等資



Foxit PhantomPDF Business for HP 

用戶手冊 

154 

訊。電子簽名擁有兩把鑰匙，一把是公共鑰匙 (證書)，用於加密或鎖定資料，一把是私人

鑰匙，用於解密或開啟被加密的資料。 

您可以將包含證書和詳細資訊的公共鑰匙分配給需要驗證您的身份、簽名以及為您加密文件

的人。只有用您的私人鑰匙才能開啟這些加密資訊，所以，請注意把您的數位 ID 放在安全

的地方。 

您可以從一個可信任的協力廠商供應商——憑證授權 (CA) 獲得數位 ID，或建立由自己簽名

的數位 ID。數位 ID 通常被密碼保護，您可以用 PKCS#12 檔案格式將其儲存在電腦上或

Windows憑證存儲區。 

置放簽名 

在簽名前，您需要先放置簽名，獲取身份，並為您的簽名建立外觀。 

1. 選擇“保護”>「簽名」> [簽名&認證] >  [置放簽名]； 

2. 在需要放置簽名的地方拖動滑鼠畫出簽名區域，然後將彈出“簽署文件”對話方塊； 

3. 在“簽署文件”對話方塊中，從下拉式功能表中選擇一個數位 ID，如果您不能找到指

定的 ID，您需要從協力廠商供應商處取得，或建立自簽名數位憑證； 

4. (可選) 建立自簽名數位憑證，請從下拉式功能表中選擇 [新 ID] > 在“增加數位憑證”

對話方塊中，選擇一個儲存位置儲存該數位憑證 > 點擊 [下一步] 後輸入您的身份資

訊 (如姓名、組織單位和郵寄地址等) 用於產生自己簽名的證書 > 點擊 [下一步] 後對

您的新數位憑證檔案進行命名、指定儲存路徑及密碼。 

5. 在“簽名預覽”功能中選擇外觀樣式，有兩種類型的外觀可供選擇，標準樣式和建立新

的樣式。請參考建立簽名外觀，您可以在預覽視窗中預覽您的簽名； 

6. 點擊 [簽名]。 

  

注：在文件上置放簽名後將無法移動和調整簽名大小，因此簽署文件時請確認簽名位置和大
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小。 

建立簽名外觀 

您可以在簽署文件對話方塊中選擇不同的選項來設定數位簽章的外觀。例如：簽名可包含您

的手寫簽名圖片、公司標識或是相片、日期等等。您可以為不同的目的設定動態簽名。簽名

的外觀也包含有可以讓其他人驗證您的身份的資訊，如：簽名原因、聯繫方式等。 

 

 

簽名的不同外觀 

 選擇“保護”>「簽名」> [簽名&認證] > [置放簽名]； 

 在需要置放簽名的地方拖動滑鼠畫出簽名區域，然後將彈出“簽署文件”對話方塊； 

 在“簽署文件”對話方塊中，從“外觀類型”功能表選擇 [建立新的樣式]； 

  

 確認希望在簽名中出現的選項。簽名的外觀可以包含很多顯示作者個性的資訊，如名字、

位址和日期等； 

 右鍵點擊簽名，選擇“屬性”，在簽名屬性對話方塊中設定簽名的外觀和動作等，具體
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可參閱“簽名區域屬性”。簽署文件後，無法執行該操作。 

 

“配置簽名樣式”對話方塊 

移動、調整及刪除簽名 

在簽名前，您可以移動或調整簽名，但是不能改變證書及證書外觀。 

1. 移動簽名 

選擇注釋工具 或其他相應工具，點擊選中簽名，將其拖動到目標位置。  

2. 調整簽名 

選擇注釋工具 或其他相應工具，點擊選中簽名，將游標移到矩形框的任意一角，拖動滑

鼠進行調整。 

3. 刪除簽名 

選擇注釋工具 或其他相應工具，滑鼠右擊簽名選擇“刪除”，或選中簽名按刪除鍵。 

注：只有在“檔案”> [偏好設定] > [簽名] 中取消對 [放置簽名後立即簽署文件] 的勾選，即

在簽署文件前才能移動、調整和刪除簽名。若在“簽名屬性”中勾選了 [鎖定] ，也無法進

行這些操作。 
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簽署 PDF 

簽名時，簽名不能被移動或調整，一個 PDF 文件可以被多個人簽名多次。簽署文件時，簽

名出現在簽名區域中。簽名的外觀根據設定的選項來顯示。 

1. 簽名文件第一步，請選擇下列步驟之一操作： 

 選擇“保護”>「簽名」> [簽名&認證] > [簽署文件]。 

 選擇手形工具，點擊 [簽名]。 

 在參數對話方塊中設定簽名參數。選擇“檔案”> [偏好設定] > [簽名]。勾選 [置放

簽名後立即簽署文件] 可在簽名設定完畢後立即對文件進行簽署。 

2. 在彈出的“另存新檔”對話方塊中，輸入檔案名稱並指定儲存位置。 

驗證簽名 

確認簽名有效性 

如果您希望在開啟文件時自動驗證全部簽名，在偏好設定對話方塊的簽名項中勾選 [當文件

開啟時驗證簽名]。將會有一個圖示出現在簽名域的左上角表明簽名狀態。在簽名面板中可

瀏覽到簽名的狀態。 

 表示簽名無效。 

 表示簽名有效。 

 表示簽名無效，但是簽名被應用後，文件曾被修改或破壞。 

 表示簽名有效。簽名增加後，文件曾被修改。 

 表示簽名是否有效不可知，因為簽名者的證書不在您的信任清單內。文件自簽名

應用後未被修改。 

驗證簽名 

1. 開啟包含簽名的 PDF文件，選擇下列步驟之一操作： 

 選擇“保護”>「簽名」> [驗證]。 

 滑鼠右擊簽名，從彈出功能表中選擇 [驗證簽名]。 

 選擇手形工具，點擊 [簽名]。 

2. 彈出的簽名狀態資訊框裡顯示了簽名的有效性。簽名區域中出現的驗證圖示表明簽名的

不同狀態。 
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技巧：  

1. 您可以通過設定簽名參數驗證簽名，點擊“檔案”> [偏好設定] > [簽名]；  

2. 勾選 [當文件開啟時驗證簽名]。 

編輯已簽署的簽名 

簽署文件後如需刪除簽名，請執行以下操作： 

 驗證簽名後，用手形工具右擊簽名選擇“清除簽名”，然後該簽名將被清除，僅剩空白

的簽名區域； 

 再用“選擇標注”工具 或相應工具，右擊簽名區域選擇“刪除”。 

簽署文件後，如需對簽名進行編輯，請按下列步驟操作： 

 驗證簽名後，用手形工具右擊簽名選擇“清除簽名”，然後該簽名將被清除，僅剩空白

的簽名區域； 

 用手形工具點擊空白的簽名區域，即開始建立新的簽名，請參看“建立簽名外觀”。 

認證 PDF文件 (僅適用於企業版) 

只有作者才能認證自己的 PDF 文件。在認證後，作者可以指定文件的更改許可權。無論何

時做出通過審核的修改，認證均有效。如果讀者沒有獲得您的授權，卻嘗試對文件進行修改，

認證將失效並且接著使用的使用者將會被告知文件已被篡改。 

請按下列步驟認證您的文件： 

1. 開啟需要認證的文件； 

2. 選擇“保護”> 「簽名」 > [簽名&認證] > [使用可見簽名認證] (或 [使用不可見簽名認

證])； 

3. 在需要出現簽名的文件位置用滑鼠拖出區域； 
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“認證文件”對話方塊 

4. 在彈出的“認證文件”對話方塊中，選擇簽署身份。如果沒有找到指定 ID，您則需要從

協力廠商處獲取數位 ID或建立自己簽名的數位 ID； 

5. 在下拉清單中為您的文件選擇允許的操作； 

6. 設定簽名原因並選擇外觀類型； 

7. 點擊 [簽名]。 

查看簽名屬性 

簽名屬性對話方塊提供最基本的簽名資訊，包括簽名者、原因、日期、位置，有效性摘要、

認證細節等。 

1. 選擇手形工具 ； 

2. 點擊簽名並從彈出對話方塊中選擇 [簽名屬性…]，或滑鼠右擊簽名選擇 [顯示簽名屬

性…]； 

3. 在“簽名屬性”對話方塊中，您可以看到如下資訊： 

 簽名者：顯示簽署文件的人。 

 原因：簽名的原因。 

 日期：簽署文件的日期。 

 位置：文件中，簽名的位置。 

 有效性摘要：顯示在文件被簽署後，是否被修改或其他資訊。 

 顯示證書：點擊證書，顯示證書細節，例如證書有效性、憑證路徑等。 
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簽名屬性對話方塊 

注：如果狀態未知，請點擊查看證書細節，查看證書是否在您的信任清單中。如果沒有，點

擊安裝，將證書安裝到可信任 Windows 憑證存儲區中。如果您使用的是由自己簽名的數位

ID，確認證書資訊是有效地，如果證書無效，請從簽名者那裡獲得有效證書。 

使用Windows憑證存儲區管理信任清單 

當驗證數位簽章時，Foxit PhantomPDF軟體中的憑證存儲區將幫助您管理可信任的證書。使

用此功能，請按下列步驟操作： 

1. 開啟被簽名的 PDF文件，點擊數位簽章或滑鼠右擊簽名並選擇 [驗證簽名]； 

2. 程式將彈出警告對話方塊顯示簽名有效性狀態； 

3. 如果簽名的有效性是未知，請點擊 [簽名屬性] > [顯示證書] > [安裝您信任的證書]； 

4. 成功導入證書後，再次點擊數位簽章，這時，提示資訊將顯示簽名有效； 

5. 如果不信任某個證書，您可以將其從Windows憑證存儲區中刪除。 

簽名面板 

簽名面板顯示文件中的每個簽名以及自第一個簽名起的修改歷史。同時提供文件被簽署的時

間、原因、位置以及簽名者資訊。 
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“簽名”面板 

開啟簽名面板 

按一下導覽面板左邊的 [管理簽名] 按鈕 即可。 

PDF快速簽名 

通過 PDF 快速簽名功能，您可以快速建立您的自簽名並將簽名增加到相應頁面，無需為不

同角色建立不同的簽名和進行其他繁瑣的設定。  

建立您自己的手寫簽名並簽署文件，請執行以下操作： 

1. 選擇“保護”> 「簽名」 > [PDF簽名] > [建立簽名]； 

2. 在“建立簽名”對話方塊中，您可以選擇 [繪製簽名]、[導入圖片] 或 [從剪貼簿] 來建

立簽名； 



Foxit PhantomPDF Business for HP 

用戶手冊 

162 

  

3. (可選) 如果您選擇 [繪製簽名]，點擊 [繪製]， 在“繪製簽名”對話方塊中，描繪您的

簽名，然後點擊 [確定]。 

4. 如果您選擇了 [導入圖片]，請點擊 [瀏覽]，然後選擇所要導入的圖片並點擊 [開啟]。

您可以在預覽框內預覽該圖片。 

技巧：您可以用黑色鋼筆在白色紙張上簽名，然後將其掃描成一個圖片檔再進行導入，這裡

建議掃描時使用單色 600DPI掃描效果最佳。  

5. 將您的名字設定成簽名後，點擊 [儲存]。然後游標將變成矩形框狀。 

6. 將游標置於目標位置，通過點擊並拖動矩形框的任意一角可調整簽名大小；如需刪除，

則選中簽名並按刪除鍵即可； 

7. 滑鼠雙擊簽名，將簽名應用到文件；或滑鼠右擊簽名選擇 [應用簽名]，若選擇 [置放到

其他頁面]，然後設定需要簽名的頁面範圍。 

注：一旦應用簽名，該簽名將無法修改和刪除。 

管理簽名，請執行以下操作： 

選擇“保護”> 「簽名」 > [PDF簽名] > [管理簽名]。在“管理簽名”對話方塊中，點擊 [建

立] 可以建立簽名；選擇一個已有簽名並點擊 [編輯] 可進行修改，修改好後可預覽簽名；

選擇一個已有簽名並點擊 [刪除] 可將該簽名刪除。  
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第十章 – 列印 

列印是一種文字和圖像的再製造過程。當您讀完一篇實用的文件或設計完一個 PDF表單後，

您可能需要將其發送至噴墨或雷射印表機，並自訂大小將其列印出來。本章詳細介紹了 Foxit 

PhantomPDF軟體的列印功能，您可以在“列印”對話方塊中設定選項確保檔的正確列印。 

列印 PDF文件 

1. 請確認您已成功安裝印表機； 

2. 選擇“檔案”> [列印]； 

3. 指定印表機、列印範圍、列印份數以及其他選項 

4. 點擊 [列印]。 

列印部分頁面 

列印頁面的某一部分，請參考快照工具的使用方法。 

 點擊“主頁”> 「工具」 > [快照] ，選擇快照工具； 

 使用滑鼠在需要列印的位置拖畫出矩形框 

 滑鼠右擊選中區域並在右鍵功能表中選擇 [列印…]，然後參閱“列印”對話方塊進行設

定列印。 
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部分頁面列印對話方塊 

使用縮圖列印多個頁面 

您可以通過頁面縮圖清單選擇文件中的多個頁面執行列印命令. 

 開啟需要列印的文件並點擊左邊導覽列上的縮圖圖示； 

 在縮圖列表中，按住 Shift 鍵並點擊滑鼠、按住 Ctrl 鍵並點擊滑鼠或直接拖動滑鼠選擇

頁面範圍； 

 在右鍵功能表中選擇 [列印頁面] 並點擊 [確定]。 

列印標籤 

您可以列印標籤欄上的一個標籤文件或一次性列印視窗中開啟的所有標籤下的文件。 

1. 將指針移至標籤欄上； 

2. 在右鍵功能表中選擇 [列印目前標籤頁文件] 或 [列印所有檔]。  

設定“列印”對話方塊 

設定“列印”對話方塊是列印前的最後一個準備工作。您可以在對話方塊中修改印表機。但

是，如果新選擇的印表機與之前所選擇的印表機使用的紙張大小不同，則需重新設定對話方

塊。 

開啟列印對話方塊，請選擇“檔案”> [列印]。 



Foxit PhantomPDF Business for HP 

用戶手冊 

166 

  

“列印”對話方塊 

 子集：設定列印不相連的頁面。 

範圍內的所有頁面：列印指定列印範圍內的所有頁面。 

僅奇數頁面：僅列印指定列印範圍內的所有奇數頁面。 

僅偶數頁面：僅列印指定列印範圍內的所有偶數頁面。 

注：此選擇有利於對雙邊列印效果。 

 反序列印：反序列印頁面。如果已輸入頁面範圍，頁面則按照輸入的順序反向列印。例

如，您選擇頁面列印範圍為 5到 30頁，那麼選擇 [反序列印] 後，則從 30頁開始列印

到第 5頁。 

 自動分頁：列印多份檔時，可按照文件的頁碼和邏輯順序自動分頁。列印一份文件時，

該選項不可用。 

 頁面縮放比例：無、符合列印邊距、縮小至列印範圍、每張紙上放置多頁、自訂比例、

縮放大頁面和小冊子。 

頁面縮放：輸入縮放數值。 

 根據 PDF頁面選擇紙張：列印時自動根據 PDF文件中的頁面大小選擇紙張類型。 

 自動旋轉：調整文件的方向以相符印表機屬性中指定的方向。 

 自動居中：列印時，將頁面自動居中。 

 作為圖像列印：作為點陣圖圖像列印。在正常列印不能產生預期效果時選擇此項並指定
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一個解析度即可。  

 列印到灰階：將檔中的彩色的圖像灰階列印輸出，所有顏色即按深淺程度用黑色油墨表

現出來。 

 列印內容：指定要列印的可見內容。 

文件：僅列印文件內容，不列印文件注釋。 

文件和注釋：列印文件內容及注釋。 

注釋：僅列印本文件中的注釋內容。 

 預覽：Foxit PhantomPDF軟體在印表機對話方塊中提供了列印的預覽效果。 

設定 Foxit PhantomPDF軟體印表機屬性 

在您通過 Foxit PhantomPDF軟體印表機建立 PDF檔案時，您可能需要進入“印表機屬性”

中對各個選項進行設定。請按以下兩種方式之一進入“印表機屬性”： 

1. 在控制台中查看印表機參數： 

 “開始” > “設定” > “控制台” > “設備和印表機” > “印表機與傳真”； 

 滑鼠右擊 Foxit PhantomPDF軟體印表機並在右鍵功能表中選擇“印表機屬性”。 

2. 在列印對話方塊中查看列印參數： 

 開啟 PDF文件，“檔案”> [列印] > 在對話方塊中點擊 [屬性] 按鈕。 

一般 

 建立 PDF檔案的預設資料夾 – 定義一個資料夾作為 PDF文件輸出的儲存位置。 

 複寫已存在的文件而不用確認 – 此選項預設使用產生的 PDF文件覆蓋原始文件，程式

不再進行提示。 

 使用預設檔案名儲存到預設資料夾 – 如果您不想更改原始檔案名，勾選此項。產生的

PDF文件將會繼續使用原始名稱並被儲存到您之前定義的儲存資料夾中。 

 轉換完成後開啟 PDF檔 – 此選項被預設勾選。PDF檔案產生後將會自動被程式開啟。 

 使用減損演算法壓縮圖片 – 在 PDF檔案產生過程中，允許您以生成較低顯示品質的圖

片的代價來縮小圖片的體積。此項被預設勾選。 

 壓縮係數 – 指定壓縮率。 

 灰階 – 將檔案中的彩色的圖像灰階列印輸出，所有顏色即按深淺程度用黑色油墨表現

出來。 

 圖片解析度 – 給圖像解析度輸入一個 DPI (每英寸點數)，有效值為 72 - 2400。 

 支援 PDF/A – 1b標準 – 支援 PDF/A-1b標準。  

 儲存為預設 – 如果勾選此項，那麼您此次所做的設定將被運用到所有文件中。如不勾
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選此項，則設定只對目前文件有效。 

 指定 PDF版本 – 可以選擇所要產生的 PDF檔案版本更佳地建立出適合不同 PDF瀏覽器

的檔案。 

佈局 

 紙張規格 – 在此清單中可根據需要選擇紙張的大小或類型。也可使用自訂選項自行輸

入紙張的高度和寬度。 

 佈局預覽 – 預覽您所選擇的紙張規格。 

 頁面大小 – 自訂紙張大小。當您再紙張規格清單中選擇自訂紙張大小後，此項便會被

啟動。 

 度量單位 – 更改度量單位，可供選擇的單位有：英寸、公分和公厘。   

 方向 – 更改紙張的方向。 

 頁面名稱 – 預設為 A4。 

字型 

嵌入字型 

 嵌入所有字型 – 勾選此項，字型來源清單中的所有字型將被嵌入到您的 PDF 文件中。

為確保您建立的 PDF檔案在所有電腦中完全可讀取，您必須嵌入所有字型以免遺漏。 

 嵌入非標準字型 – 將您電腦中的非標準字型內嵌到您的 PDF文件中。 

注：勾選此項將迅速增大您的文件大小，特別是在使用 Unicode語言的時候（如亞洲語言），

且字型內嵌清單將被禁用。  

 使用以下的字型內嵌列表 – 勾選此項則對話方塊下方的“字型內嵌列表”可用。您可

以選擇勾選或取消清單中的字型來嵌入到您的 PDF文件中。 

 不嵌入任何字型 – 嵌入清單中的所有字型將被取消勾選。當在閱讀您所建立的 PDF檔

案時，系統只使用安裝在您電腦中的字型。 

當文件中包含不允許嵌入的字型時彈出提示資訊 – 當您開啟含有被禁止嵌入字型的文件時，

將彈出提示資訊。  

文件資訊 

為文件增加資訊 – 勾選此項您可以直接在對話方塊下方的“PDF資訊”增加 PDF文件資訊，

如標題、主題和作者等。 

PDF 資訊 – 鍵入文件的標題、主題、作者、關鍵字和建立者。製作者為 Foxit PhantomPDF

軟體。 



Foxit PhantomPDF Business for HP 

用戶手冊 

169 

關於 

該標籤顯示 Foxit PhantomPDF軟體的產品資訊及其相關版權等資訊。 

浮水印 

為文件增加浮水印 – 勾選此項向文件增加浮水印，您可以選擇增加 [圖片浮水印] 或 [文字

浮水印]。 

圖片浮水印 

 圖像 

瀏覽檔案增加圖片作為文件的浮水印，還可以編輯圖像的透明度和方向。 

 偏移量 

您可以改變測量單位和指定圖像的寬度、高度等。 

 比例 

A. 相對於原始圖像大小調整浮水印，請勾選 [絕對比例] 並在框中鍵入一個百分值。 

B. 相對於 PDF頁面尺寸調整浮水印，請勾選 [相對比例] 並在框中鍵入一個百分值。 

 預覽 

您可以查看預覽所設定的浮水印。 

文字浮水印 

 字型 

勾選 [文字浮水印] 選項後該選項才可用。您可以從下拉式功能表中設定字型名稱、大小和

顏色等。 

 文字 

在“內容”框中輸入文字作為文件的浮水印，還可以編輯文字的透明度和方向。 

 偏移 

您可以改變測量單位和指定文字的寬度、高度等。 
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 比例 

A. 相對於原始圖像大小調整浮水印，請勾選 [絕對比例]並在框中鍵入一個百分值。 

B. 相對於 PDF頁面尺寸調整浮水印，請勾選 [相對比例] 並在框中鍵入一個百分值。 

 預覽 

您可以查看預覽所設定的浮水印。 

頁眉/頁腳 

為文件增加頁眉或頁腳 

勾選此項後可以設定以下選項： 

字型  

您可以從清單選擇字型的名稱、大小和顏色。 

編輯 

該選項允許您編輯頁眉/頁腳及其樣式。  

您可以根據需要在這各個列中 (左列、中列和右列) 鍵入文字。 

點擊 [插入日期] 可以向 PDF文件插入日期。 

點擊 [插入頁碼] 可以向 PDF文件插入頁碼。 

偏移量 

您可以改變測量單位和指定頁面四條邊的邊緣。  

預覽 

您可以查看預覽所設定的浮水印。 

安全 

安全標籤提供給您對 PDF檔案進一步的管理。請先選擇一種加密類型。 

1. 密碼加密 
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密碼 

 需要密碼開啟文件：使用者必須輸入正確密碼才能開啟文件。 

文件開啟密碼：設定使用者開啟文件所需要的密碼。 

重複密碼： 再次輸入密碼以確認密碼。 

許可權 

 需要增加文件許可權：向 PDF文件增加許可權，如列印和編輯等。 

修改許可權密碼：設定使用者的許可權密碼。 

重複密碼：再次輸入密碼以確認密碼。 

許可權詳情 

 列印允許：指定允許使用者用於 PDF文件的列印級別。 

A. 無：不允許列印。 

B. 低解析度列印：允許使用者在低於 150-dpi解析度的狀態下列印。 

C．高解析度列印：允許使用者在任何解析度下列印。 

 修改允許：定義文件中可做的修改。 

A. 填寫表單且簽署已存在的數位簽章欄位：允許使用者填寫表單 (但不允許建立表單)

及在現有的數位簽章欄位中簽署。 

B. 標注、填寫表單、簽署已存在的數位簽章欄位：允許使用者為 PDF文件增加注釋、

填寫表單 (但不允許建立表單) 及在現有的數位簽章欄位中簽署。。 

C. 插入、刪除、旋轉頁面：允許使用者插入、旋轉、刪除頁面。 

D. 除匯出頁外的其他頁面：允許使用者作上述所列的任何修改行為，但禁止匯出頁外

的其他頁面。 

允許拷貝文字，圖片和其他內容 – 使用者可以指定 PDF文件中允許被擷取的內容。 

為視障人士啟動畫面閱讀器來閱讀文字 – 説明視覺障礙者使用螢幕閱讀設備中的語音辨識

軟體閱讀所產生的 PDF檔案。 

加密設定 

 加密演算法 - 設定較難被未授權使用者破解的資料轉換資訊。 

 不加密 metadata 資料：加密 PDF 文件內容，但仍然允許搜尋引擎接收文件 metadata

資料。 

2. 證書加密 

接收者列表 
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 點擊“導入”，從Windows憑證存放區區中導入證書； 

 點擊“瀏覽”，從磁片中導入證書。 

 點擊“移除”，將收件人從收件人列表中刪除。 

 點擊“詳細資料”，查看證書的詳細資訊。 

許可權信息 

 列印允許：指定允許使用者用於 PDF文件的列印級別。 

A. 無：不允許列印。 

B. 低解析度列印：允許使用者在低於 150-dpi解析度的狀態下列印。 

C．高解析度列印：允許使用者在任何解析度下列印。 

 修改允許：定義文件中可做的修改。 

E. 填寫表單且簽署已存在的數位簽章欄位：允許使用者填寫表單 (但不允許建立表單) 

及在現有的數位簽章欄位中簽署。 

F. 標注、填寫表單、簽署已存在的數位簽章欄位：允許使用者為 PDF文件增加注釋、

填寫表單 (但不允許建立表單) 及在現有的數位簽章欄位中簽署。。 

G. 插入、刪除、旋轉頁面：允許使用者插入、旋轉、刪除頁面。 

H. 除匯出頁外的其他頁面：允許使用者作上述所列的任何修改行為，但禁止匯出頁外

的其他頁面。 

允許拷貝文字，圖片和其他內容 – 使用者可以指定 PDF文件中允許被擷取的內容。 

為視障人士啟動畫面閱讀器來閱讀文字 – 説明視覺障礙者使用螢幕閱讀設備中的語音辨識

軟體閱讀所產生的 PDF檔案。 

加密設定 

 加密演算法 - 設定較難被未授權使用者破解的資料轉換資訊。 

 不加密 metadata 資料：加密 PDF 文件內容，但仍然允許搜尋引擎接收文件 metadata

資料。 
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第十一章 – 附錄 

本章作為手冊的補充說明部分，主要列出了在查看文件中的常用快速鍵及命令列。 

鍵盤快速鍵 

鍵盤快速鍵可説明您在快速瀏覽文件時對 Foxit PhantomPDF軟體進行其它的操作。您可以使

用預設快速鍵或自訂快速鍵。  

自訂鍵盤快速鍵，請滑鼠右擊工具列並選擇 [自訂快速存取工具列]，選擇「鍵盤」標籤。 

以下列出了部分重要的鍵盤快速鍵供您參考： 

檔案 操作快速鍵 

結果 快速鍵 

開啟文件 Ctrl + O 

關閉文件 Ctrl + W, or Ctrl + F4 

另存文件為 Ctrl + Shift + S 

列印文件 Ctrl + P 

退出 Foxit PhantomPDF軟體 Ctrl + Q，或者 Alt+F4 

儲存文件 Ctrl + S 

從文件建立 PDF文件 Ctrl + N 

文件屬性 Ctrl + D 

視圖快速鍵 

Action Shortcut 

進入全螢幕模式 F11 

退出全螢幕模式 ESC, or F11 

轉換到文字檢視器模式 Ctrl + 6 

放大 Ctrl + + 

縮小 Ctrl + - 

縮放到 Ctrl + M 
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實際大小 Ctrl + 1 

適合頁面 Ctrl + 0 

適合寬度 Ctrl + 2 

適合可見範圍 Ctrl + 3 

順時針選擇頁面 Ctrl + Shift + Plus 

逆時針選擇頁面 Ctrl + Shift + Minus 

自動滾屏 Ctrl + Shift + H 

停止自動滾屏 ESC 

切換文件標籤 Ctrl + Tab 

閱讀模式下查閱文件 Ctrl + H 

在預覽列印框中上下翻頁 Page Up/Down 

跳至特定頁面 Ctrl + G 

第一頁 Ctrl + Home 

最後一頁 Ctrl + End 

上一視圖 Alt + Left 

下一視圖 Alt + Right 

選框縮放 Alt + 5 

朗讀當前文件 Ctrl + Shift + V 

從目前頁面面開始朗讀 Ctrl + Shift + B 

停止朗讀 Ctrl + Shift + E 

使用尺規工具 Ctrl + R 

顯示/隱藏導覽列 F4 

編輯快速鍵 

結果 快速鍵 

複製文字 Ctrl + C, or Ctrl + Insert 

剪下文字 Ctrl + X 

貼上文字 Ctrl + V 

撤銷 Ctrl + Z 

重做 Ctrl + Shift + Z 

全部選擇 Ctrl + A 

增加書籤 Ctrl + B 



Foxit PhantomPDF Business for HP 

用戶手冊 

175 

進入偏好設定 Ctrl + K 

按照標籤順序切換可填寫表單欄位 Tab 

按照標籤逆序切換可填寫表單欄位 Shift + Tab 

工具快速鍵 

工具 快速鍵 

使用手形工具 Alt + 3 

使用文字選擇工具 Alt + 6 

使用快照工具 Alt + 7 

查尋文字 Ctrl + F 

查尋下一個 F3 

查尋前一個  Shift + F3 

使用搜尋工具 Ctrl + Shift + F 

文件查看快速鍵 

 Action Shortcut 

向後翻頁 Space 

向前翻頁 Shift + Space 

將選定範圍擴展至右側的一個字元 Shift + Right 

將選定範圍擴展至左側的一個字元 Shift + Left 

將選定範圍擴展至單字結尾 Ctrl + Shift + Right 

將選定範圍擴展至單字開始 Ctrl + Shift + Left 

將選定範圍擴展至行尾 Shift + End 

將選定範圍擴展至行首 Shift + Home 

將選定範圍擴展至下一行 Shift + Down 

將選定範圍擴展至上一行 Shift + Up 

將選定範圍擴展至文件開始處 Ctrl + Shift + Home 

將選定範圍擴展至文件結尾處 Ctrl + Shift + End 

左移一個字元 Left 

右移一個字元 Right 

左移一個單字 Ctrl + Left 
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右移一個單字 Ctrl + Right 

上移一行 Up 

下移一行 Down 

移至行尾 End 

移至行首 Home 

移至文件結尾 Ctrl + End 

移至文件開頭 Ctrl + Home 

“説明”視窗快速鍵 

結果 快速鍵 

開啟“説明”視窗 F1 

命令列 

以下為 Foxit PhantomPDF軟體中可用的命令列參數： 

 

命令列 結果 

-Register 將 Foxit PhantomPDF軟體為預設的 PDF閱讀器。 

-pwd<password> 請輸入密碼開啟文件。 

/p <PDF path> 使用預設印表機列印文件。 

/t <PDF Path> [Printer] 使用指定的印表機列印文件。 

<PDF Path> /A […][…].. 
使用命令列開啟一個PDF文件並指定顯示方式和顯示

內容。 
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支持 

用戶回饋 

您還可以將 bug報告、使用建議或評論直接回饋到 Foxit的客戶支援中心。建立回饋報告，

請在程式視窗中選擇“説明” > “幫助” > “報告問題”。 

技術支援 

Foxit的客戶支援中心配備產品專家 24小時為您解答技術問題，提供快速和高效的服務。如

果您對我們的產品需要瞭解更多資訊或者有任何疑問，請隨時聯繫我們，我們將竭誠為您服

務。 

 郵箱： 

Foxit4HP@foxitsoftware.com 

 聯繫電話： 

+1-866-MYFOXIT or +1-866-693-6948 (24/7) 

+86-591-38509808（9:00-22:00 UTC+8，僅支持普通話） 
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